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1. Before Starting

Purpose of Document

This document provides the information on how to use the CodeScroll Controller Tester Product.
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2. Overview

Introduction

Controller Tester is a test automation solution for unit and integration tests of software developed and
executed in various environments.

Toolchain supported in Controller Tester

Controller Tester supports about 100 toolchain. For more information, please contact the Technical
support contact at the bottom of this document Troubleshooting page.

Features

Controller Tester is a source code-based software test automation tool for unit and integration tests and
the major features are as follows.

Test design

hon =

Automatically create tests and test data

Intuitive test design interface

Ability to import test data in various format

Ability to design of integration test for complex nested structures

Achieving coverage goals

1. Supports statement, branch, MC/DC and function call coverage

2. Provides guides to achieve the goal of MC/DC

3. Checks the coverage results by linking the control flow graph with the source code

4. The coverage goal can be achieved quickly by testing only uncovered section after measuring the
system coverage (QualityScroll COVER product).

Others

1. Supports the simulation and the actual target environment tests

2. Links with DevOps(issue management + continuous integration + configuration management) tools

3. Shares project settings with CodeScroll product family: By carrying out the project settings only
once, coding rule inspection + runtime error detection + unit/integration test can be possible.

4. Reports in various formats

5. Interaction with requirements management tools to support traceability of requirements to tests

and results

Standard certification

1.
2.
3.

IEC 61508-3 (Electrical/Electronic)
ISO 26262-8 (Automotive)
IEC 60880 (Nuclear)
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4. |EC 62279/ EN 50128 (Railway)
5. DO-178C / DO-330 (Aviation)
6. IEC 62304 (Medical device)

Overall screen of Controller Tester

User Manual - 3.6_en

It provides high DOF (degrees of freedom) windows made by Eclipse RCP. User can set them in
[Window] menu and each view.

File Edit  Search  Project Targst Run  Window  Help

2 Hiost % B [ Global Search (-3 Qi =
~w~Dasﬁbq I-secti - S
OVEAgE C 4t atub || Class Factory < b Control Fow Graph oo Call Graph T Function Call Hiscarchy ™) Emor

922[1F]
323

,(J[ 1

zlib
& Ta | Show Coversge
[& treesc &1
885 * Flush the bits in the bit buffer te pending cutput (leaves at a
887 woid ZLIB_TNTERMAL _tr_Flush_bits{s}
228 deflate_state *s;
B&9
858 bi_flush(s);
g=1
a2
593 B R B R
il Send one empty static bleck to g 4 £
895 * This takes 18 bits, of which 7 may remain in the bit buffer.
Ba :
aav LIB INTERMAL _tr ali
BSE deflate_state *=5j
il
aea[TF send_bits(s, STATIC_TREES<cl, 3);
sa1[F] send_code(s, ERD_BLOCK, static_ltree);
a2 #ifdef DEAUS
5@, :-Pcotpressed_].en += 18L; f* 1 for block type, 7 for EOO */

5 e Code Editor

wodd ZLIE_INTERMAL _tr_flush_bleck(s, buf, stored_lea, last)

deflate_state *=;

charf "buf; J/* dnput bleck, or NULL if too eld *f

ulg stored_len; gth of imput black =/

int last; % one §F this is the last block Tor a Tile

ulg opt_lent, static lenb; /= opt len and static_len in byte
int max_blindex = 8; /* index of last bit ]rng’tn cede of mor

S Build the Huffmam trees unless a stored block fs forced *.
if (s-»level » 8) {

f* Check if the file is blnary or text =/
if (s-»strm->dota_type == T LMKHOWN])

}

Uit Test Integiatian Test

type file, function, test, state, ismwe

o =

w

(809 / 0 / 286) 1095

L ow || == =

Statement Coverage

39.1%

Mame Resuft Coverage -
: _tr, llign T t 71.4%
ol bi 100.0%
oo e 1€S view sec tlﬂ'n 000
t 1 100.0%
Ir nend _bleck ay D 9 100.0%
_tr_tally 0/0/3 22.2%
H/T) adler32 904 a8.0%
41 540/ 100.0%
i 54000 100.0%
14000 100.0%
5/0/8 100.0% L
-| _ir_flush_btts{sinuct intemal_state *)_0 =7 = 0
Test Info (#iby_tr_flush_bits_testd) A
Test Structure BB Test Info Edit

Test structure using & tree view and edit the information in the

test

Mame

Global Variable
Teat target function
User eode

Stub

Test Indo | Test Case Test Code Configuration |

= Test Editor section

:- sfzaam !
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3. Install

Installation requirements

OS  Microsoft Windows 7/10 (64bit)
RAM 512MB or more

Free space about 1GB (GCC Compiler installed)
(When carrying out tests actually, HDD usage may be increased due to the test results.)

HDD

Install Controller Tester for Windows

By using the install package, you can install Controller Tester as follows:

1. Execute controller-tester_3.x_xxx.exe file.

-
wul

il

[
i)
rat
=

o
nék
|
el

BR controller-tester_3.6_x64.exe 2021-11-09 2= 328 S22 =Z=0% 1,010,902...

2. Click [Next] after the installation wizard runs and gathers installation information.

E CodeScroll Controller Tester Setup *
::333 CONTROLLER TESTER

Welcome to the CodeScroll Controller Tester Setup Wizard

The Setup Wizard will install CodeScroll Controller Tester on your computer.
Click Mext to continue or close the window to exit the Setup Wizard,

3. Accept the end-user license and click [Next].
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Read the Suresoft Technologies Incs. License Terms

To continue you must read and accept the terms of this agreement, If you do not
want to accept the Suresoft Technologies Incs. License Terms, close this

Software End User License Agreement

Important: This End User License Agreement ("EULAT) i a legal agreement between user and
Suresoft Technelogies, Inc. producing software product identified by product cognition cardflabel
Software product includes computer software, related media, related documents and “enling” {or
electronic) manual. When instaling, copying, downloading, backing up, or accessing software
product, user must accept the conditions in the EULA, otherwise license cannot be issued. Without
license, user cannet install, copy, dewnlead, backup, and access software product.

Software Product License

Software product is protected by intellectual property rights, copyrights, pregram copyrights and
international copyright regulations. Software product license is registered but cannot be sold. The
term “computer” used in this agreement means a zingle computer system, the range of which iz
described below.

| accept the terms of thiz agreement,

< Back

4. Set the path to install Controller Tester and click [Next].

CodeScroll Controller Tester Setup - P

Choose a file location

This is the folder where CodeScroll Controller Tester will be installed.

To install in this folder, click "Mext". To install o a different folder, enter it below ar
click "Browse".

|C:WProgram Files®#Suresoft¥CodeScroll Controller Tester 3 6% v Browse,,,

< Back

5. All required information for the installation has been collected. Click [Install].



CodeScroll Controller Tester Setup X

Begin installation of CodeScroll Controller Tester

The Setup Wizard is ready to begin the CodeScroll Controller Tester installation

Click Install to begin the installation. If vou want to review or change any of vour
installation settings, click Back. Close the window to exit the wizard.

<Back | | @pinstall |
6. Install Controller Tester.
CodeScroll Controller Tester Setup >

Installation Progress

Installing CodeScroll Contraller Tester...

Flease wait while the Setup Wizard installs CodeScroll Contraller Tester. This
may take several minutes.

Extracting files fram archive

7. Click [Run CodeScroll Controller Tester] to run Controller Tester immediately after installation is
complete, and click [Finish] to end the installation.
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@ CodeScroll Controller Tester Setup

CONTROLLER TESTER

CodeScroll Cantroller Tester has bheen successfully installed.

Run CodeScrall
Controller Tester

Cloze

User Manual - 3.6_en
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4. Uninstall

Uninstall Controller Tester
How to uninstall Controller Tester is as follows.

1. Uninstall using [Control Panel] > [Uninstall a program]
ey

I:__,.:, B s Comteod Pl 5 =

L EAELARS St

T and Security

«%s “Uninstall Controller Tester” removes the files necessary to operate the Controller
Tester. The workspaces set by users are not removed.

The procedures for [Uninstall a program]

1. Click [Control Panel] > [Uninstall a program].
Uninstall or change a program

T uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

Organize =  Uninstall

Mame Publisher

B CodeScroll Controller Te Suresoft Technologies Incs.
Uninstall

2. Click [Yes] to uninstall CodeScroll Controller Tester
|

‘ .
Windows Installer

Are you sure you want to uninstall this product?

Yes No

3. All the necessary information for uninstalling has been collected. When the Controller Tester is
successfully uninstalled, the window closes.
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5. Run

Select the shortcut icon or [Start] -> [All programs] -> [CodeScroll Controller Tester 3.x] -> [CodeScroll
Controller Tester 3.x].

¢ CODESCROLL

i CONTROLLER TESTER

Select the workspace (working space) following the splash screen of the Controller Tester. You can
select either the already existed directory or enter a new directory as the workspace path. You can also
use the currently selected workspace as the default so that you do not need to reselect the workspace
the next time you run again. When the path has been set, click the [OK] button.

B Werkspace Selectien. =
Plok Workspace

Vit wesrREpaOE 1 wibBlE SETgE and vaRGuL nportint [iles vl be stored

Worpece  CACTIO = [ bowe |

Use thit s the defaut snd do rct sk sgein

cone || ok || canen

If the selected directory does not exist, confirm the user whether to create the directory.
B New Werkspace [===]

9 Weuld you like to create o workspace in the selected location?

[oc [ comce

Create a directory in the workspace you have set and the welcome page of the tool and [Create a
Project] wizard is displayed. The welcome page is displayed only when creating a workspace newly, and
is not displayed when selecting the workspace created previously.

Page 12 of 322
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Software for Safe world

a4 o DM RLEE TISTIR

CONTROLLER TESTER T [o—

MNaedi

Wintian Critical domain tequines certfication oo Lafety and selisbiity,

Close the welcome page and the product screen is displayed.

User Manual - 3.6_en
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6. Set License

User Manual - 3.6_en

To use Controller Tester, you must register the license first. The procedures for registering the license

are as follows.

1. Select [Help] > [License] in Menu
Help

Welcome

Show Manual
Show Troubleshooting Guides
Cheat Sheets..

License...
Parser Config

About Controller Tester

2. Select [Product] > [Controller Tester] and click [Edit].

.I.iﬂme

a Produsct
Centrolier Tester Irrvalsd hicere,

(-

3. Enter the provided license in [Editing License Information] and click [OK] button to register the

license.

B Edit license information
License Information
| Floating
Please enter floating license server information.
Operating systems:  Window
[P/ hostname:

Port:

2 Nodelack

Please enter nodelock license file path.
(License file name : ctlic)

File path:

|

Mo e |

Cancel

Page 14 of 322
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» Floating: Register it through the license server. Enter the server information (operating
system, IP, port) and click [Authentication connection] button.
* Nodelock: Register the license file provided.
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7. Set a Toolchain (Analyzer)

To perform the test using Controller Tester, the toolchain setting is required.

To create a project, you must have a toolchain(compiler information) of the sources to test.

The toolchain can be set in [Window] -> [Preferences] -> [Toolchain].

B o Lo
i bt [ . -
wey
= [ V. — T T P — T

S O ECAFAE b 4 P
[T i o Lk e
o WL 30 Al LT oy
fh— g oty e
P i (O
Bt
famrcn Viw P
Tl ek
e
i (T Rl
o hen
et
gy e (e )

And it can also be set through [Toolchain setting] in Create a source file C/C++ project wizard or in

Create a C/C++ Project from Embedded wizard.

I Mew Progect = (o
Mew Project

Creste new peoject

Progect namies |

Liscatican: CALCTI0

Sedect Toolchain

| Default  Tookchain Mame * Descrigtion
GCC 4.7 3lea)y Automatally generbed
GCC 5.3 (3] dutomatscally generated

< Back l‘ Bexi = f -' Camgel |

The functions related to the toolchain setting provided by Controller Tester are as follows.

+ Add a Toolchain

+ Edit a toolchain

» Duplicate a toolchain
+ Remove a toolchain
» Export a toolchain

» Import a Toolchain
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7.1. Auto-registration of Toolchain

When executing the Controller Tester, it extracts the information of Visual Studio compiler installed in
user PC and the information GCC compiler installed along with the Controller Tester and registers the

toolchain automatically (the registered toolchain is not registered again.).
e re
' ' T LW [ =

L L e
# by [t g SMEEE |1k 'y Gl Py Sarii S g | Cll g Famibn £ Hariy b

WAL o e AL PR

CONTROLLER TESTER

Needs

Miiicn Critical domain inguite, cortification cn wfety snd ekabdity,

The auto-registered toolchain can be checked in [Window] -> [Preferences] -> [Toolchain] window, and it
displays the message “Automatically generated.” in the description.

[ ER— B e |
Tastlhain “EE-R R
sty
Tra YT Peeraey T Twpriie.  Coroprer o G gl [ .
Lok of GO0 (L b g T ]

x"“"“" ¢ WK ey destpensbaly e
b mar sl < e
Faen
S Tl Vi
Tt
(L e
ok
du
Dmad
[repyomtom] | men
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7.2. Add a Toolchain

User Manual - 3.6_en

1.

2.

In [Window] -> [Preferences] -> [Toolchain] window, click the [Add Toolchain] button.

B preferences o x
| ToolChain MR 2
5 Analysis
Editor Status Toolchain Name Target Compi... Conversion Toolchain .. Description Add Toolchain.
Exclusion
Language Add RTV Toolchain.
Performance Edit.
Perspectives
Source File Types Duplicate.
> Target Test
3 Test Remove
Theme (CS Labs)
» ToolChain
Open Configuration Folder
Detail

[Apply and Close] Cancel

In [Add a toolchain] window, enter the toolchain information.

B cdit Teolchain m] X

Toolchain(Method Manage)

Manage toclchain information.

Toclchain Informaticn

Name: [Gec 5.3 (32bity |

Description ‘ ‘

Env Script: ‘[ wUserswxwAppDatawRoamingwCodeScrollw1.1#parserConfigGCC 5.:| | Browse

Configuration: » GNU Compilers » gcc » 5.3 b cthers

¢ e il

Cnmpwler'lt"-\‘gccws 3.0%32bitwbinwgcc.exe ‘ Browse. I

Linker: |C'Ngcc*-\‘5 3.0%32bitwbinwgcc.exe

‘ Browse.

Archiver: |C'Ngcc*-\‘5 3.0W32bit¥binwar exe ‘ Browse:

System Header:

CHgCCHS. 3 03 2bitwlibgec¥mingw32#5.3.0winclude Add...
CHgCeWS 3. 0%32bitwinclude ~
CHgCCS. 3. 03 2bitwlibgecwmingw32#5.3.0winclude-fixed Edit...
Remove
Up

Down

Libraries:

Add
Edit

Remove

Automatically extract toolchain infermation from entered compiler. Extract Toolchain Info

< Back Next = Cancel

* When you click [Extract toolchain Info]@ button after [Compiler]@, the toolchain information

is extracted automatically from the compiler entered.

* In [Compiler]@, enter the compiler path.
o Ex:
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= If it is based on Visual Studio:
C:\program Files (x86)\Microsoft Visual Studio 10.0\VS\bin\cl.exe
= Ifitis based on GCC:
C:\MinGW\bin\gcc.exe
= CodeWarrior 5.x or higher for Freeescale HC (s) 12:
C:\Program Files (x86)\Freescale\CWS12v5.1\Prog\chc12.exe
3. In [Name], enter the name of toolchain to be created.
In [Description], enter the description of toolchain to be created.
5. The entry information of [Env Script], [Configuration] and [C/C++] is set automatically by extracting
the information from the compiler or can be entered directly by user.
6. After entering the toolchain information, click the [Next] or [Finish] button.

B Add a toolchain O x

>

Advanced Compile setting

Set the parser configuration. (Depending on the toclchain, some
options apply differently)

c C++

Keyword Directive Define Predefined Type  efc

Keywords:
Add...
Edit...
Remave
ASM Keywords:
Add...
Edit...
Remave
Example:

Mext = Finish Cancel

7. In [Advanced Compile setting] window displayed when clicking the [Next] button, the detailed items
related to the configurations selected in the [Configuration] are shown. Each item can be changed
by the user. The application of the changed items can be checked in [Example].
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* For the detailed setting procedure for the other toolchain detail, please contact the
Technical support contact at the bottom of this document Troubleshooting page.
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7.3. Edit a Toolchain
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1. Select the toolchain to be edited and click the [Edit] button.

B cdit Teolchain

Toolchain(Method Manage)

Manage toclchain information.

] X

Toclchain Informaticn

Name: [Gec 5.3 (32bity

Description ‘

Env Script: ‘[ wUserswxwAppDatawRoamingwCodeScrollw1.1#parserConfigGCC 5.:| | Browse

Configuration: » GNU Compilers » gcc » 5.3 » cthers

c e

Compiler: |C'Ngcc*-\‘5 3.0%32bitwbinwgcc.exe

Linker: |C'Ngcc*-\‘5 3.0%32bitwbinwgcc.exe

Archiver: |C'Ngcc*-\‘5 3.0%32bitwbintar exe

System Header:

CHGCCHS. 3 03 2bitwlibWgccwmingw32#S.3.0winclude
CHgCCHS.3.0%3 2bitwinclude
CHGCCHS. 3 03 2bitwlib¥gecwmingw32#5.3.0winclude-fixed

Libraries:

Edit

Remove

Autematically extract toolchain infermation from entered compiler.

Extract Toolchain Info

< Back Next > Cancel

2. Edit the information of toolchain.
3. Click the [Finish] button.
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7.4. Duplicate a Toolchain

1. Select the toolchain to be copied and click the [Duplicate] button.
(It can copy only a toolchain which a compiler is not entered.)

2. Edit the toolchain information that you want to change.

3. Click the [Finish] button.
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7.5. Remove a Toolchain

Select the toolchain to remove and click the [Remove] button.

! If there is a project using the toolchain you want to remove, the project will not work
properly.
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7.6. Export a Toolchain

The toolchain information can be exported via ‘Export’ function.

1. Click [File] > [Export] in menu and select [Toolchain] in [Preferences].

e
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2. Select the toolchain to be exported and click [Browse] button to specify the path to be exported. If
you set the system header file in the toolchain settings, a checkbox will be displayed in the
[Exporting system header] column, where you can choose whether to export or not.
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3. Click [Window] > [Preferences] > [Toolchain] > [Exporting] in menu to set the system header size
to be exported. If the size of the system header is larger than the set value, the system header

cannot be exported.
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7.7. Import a Toolchain

The exported toolchain can be imported via the [Import] function.

Select [File] > [Import] in menu and click [Toolchain] in [Preferences].
[Foe] ioe sewon Proes mun wmae (S5

v e e e e

147
[47%] e
Clese A Chrls Shifta

rwa
]

Sankch Wostapce_
L g

i apos

Bt =

2. Select the file to import and check the toolchain to import when the toolchain of the file is
displayed.

e

The name of the toolchain to import is duplicated with the existing toolchain name, the status of ‘import’

becomes “Need to configure”. The name of the toolchain to import can be modified in [Select how to
resolve] dialog shown when clicking the [Next] button.
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8. Create a Project

Checklist before creating a project

Since Controller Tester is a tool that detects errors by actually executing source codes, the source code
under test must be executable. In other words, the source code under test must be buildable for normal
testing.

Before creating and testing a project, you need to set up a ‘toolchain’ that takes into account the
development environment of the target software. Please refer to Set a toolchain for details.

Controller Tester automatically generates a stub if the target object to link does not exist during the build
process. However, the automatic test stub generation feature may have limitations in performing tests,
so it is recommended to prepare an appropriate test strategy in advance.

Create a project
To create a Controller Tester project, execute [Create a Project wizard].

Select [File] -> [New] or click the shortcut icon.

File Edit Search Project Target Window Help

Mew b C/C++ Project with Source Files
Close Chrl<W @ C/C++ Project from Embedded(CodeWarrior, Green Hills, NEC)
Close Al Clrl+Shift=W & C/C++ Project from Visual Studio Project
ﬁ C/C++ Project from Existing CodeScroll Project
Save Ctrl+S L .
2avE i Create a C/C++ project with CPI File
Save All Ctrl+Shift+5 | o ) ] ! )
i@ Create 3 C/C++ project with Build Information
ename ?
fename... F =i Other.. Ctrl+N
Refrach F5

The following types of project creation wizards are provided.

+ C/C++ Project with Source Files

Creates a project by selecting the source file directly.
» C/C++ Project from Embedded

Creates a project by using an embedded project file.
+ C/C++ Project from Visual Studio Project

Creates a project by using Visual Studio dsw, sin, vexproj and veproj files.
» C/C++ Project form Existing CodeScroll Project

Creates a project by using the CodeScroll project created previously.
+ Creates a C/C++ Project with CPI File

Creates a project by using project creation information located in a CPI file.
» Creates a C/C++ Project with Build Information

Creates a project by using a makefile and build script.
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Create a project with C/C ++ source code files. The user needs to enter the necessary information to

build the source code.

1.

Enter the project name in [Project name].

W e P
Hew Project
Create faba POt
Frosec Aamse
Lot CACTIA

Seleit Tkt

GO AT (e
LG5 O]

Dufwall  Tookbain hese

o (B2

fudpmabically ganerated.
A comgier ally gutnigiaied

Ioadchaten betiersg

Cancel

In [Select Toolchain], select the toolchain to use in the project. If there is no created toolchain,
create a toolchain through [Toolchain Setting]. Please refer to Set a Toolchain for details.

Click the [Next] button to move to the next screen. If you click the [Finish] button, an empty project
containing no source file is created.
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. Mew Project O *

New Project

Choose source files

Top Directory: |P:WExampIe_PrDjecth‘#maszlibJ.2.8 | Browse...
Directory File
v [m]zlib-1.28 2 |t}-‘|se filter text |
» [ sefttings
s []amiga adler32.c ~
s [] as400 COMpress.c
s [] contrib crc3z.c
» [ dec deflate.c
s [] examples gzclluse.c
5[] msdos gzlib.c
> [ nintendods gzrea_d_c
> [Jold gzwrite.c
» [ gnx infback.c
s [ test inffast.c
s [ watcom inflate.c
s [Jwin32 w inftrees.c o

Text file written list of source files

| Browse...

¥ The entered text file is separated by ' or newline character. Remove

15 itemns selected

* You can select the source file directly, or through a text file with a file path.

4. Select source files directly.

a. Click [Browse ...] to specify the [Top Directory] to be displayed in the directory screen

below.
« Except in special cases, make the directory one level higher than the directory
containing the source files you want to select as the top-level directory.

b. On the [Directory] screen shown on the left, select the directory containing the source files
to be used for project creation.

c. The files in the selected directory appear on the [File] screen shown on the right. Check the
files to add.

5. Select by using a text file with the file paths.
a. On the [Text file written list of source files] screen shown below, click [Browse ...] to select a
text file with a list of source files(absolute file path).
b. Clicking the [Remove] button deselects the selected text file and the source file selected
through the file.

6. After all settings are completed, click the [Finish] button to create the project.
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8.2. C/C++ Project from Embedded

Create a project with an embedded project file(.xml, .gpj, .prw, .prj). Except in special cases, the
information required for the build is automatically entered, so there is nothing to specify by the user.

B rew Project O *

MNew Project

Create new project from CodeWarrior project file(* xml), Green
Hills MULTI project file(*.gpj)

Project name: |embedded |
Location: | P:#Product Workspacetct_3_1_02 |
Select Toolchain

Default Toolchain Mame Description
] CPP_TI_TMS320 6000_SoC_Unit

O GCC 4.7 (32bit)

O GCC 5.3 (32bit)

[ Microsoft Wisual Studio 2010 (32...

[ Microsoft Wisual Studio 2010 (32...

O Microsoft Wisual Studio 2015 (32...

[l Microsoft Visual Studio 2015 (32...

| gces

iar

Toolchain Setting

Import Setting
Embedded Project File: | |§r0w5e...|

< Back Next > Finish Cancel

1. Enter a project name in [Project namel].

2. Choose a toolchain that fits the embedded project you select.

3. In [Import Setting] -> [Embedded Project File], specify the embedded project file of the software
under test.

4. After completing all settings, click [Finish] to create the project.
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8.3. C/C++ Project from Visual Studio
Project

Create a project with a Microsoft Visual Studio project file(.dsw, .sIn, .vcxproj, .vcproj). Except in special
cases, the information required for the build is automatically entered, so there is nothing to specify by the
user.

B rew Project O ot

New Project

Create C/C++ Project from Visual Studio Project. (dsw, sin,
NVCXProj, .veproj)

Project name: |sample |
Location: | P:wProduct Workspacetct_3_1_02 |
Import Setting

Wisual Studic Project: |P:WExampIe_Prujecthanip’#cpfechfe.sIn ‘Browse..:

Advanced

o | oo cocl

1. Enter the project name in [Project name].

2. Specify the Visual Studio project file to import in [Visual Studio Project].

3. If there are values that must be set before calling the compiler of the toolchain to be registered,
add a script file to set the values to [Advanced]-> [Environment Script File].

4. Click [Next] to move to the next screen. When you click Done, module settings are randomly
selected for the imported Visual Studio project.
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. Mew Project O *

New Project

Create C/C++ Project frem Visual Studic Froject. (*.dsw, *sln,
*VCKProj, *.veproj)

Select Active Modules:

Active Module Configuration (Click to Edit)
misci¥mk_errinfo Debug|Win32
srcwdispidisp Debug|win32
srcfe Debug|win32

Select All | | Deselect All Set All Cenfigurations...

LiBek [ Meds Cancel

5. Select the module to be activated from the modules included in the Visual Studio project.
6. Select the configuration of each module.

+ [Set All Configurations ...] allows you to change the configuration for all modules in a batch.
7. After all settings are completed, click the [Finish] button to create the project.
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8.4. C/C++ Project form Existing CodeScroll
Project

Import an existing CodeScroll project and create a new project with that information. You can easily
create a new project with the same configuration(source file, exclude/include analysis, compile flags) as
the existing project.

B rew Project O ot

Import Projects —

/0, If the project of the same name exist, the '_copy' is added after the name ; .r'f
of the project. P |

Select root directory: | P-#Product_Workspacettct_3_1.02

Projects:

[zlib_build]MetLinked (P:#Product_Workspacewct_3_1_02%[zl & Selact All
[zlib_build]example (P-#Product_Workspacewct_3_1_02%(zlib
[zlib_build]minigzip (P-#Product_ Workspacewct_3_1_02%zlit Deselect All
[zlib_build_project]MotLinked (P-#Product_Workspacewtct_3_1
[zlib_build_project]example (F-wProduct_Workspacewct_3_1_(
[zlib_build_project]minigzip (P-#%Product_Workspacetct_3_1_
cpfe (PwProduct_Workspacewct_3_1_02wcpfe)

stub_sample (P-#Product Workspacewct_3_1_02%stub_sampl

target (P #wProduct_ Workspacewct_3_1_02#target)
zlib (P-wProduct Workspacewct_3_1_02%zlib) v

Refresh

1. Use the [Browse ...] button to select the CodeScroll workspace or CodeScroll project path.
2. Projects existing in the selected path are displayed in the [Projects] list.

* When the CodeScroll workspace is selected, all the projects under it are displayed.
3. Click [Finish] to create the project.
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8.5. Create a C/C++ Project with CPI File

Create a project from a CPI file. The CPI file is an information file for project creation in the command
line interface.

The CPI file must be created by the user using the template file in the {installation path}\plugins\

com.codescroll.gp.cli_x.x.x.x\cpi folder.

. MNew Project

New Project

Create C/C ++ project from the CPI file (* cpi) information.

Location: |P:wproduct_WorkspaceWct_S_LOz
CPI file
File: | | Browse(B)...
< Back Next = Finish Cancel

1. Select a CPI file with the [Browse...] button.
2. Click the [Finish] button to create the project.

* You can also create a project by dragging and dropping a CPI file into the test navigator.
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8.6. Create a C/C++ Project with Build
Information

Create a C / C ++ project from build information. The project is created as many as the number of
modules extracted from the build information.

1. Enter a project name in [Project name]. The final project name is determined by combining the
entered project name with the module name extracted from the build information.

» Ex) [Project name]Extracted module name
B new Project O *

New Project

Create C/C++ Project from Build Command. (2.g. makefile or build script)

Project name: |z|ib_bui|d_prcject |

Location: | P:#Product_Workspacettct_3_1_02 |

Select Teclchain

Teelchain Name - Diescription
CPP_TI_TMS320_6000_SoC_Unit

GCC 4.7 (32bit)

GCC 5.3 (32bit)

Microsoft Visual Studio 2010 (32bit)

Microsoft Visual Studio 2010 (32bit_64bit)

Microsoft Visual Studio 2015 (32bit)

Microsoft Visual Studio 2015 (32bit_g4bit)

gces

iar

[w]
i
Y
[=
=

OoooOoOogomod

Toolchain Setting
Import Setting
Build Command:

make clean al|

Build Directory: PwExample_Projectwcmamwzlib-1.2.3 Browse...

Mote: The final project name is determined by combining the entered project name
with the medule name extracted from the build information. (e.g. [project name] extracted module name)

Advanced

< Back Mext > Cancel

2. Choose the same toolchain as the compiler you use for the build.
3. In [Import Setting]-> [Build Command], enter the command required for the build.
» Ex) Make all / make clean
4. Specify the path where the makefile is located in [Import Setting]-> [Build Directory].
5. If there are values that must be set before calling the compiler of the toolchain to be registered,
add a script file to set the values to [Advanced]-> [Environment Script File].
6. After completing all settings, click [Finish] to create the project.
7. When the project creation is completed after building, the result screen appears.
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B Create 2 C/C+- project with the build informaticn X

The C/C++ project(s) has been generated with the build informaticn.
(If 3 project with the same name already exists, skip it in project creation)

Result:
Project name State

i [zlib_build_project]MotLinked SUCCEsS
[zlib_build_project]example SUCCess
[zlib_build_project]minigzip SUCCESS

» Success: Project creation complete.
» Error: If the creation failed due to an error during project creation.
+ Exclude: If the same project name exists in the workspace.
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Generate test data and test code to test the functions of the source code. You can create individual tests

for each function.

Create unit tests

Generate test data and test code for each function under test.

1. Select the project or module to create unit tests, right-click and click the [Create Unit Test] menu.

T Test Mavigator 5
0 stub_sample

[ target
= 7lih
1 MNew ¥
} * Delete Delete
1 Rename... F2
i Import.
g Export.
Refresh F5
Close Project
Quality Management Teols >
®  Run Target Test
24 Import Target Test Log >
Collect project log
Create Unit Test...
™ Run Test F11
% Rebuild and Run Test
Run RTV Test Alt+F11
Reanalyze
Merge Project coverage..
Properties Alt+Enter

==$

v = H

2. After the analysis is finished, in [Select function to be tested], select the function to perform the

unit test.

BB tew Test

Select Function to be tested
Select Function to be tested

1B Mew Test

Select Function to be tested
Select Function to be tested.

Project: [RTV_project

Project: [RTV_project

Selection type: [ Source file v

Selection type: v

[type fitter text |[type fitter text | | ~ Name | path |~
[ adler32.c [ adler32(unsigned long, const unsigned char L 5
. . 1 [ @ adler32(unsigned long, const unsigned char *, un... =] adler32.c
[ compress.c [ adler32_combine(unsigned leng, unsigned lg| i b by al B
(
O crez2c [ adler32_combines4{unsigned long, unsigned 2 Ll | @ adler32 combine(unsigned long, unsigned long, ... Bl adler32.c
" 3 [ | @ adler32_combine64(unsigned long, unsigned lon... [E] adler32.c
[0 deflatec [ adlers2_combine_(unsigned long, unsigned |
4 [ | @ adler32_combine_(unsigned long, unsigned lang, adler32.c
[ gzclosec [ adler32_z(unsigned leng, const unsigned chz
0 galibe 5 [ | @ adler32_z(unsigned long, const unsigned char *, ... [ adlers2.c
O geread.c & [ @ compressiunsigned char *, unsigned leng *, cons. compress.c
0 gewitec 7 [1 | @ compress2(unsigned char  unsigned long *, con compress.c
0 infacke 8 [0 | @ compressBoundiunsigned long) compress.c
0 intaste 9 [ | @ cre32(unsigned long, const unsigned char #, unsi cre32.c
O m"\ate.( 10 [1 @ cre32_bigunsigned long, const unsigned char *, cre3a.c
[ infireesc 11 [1 | @ cre32_combine(unsigned long, unsigned long, si cre3a.c
O treesc 12 [ | e crc32_combines4(unsigned leng, unsigned long, cre32.c
07 uncompre 13 [0 | @ crc32_combine_(unsigned long, unsigned long, si cre32.c
0 zutle 14 [ | @ cre32_little(unsigned long, const unsigned char #, cre32c
< > 15 [ @ cre32_ziunsigned long, const unsigned char *, u. cre3a.c ©
0 items selected 0 iterns selected
Run option Run option
[JRun after Test Creation [JRun after Test Creation
Host RTV Host RTV
Finish Cancel Finish Cancel
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a. You can filter the function under test using [type filter text].
b. You can use the [Selection type] combo box to select the function to be tested based on the
source file or function.
c. You can easily select and deselect all functions under test with the right-click menu.
When [Run after Test Creation] is selected, the test is executed after the test data is
generated.
3. Click [Finish] to create the unit test.

Create and run tests

The [Create and Run] function allows you to create and run unit tests at once without using the [Create
Unit Test] function.

1. Select the function to be tested in the test navigator and right-click.

T Test Mavigator BEg® v &
I stub_sample ~
17 target

~v 1 zlib
v (g Default Module

v g adler32.c

o adler”

o adle Create Unit Test
b Q compre: Create and Run
> L4 eres2c
> Ly deflatec
> [ grioc
5> Lg infoackc

v [ inffact ¢

2. If you select the [Create and Run] menu, it creates a test for the target function and then runs the
test.

Create an integration test

You can use the toolbar menu to create an integrated test.

Unit Test Integration Test = & & | &2 EH~- ¥= 08
v  Statement Coverage
;
(33/0/0) 33 43.0%
(1719/3995)
type file, test, state, issue
Name Result Coverage
v [ INTEGRATION_® 33/0/0) 33 100.0% (1212
w [1est]| adler32_combine(unsigned long, unsigned long, signed 11/0/0) 11
case] 1
case] 2
case] 3
case] 4
case] 5
case] 6
case| 7
case] 8
case| 9
case| 19
case] 11

The integration test name is automatically assigned and can be renamed using the [Rename] context
menu.
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Unit Test IntegrationTest] Bl @ EE = o
m | v statement Coverage|
(33/0/0) 33 43.0%
(1719/3995)
type file, test, state, issue
Mame Result Coverage
v I”TEGRT; Create Test. i 33/0/0 3? 100.0% (12/12)
v [Hesfl a Create sub-i . Rename [m] X

] Copy Mew name: |

Faste

4

1 Duplicate

{ Duplicate m | oK | | Cancel ‘

] Paste as sub

| % Delete Delete

CReme.

: Select Test
» [1est] adl Deselect Test g, signed (11/0/0) 11
> [fest] adl e. siened Mms0/01
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The test editor can be opened by double-clicking the test or test case in each test view, located at the
bottom of the unit/integrated test view.

Unit Test

BB E- =0

v Statement Coverage

0,
(19/0/5) 24 2.9%
(118/3995)
type file, function, test, state, issue
MName Result Coverage Q
v adler32(unsigned lon (8/0/513 97.0% 00
> adler32 - 3
v & > adler32_combine 11 100.0% (12/12
adler32_combine ng, si (117070 11
v
] adler32({unsigned long, const u... 52 =0
Test Info (zlib/adler32_test0) e B
Test Structure Q Test Info Edit
Test structure using a tree view and edit the information in the test. |Change the notaticn edit the partition i
Name In | Out = Set Numeral System
Test global code @ 10 Numeral System (O 16 Numeral System
User code

Global Variable
~ Test target function
~ @& adler32(unsigned long, const unsic ‘M‘" | - ‘Max
Local Static Variable

Variable Partition

“Smg\eValue
v Parameter/return

~w o adler - ulong Partition List

o adler : unsigned long ] 0O g

~ o buf : const Bytef * BE

v o [0] : Bytef "5
v o [0] : Byte g
o [0] - unsignedc [ v 1755517 v

Test Info | Test Case| Test Code | Configuration

Wl 122m of 1032m [

«¥s You can move the editor and open it in a separate window.
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The Test Information tab is a feature that presents the test code as a tree of test structures, making it
easy for users to modify the test code.

k| =adler32_combine{unsigned long,... i3

Test Info (test/adler32_combine_test0)

Test Structure

Test structure using a tree view and edit the information in the test

MName
Test global code
User code
Global Variable

v Test target function
T

~ @ adler3z_combine{unsigned long, unsigned long, signed

Local Static Variable
~ Parameter/return
~ @ adlerl : uLong
© * adler1 : unsigned long
o adler2 : ulLong
© adler2 : unsigned long
o len2 : leng
o retumnvar © ulong
o returnvar : unsigned long
Before call code
Adfter call code
User code
- Stub
Host
Target

<

<

Q, i Test Info Edit

In Out

Set the number format edit the partition

Base
@ Decimal (O Hexadecimal
Variable Partition
|Mm | ~ |Max
|Smg\e Value
Partition List
o
"1~4294967295"

C.
E o

Add

Add

Delete

Default

Test Info | Test Case | Test Code | Configuration

* User code can be inserted into the test code.
* You can control global variables related to the function under test.

* You can control the input and output of the function parameters and return values.
* You can enter the code to be executed just before calling the function under test.

« ™ markers appear at modified items. When you save modifications, the markers disappear.

Repeat function calls

You can have the function under test be called multiple times.

E] adler32_combing{unsigned long,.. 52
Test Info (zlib/adler32_combine_test0)

The information has been change aft iting the test

Test Structure aQmB
Test structure using 2 tree view and edit the information in the test.
Name n  out A
Test global code
User code
Global Varizble
~  Test target function
~ & adler32_combineunsigned long, u
Local Static Varizble
v Parameter/retum
v o adlerl : ulong
o adler : unsignedlong & [
« o adler2 : ulong
o adler : unsignedlong & [
o len2 : long [m]
of returnvar : ulong v

Test Infc | Test Case| Test Code| Configuration |

= 0
(=

Test Info Edit

Test target function

lterstion count: [5 [3

E| adler32_combins gned long,... £3

32

33

34 for(cs_index=0;cs_index<S;cs_index++){

35

E /* uLong [5] adler32_combine(unsigned long, unsigned long,

=7 returnvar[cs_index] = adlers2_combine(adlerl,adler2,len2);

38

39 }

20

e

42 /*output*/|

43 CS_UINT_OUTPUT (returnVar[8], "returnvar[8]");

2

as /*<END TEST>*/

45 /*<CS_DISCONNECT_CODE_START>*/

a7 /*Do not remove disConnect_stub_configuration()*/

48 disConnect_adler32_combine testd_stub_configuration();

49 /*<C5_DISCONNECT_CODE_END>*/

se }

51

52 #endif

53

signed long) */

Test Info |Test Case | Test Code| Configuration
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You can export/import variable partition information by selecting a variable on the Test Information tab.

1| adler32_cornbinefunsigned long,... &2

= B8
Test Info (test/adler32_combine_test0) & B
Test Structure Q, g Test Info Edit
Test structure using a tree view and edit the information in the test. Set the number format edit the partition.
Mame In Out Base
Test global code (® Decimal (O Hexadecimal
User code
Global Variable Variable Partition
v Test target function
~ @ adler32_combine(unsigned long, unsigned long, signed lo |M'” | - |Max ‘ Add
Local Static Variable |S\ng\e\falue ‘ Add
v Parameter/return
v © adler] - ong Partition List
< adler1 : unsigned long g Delete
v © adlerZ T ulong "1~4204067295"
o adler2 - unsigned long Default

K&

@ len2 : long
v & retumnvar - uLong
o returnvar © unsigned long
Before call code
After call code
User code
v Stub
Host
Target

Test Info | Test Case|Test Code  Cenfiguration

Menu Description

() Export Variable Partition Export the partition information of the selected variable.

(:T) Import Variable Partition Import the partition information of the selected variable.

Change detection

If you edit and save the information of a test that has already been executed, “The information has been

changed after executing the test.” is displayed at the top of the test editor.

k| adler32_combine{unsigned long,... &3
Test Info (zlib/adler32_combine_testd)

The information has been changed after executing the test.
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10.2. Test Case

Test Case Tab provide the ability to edit inputs for a function under test and the expected value for the
execution result.

] adler32_combine{unsigned long, .. 52 = 8
Test Case (zlib/adler32_combine_test0) #1 Q, Bl & E oo
Parameter Type Input Expected Value  Host Cutput Target Cutput

Local Static Variable
v Parameter/retumn
v o adler1
o adler unsigned long 65520
~v o adler2
o adler2 unsigned long 131041
o len2 long 2147483647
v o returnvar
of returnvar unsigned long 4279500767
Before call code
After call code

User code
Stk v

< >

» More Info

Test Info | Test Case | Test Code | Configuration

In the Test Structure tree, you can enter input values for the variables specified as input.

o |f there is no input value, the value of the variable is ‘undefined value’, and the tool
initializes the variable with no value entered as 0 (Blank if a string) for the
convenience of the user.

* You can switch the representation of the Test Structure as a table or tree with the [Show as Tree],
[Show as Table] toolbar menu.

« With the [Apply the test case in a lump] context menu, you can apply the input and expected
values of the test case to other test cases in the same test at once.

» If you select the ‘Out’ of a variable in the Test Structure tree, You can check the value of the
variable after the test is performed.

» Editable cells are displayed in a pale sky color.

+ If the expected value is different from the host/target output, it is displayed in blue.

+ If the host and target output values are different, it is displayed in yellow.

* You can use ~ (range) and logical operators! (Not), & (and), and | (or) in expected values.

» The following shortcuts are available.

o Undo:Ctrl +7

o Move row: arrow keys (1, |)

o Editable cell focus: Enter

o Editable cell focus out: Esc

o Move column (editable cell): Tab(right), Shift + Tab(left)

o Move test cases: Ctrl + /-

Change detection

If you edit and save the information of a test case that has already been executed, “The information has
been changed after executing the test.” is displayed at the top of the test editor.
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adler32_combine{unsigned long,... EE]

Test Case (zlib/adler32_combine_test0) #1

The information has been changed after executing the fest.

Page 44 of 322



Suresofttech User Manual - 3.6_en

10.3. Test Code

You can check the test code by clicking the Test Code tab in the test editor.

[t] adler32(unsigned long, const u... £ =g
1 Wline 2 "cs_test¥adler32_test@¥cs_error "
2/

e .. /factory/factory.h"
include "adler32_testd.h”

s
10 void CS_TEST adler32_testa()

2 unsignes m [1]-{0,}; .

Test Info [ Test Case | Test Code| Configurstion |

+ If the user edits and saves the test structure tree, the changes are automatically reflected in the
test code.

 If the return type of the function under test is a primitive type, a macro that outputs the return value
is automatically generated.

+ If you want to modify the test code yourself, you must switch the test to unmanaged code.

* The test execution function must have a return type and an input parameter of a void type.
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On the configuration tab, you can make various settings for unit testing.

k| adler32_combine{unsigned long,_.. 52
Configuration(zlib/adler32_combine_test0)

Test Name

|bd\ersz_ccmbme(uﬂswgned long, unsigned long, signed long)_&

Description

Set related file

P:wExample_Projectwcirdipwzlib-1.2.3%adler32.c Search..

Run Test

Test Case Timeout(Second) l:|

# If the time-out value is empty, run the time-out value of the project.
[JMaintain test case context

Change Unmanaged Code |

Test |ﬂfD‘TESf Case | Test Code | Configuration

+ If you modify and save the test name, the test name that appears in the unit test view changes.

* You can enter a description for the test.

« With the related file settings, you can select the file to which the function under test belongs.

* You can set the timeout for the test.
* You can choose whether to keep the context for the test.

« If you want to write test code yourself, you need to do [Change Unmanaged Code].
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Controller Tester provides several macros to help users write test code more easily. You can check and
write the macro provided using the shortcut(Ctrl + Spacebar) in the Test Editor.

ASSERT macro

Examine the conditional expression and print the success/failure in the Test Case Tab.

Macro Parameter

CS_ASSERT(_b) _b: conditional expression
_B: conditional expression
CS_ASSERT_MSG(_B

_msg)

Output macro

Example

CS ASSERT (val!=1);

CS ASSERT MSG(val==1, "va

_mgs: message to print when the
conditional expression is false

1 is not 1!");

Print the values of specific variables in the Test Case Tab.

Macro Parameter
CS_INT_OUTPUT( v,

_S)

CS_UINT_OUTPUT( v, v: avariable to print the
) value
CS_FLT_OUTPUT( v, _s:aname to show in the
_S) Test Case Tab
CS_STR_OUTPUT( v,

_s)

Input macro

Pass test data to the function under test.

Macro Parameter

CS_INT_INPUT(_t,

_s)

CS_UINT_INPUT(_t, )
s) _t: a type of the variable

- _s: a name to show in the
CS_FLT_INPUT(_t,
s) Test Case Tab

CS_STR_INPUT( t,
s)

Example

CS_INT OUTPUT (int var,
CS_UINT OUTPUT (unsigned int var,

"int var name");
"unsig
ned int var name");
CS_FLT OUTPUT (float var, "float var nam
e");

CS_STR OUTPUT (string var, "string var n

ame") ;

Example

CS_INT INPUT (int, "int var name");

CS_UINT INPUT (unsigned int, "unsigned i
nt var name");
CS_FLT INPUT (float,

CS_STR INPUT (char*,

"float var name");

"string var name");
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Address-related macros

If there is a part that directly assigns or fetches the value in the embedded address in the converted
source code, it may not operate normally when executed on the local computer. In this case, you can
use an address-related macro for the virtual address.

Macro Description
CS_VIRTUAL_ADDR( b, e) Creates the space from the address (_b) to the address (_e)

CS_ADDR_ASSIGN(_t, a, V)

CS_ADDR_SET(_t_a, V) Assigns the value (_v) of type (_t) to the address (_a)

CS_ADDR_GET(_t, _a) Fetches the value of type (_t) from the address (_a)

CS_VIRTUAL_ADDR_CLEAR() Frees the memory space created

Address-related macro example

// Create a virtual memory area of size 100 from OxFFE40000U.
CS_VIRTUAL_ADDR(OXFFE4000OU, O0xFFE40000U+100) ;

// Assign value 10 of int type to O0xFFE40000U
CS_ADDR_ASSIGN(th , OXFFE40000U, 10);
CS_ADDR SET (int ,0xFFE40000U, 10);

// Return the value from OxFFE40000U to the variable a.
int a = CS_ADDR GET (int , 0xFFE400000U) ;

// Return an address of OxFFE40000U into variable ptr of pointer type.
int* ptr = CS ADDR PTR(OxFFE400000U) ;

// Frees the memory space created.
CS_VIRTUAL ADDR CLEAR() ;

«¥s For more information about address-related macros, see the Virtual Address Usage
Guide page in the User Guides.

Other macros

Macro Parameter Description Example
_msg: log
CS_LOG(_msg) Outputs user log CS LOG("User Log");
message
Returns the number of the test int testCaseNum = CS_TES

CS_TESTCASENO
- 0 currently running TCASENO () ;
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Testing can be performed in a variety of ways.

Run all tests

Run the selected tests in the [Unit Test] view and [Integration Test] view.

1.

Select the project to run the test, right-click ans slect [Run test]

Tg Test Mavigator i3

3 stub_sample
3 target
1= 7lih

{

1
1
1

C. &

Mew

Delete
Rename...
Import...
Export...

Refresh

Close Project
Quality Management Tools

Run Target Test
Import Target Test Log
Collect project log

Create Unit Test...

Run Test

Rebuild and Run Test
Run RTV Test

Reanalyze

Merge Project coverage...

Properties

Delete
F2

F5

F11

Alt=F11

Alt+Enter

El

=3

¥ =

2. A progress monitor of the test opens. When the test is completed, you can check the results

through each test view.

Run unit tests

Run the selected unit tests in the [Unit Test] view.

1. Click the [Run] button on the dashboard in the [Unit Test] vie

Unit Test ntegration Test

type file, function, test, state, issue

(655 /0 / 283) 938

W.
g H~ =8

v Statement Coverage

2. A progress monitor of the test opens. When the test is completed, you can check the results

through each test view.
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* To perform only a specific test case, select the test case you want to run and right-click

the mouse and click the [Run Test Case] menu.

Run integration tests
Run the selected tests in the [Integration Test] view.

1. Click the [Run] button on the dashboard in the [Integration Test] view.

Unit Test Integration Test 2oL |E B2 EHy = 8
v Statement Coverage

| ;
(33/0/0) 33 43.0%
(1719/3995)

type file, test, state, issue

2. A progress monitor of the test opens. When the test is completed, you can check the results

through each test view.
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If an error occurs while running the test case, you can use the [Inspect Debug Info] function to determine

the cause of the error.

[Inspect Debug Info] function can be checked in the unit test view with the context menu of the test case.

Copy Ctrl+C
Paste Cirl+\
Duplicate Ctrl+D
Duplicate multiple times...

#H Delete Delete
Add Test Case

Host Cutput Value -= Expected Value
Target Cutput Value -> Expected Value

™ Run Test Case
& Run Target Test Case

it Add Stub...

Open Host Error Loaction

i Inspect Debug Info

«¥s Test cases that have not been executed are automatically executed before [Check

Debug Information] is performed.

When [Inspect Debug Info] is performed, debug information is displayed in the [Inspect Debug Info].

% Debug Information &2 @ = 8
Test Case (test/func_test0) #1
Stack trace: List of variable/expression:
v % [Project: test] test run Variable/Expression Value Location
— . . .
= func3(signed int %) at test1.c42 p (testi.c: 40) 12319812 before line

= func2() at test1.c:30
= func(signed int) at test1.c12

The test case (Debug info included) is displayed in the test case where the [Inspect Debug Info] was

performed.
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w test()

v [ (1851 test() o
1 signaled (Debug info included)
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13. Properties

Controller Tester provides a page that enables to set the properties of the project, module, and source
files.

The property page types are:
» Project Properties

* Module Properties
» Source File Properties
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13.1. Project Properties

You can edit the properties of the created project.
Select [Project]-> [Properties] from the menu or right-click the project in the Test Navigator view and
click the [Properties] menu.

Inclusion and Exclusion Info

You can set what to exclude or include when analyzing the project.

* To analyze only selected directories or files, add the targets to be analyzed to [Included]
and check [Exclude All].

I Properties for zlib ] X
ype filter text Inclusion and Exclusion - v
Inclusion and Exclusion
: Included
Info
» Target test Add File.
Test
’ Add Directory.
Edit...
Remove
Excluded
W CwProgram FileswCodeScroll Controller Tester 3.2%pluginstécom.codescroll Add File.

25 pwproduct Workspacewcet 3 1_01%wzlibW.csdata

A P WorkspaceWTarget_Platform#Oxygentwindows®. #. ¥ #u-4-2-br_newd| Add Directory...

Edit...

Remove

< >
[ Exclude All

Note: If there is one resource in both places, the resource is inclusion item.

Apply and Close Cancel

+ Add targets to include in the analysis.
1. Click the [Add File] or [Add Directory] button.
2. Select files or a directory to analyze.
3. Click the [Open] or [OK] button.

* Add targets to exclude from the analysis.
1. Click the [Add File] or [Add Directory] button.

2. Select files or a directory to exclude from the analysis.
3. Click the [Open] or [OK] button.

Info

Shows brief information(path, type, location) about the project.
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type filter text Info f=I = 4

Incl d Excl
‘:'[Dusmn & clusion Project Infermation

5 Target test Path:  /zlib

> Test Type: Project

Location: P-/Product Workspace/ct_3_1_02/2lib

Apply and Close Cancel

Virtual Address

You can select a memory setting managed by the Virtual Address preference.

B Froperties for zlib m] X

type filter text Virtual Address Srorw
Inclusion and Exclusion
Infe. Configuration name: |} iV
> Target test Detail information
w Test
Exclusion of coverage Begin
External Command
> Generate test cases automatically
Run Test
Virtual Address

End

Apply and Close Cancel

External Command

You can enter external commands to run before or after the test run.

User Manual - 3.6_en

In [Pre-command for test run], you can enter a command or batch file to execute an external command

before running the test.

In [Post-command for test run], you can enter a command or batch file to execute an external command

after running the test.
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B Properties for zlib O x
type filter text External Command fror
Inclusicn and Exclusion
Info Pre-command for test run
» Target test [ P#Example_Projecticivdipszlib-1.2.3#rebuild bat |
v Test Post-command for test run
Exclusion of coverage - - — -
External Command |P.'n\‘Btample,ProJecthwdlszhb-1 2.3#rebuild.bat |
» Generate test cases aut
Run Test
wirtual Address
< >
Apply and Clusel | Cancel

Exclusion of coverage

You can set coverage exclusions on a per-file or per-function basis.

User Manual - 3.6_en

You can see that the coverage of the excluded function is excluded from the coverage results obtained

by running the test.

B Froperties for zlib m] X
type filter text Exclusion of g =10 NI 2 4
Inclusion and Exclusicn =
Info The list of resources excluded coverage.
5 Target test The list of files excluded coverage.
v Test Source File Add...
Exclusion of coverage
External Command Remove
> Generate test cases aut
Run Test
Virtual Address
The list of functions excluded coverage.
Functicn Source File Add
Remove
< >
Apply and Clmel | Cancel
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Set the generated tests to run in a user-specified directory, not in a workspace. In this case, you do not
need to copy the library or header files used by the target under test to the workspace or change the link

settings.

Click the [Start Test in User Code] checkbox.

Select the home directory to run the test and click the [Apply] button.

B Properties for zlib

type filter text
Inclusion and Exclusion
Info
Target test
w Test
Exclusicn of coverage
External Command
Generate test cases au
Run Test
Virtual Address

Run Test

[] start Test in User Code

Test Launch Directery : |

Test Case Timeout(Second) |3 =

[ Maintain test case context
[JRedirect standard output or standard error

Restore Defaults

Apply

Apply and Clese

Cancel

[Test Case Timeout] Set the time to be used as the timeout judgment when executing the test case. If
the test execution time exceeds the test case timeout time, the test for that test case ends and the result

is reported as a timeout.

[Maintain test case context] is a feature that performs all test cases with one launcher. The previous test
execution result (static, global variable) is maintained during the test, and each test case result value
does not appear independently. This makes the relationship between the test case result values clear.

[Redirect standard output or standard error] is a feature to record standard output and standard error in
the log file for each test case.

Generate test cases automatically

You can set to keep previous test cases when automatically generating test cases.

! The search-based generation is not affected.
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B Properties for zlib

type filter text
Inclusien and Exclusien
Info
Target test
v Test
Exclusion of coverage
External Command

Run Test
Virtual Address

Generate test cases automatically

test cases ically f=14 -

Generate test cases automatically
Keeping the previous test case when auto generating test cases
% Search-based generation is not affected.

Restore Defaults Apply

Apply and Close Cancel

Combination

You can set up how to extract test data if the variable partition is range.

B Properties for zlib

type filter text

Inclusion and Exclusion
Info
Target test
w Test
Exclusion of coverage
External Command
w Generate test cases aut
Combination
Function Generator
Search-based (C5 L
Run Test
Virtual Address

Combination (=g -

Create Test Data from Partition
Max

Min

[JRandom

Data Combination
(®) Flat Combination
() Pairwise Combination

Number of Limit:  [200

(O Random Combination

Number of Test case |5

Array elements.
(® Generate array of the first element () Generate array of all the elements

Generate global variable
[ Create global variable in the relationship between function calls.

Restore Defaults Apply

Apply and Close Cancel

User Manual - 3.6_en

Select the desired test data extraction method by checking the checkbox. The meaning of each value is

as follows.

Method

Max value

Min value

Random value Selects a random value among partition sections.

Description

Selects the maximum value of the partition section.

Selects the minimum value of the partition section.

You can select multiple test methods of data extraction.
When all are unchecked, the default is automatically set to the maximum and minimum values.

[Data combination] supports Flat, Pairwise and Random. The meaning of the combination is shown in
the following table.
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Combination Description
Flat Combines simply based on variables having the largest number of test data.

Combines so that each selected parameter data is paired at least once with the parameter
data other than itself.

Pairwise is performed as many as the maximum number(default 200) of symbols used for
the combination, and when the number of symbols is exceeded, Flat is performed.

Pairwise

Combines the test data as many as the number of test cases that the user defines any value
Random between the minimum value and the maximum value for the variable partition of input
parameters(default 5).

[Array elements] is a feature to select how to generate test data for each array element.

Method Description
Generate an array of the first element Creates only the first element regardless of the array size.

Generate an array of all the elements Creates elements as much as the array size.

When creating a test, global variable creation is an option to create all global variables used by all
functions called from the function under test.

Search-based (CS Labs)

es CS Labs allows you to preview new features that will be released in CodeScroll tools
later. Based on feedback for the new features, CS Labs features may or may not be
applied as formal features.

You can set the maximum search when automatically generating test cases based on search.
You can turn this feature on or off with [activating search-based test case generation] option. Reanalysis
is required after turning the feature on.
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& rrop X u] X
type filter text Search-based (CS Labs) Lo
::;:;usmn and Sxclusion [ Activate search-based test case generation
v Test General settings for maximum search:
External Cemmand Mumber of searches(for each branch case): 400
~ Generate test cases aut
Combination Search time (seconds): 300
Function Generator
Search-based (CS L
Run Test
Virtual Address
( ) Restore Defaults Apply
G
Option Description
Number of searches(for each Searches for the number of times entered for each branch
branch) combination.
Search time(seconds) Searches for the time entered.

Function Generator

When using the function generator to automatically generate test cases, specify common setting values
that each function has in common.

B rroperties for zlib m] *
type filter text Function Generator (g Mg
Inclusion and Exclusion
Info Sample interval |E |
Torget test Sample count: |D- |
w Test

Exclusion of coverage Start value: |C' |
External Command
~ Generate test cases automatically

Combination
Functicn Generator
search-based (CS Labs)

Run Test

Virtual Address

Restore Defaults Apply

Apply and Close Cancel

Option Description
Sample interval Interval of samples when sampling from function

Number of samples when sampling from function

Sample count
(Number of test cases)

Start value Default value at which the function starts, and generates a value based on the value
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Import settings

Project created by Visual Studio project

. Properties for cpfe [m]
type filter text Import =R =
Import
Inclusion 2nd Exclusicn Visual Studio Project: P:#Example_Projectwcinvipwcpfewcpfe.sin
nfo Select Active Modules:
» Target test
5 Test Active Module Cenfiguration (Click to Edit)
misc#mik_errinfo Debug|Wwin3z2
sreswvdispidisp Debug|win32
srcwfe Debug|Win32
Select All | | Deselect All Set All Configurations.
Restore Defaults Apply
Apply and Close Cancel

User Manual - 3.6_en

You can see the path of the Visual Studio project used for creating the project and the modules active in

the selected project.

You can change whether each module is active or not and the configuration.

You can change the configuration of all modules collectively through the [Set All Configurations] menu.

1. If you click the [Set All Configurations] button, a dialog box where you can select one of the
configurations common to all modules opens.

B set all Configurations O

Commen Configurations:

ot

:
[0 Debugjwin32

cone
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2. Select the configuration to be applied to all modules in common and click the [OK] button.
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Build

You can set toolchain related information (toolchain, linker) and link flags for the module. Changing the

toolchain also changes the toolchain set in all source files under the module.

B Properties for Default Module m}
ype filter tesd Build - -
Build
o S Select a teclchain
Cempile flag —
Default Teclchain Mame Description
O CPP_TI_TMS320_6000_SoC_Unit
O GCC 4.7 (32bit)
GCC 5.3 (32bit)
O Micrasoft Visual Studio 2010 (3...
O Micrasoft Visual Studio 2010 (3...
O Microsoft Visual Studio 2015 (3...
O Microsoft Visual Studio 2015 (3...
O gecs
O iar
Linker: gec.exe ~
Link Flag:
Undo Redo Find/Replace
Restore Defaults Apply
Apply and Close Cancel

Compile flag

You can set compile flag information for that module.
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. Froperties for Default Module m] *
type filter text Compile flag = - v
Build

Compile flag Note: The compile flag information is saved in all source files set to use a parent compile flag.

Overwrite all sub source files

Command Include Define Macro

Undo Redo Find/Replace.

£2g Import.. &5 Export...

Apply and Close Cancel

+ Enter compile flags in [Command] tab. [Include] tab and [Define Macro] tab help to enter compile
flags easily.
« [Overwrite all sub source files] overwrites the compile flag entered to all source files under the
module.
» [Import] imports an external compile flag. [Export] saves the current compile flag externally.
o |Import
1. Click the [Import] button.
2. Select the file (.cf file) which has compile flags from the file open dialog.
o Export
1. Click the [Export] button.
2. In the save dialog, enter the name and location of the file to enter the compile flag and

save.
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13.3. Source File Properties

Build

You can set toolchain related information (toolchain, compiler) for the source file.

B Froperties for adleraz.c O X
y Build AT T
Build ] Select a toolchain
Cempile flag -
Info Default  Toelchain Mame Description

CPP_TI_TM5320_6000_SoC..
GCC 4.7 (32bit)

GCC 5.3 (32bit)

Microsoft Visual Studio 20...
Microsoft Visual Studio 20...
Microscft Visual Studic 20.
Microscft Visual Studic 20.
gees

iar

gooooordn

Compiler: gcc.exe ~

Restore Defaults Apply

Apply and Close Cancel

Info

Shows the information of the source file and the module containing the source file.

B eroperties for adler3z c a x
type filter text Info =l =i
Build

Translation Unit Information

Compile fla
° ¢ Medule: Default Module

Info
Primary Scurce File Information

Path: /zlib/adler32.c

Type: Linked File

Location: P/Example_Project/c/dip/zlib-1.2.3/adler32.c
Size: 4,561 bytes

Apply and Close Cancel

Compile flag

You can set compile flags for source files.
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B Properties for adler32 c m] X
type filter text Compile flag = - -
Compile flag [JiParent compile flag inheritance
Infe Command |nclude Define Macre
Undo Redo Eind/Replace...
£ Import... 253 Export...
Apply and Close Cancel

» If you check the [Parent compile flag inheritance] checkbox, the compile flag of the module
containing the source file is applied. Conversely, you can change the current compile flag
information by unchecking the checkbox.

* [Import] imports an external compile flag. [Export] saves the current compile flag externally.

° Import
1. Click the [Import] button.
2. Select the file (.cf file) which has compile flags from the file open dialog.
o Export
1. Click the [Export] button.
2. In the save dialog, enter the name and location of the file to enter the compile flag and
save.
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14. Preferences

In the preference menu, you can check or change the current settings of the tool.

The preferences provided by Controller Tester are as follows.

* Analysis

» Exclusion

» Performance

» Source File Types
+ Language

+ Theme

« Test

+ Toochain

* Editor
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14.1. Analysis
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You can check or change the settings related to the analysis.

Metric

For any view showing metric data, you can set which metrics are visible or hidden and the order in which

they are displayed.

The name of the selected metric is displayed as a tooltip message.

B preferences m]
type filter text Metrics =R -
w Analysis
CFG Module File Class  Function
Call Graph
Function View Hide/Show Metrics
v [ Hide Show
Diagnosis FUMCYC FUNST up
View FUMMC e FUCYC —
Test Navigator FUMIN FUNDC =
Editor FUNSP << | FUMNCE
Exclusion FUNCR FUNPA
Language FUNEM FUNGS
berformance L FUNRD
Perspectives FUNDM
Register external comman
Source File Types
Target Test
Test
Theme (CS Labs)
ToolChain
key
< 5 Restore Defaults Apply
coce

After selecting a metric, you can move to the ‘Hide’ list or the ‘Show’ list with the [>>] or [<<] button.
After selecting a metric in the ‘Show’ list, you can change the order in which the metrics are displayed
with the [Up] or [Down] button.

Metrics View

You can change the settings of the views showing metric data.
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B preferences O x
type filter text View S v ow
w Analysis .
5 CFG Metrics View
5 Call Graph Rows per page: [100 |
" Ii:l:t:::c‘iﬂ View Metrics Tep Chart View
Diagnosis Sum for the rest of the items to display
View Number of items to display: |1D |
Test Mavigator
Editor Metrics Bar Chart View
Exclusicn Nurmber of items to display: |5CHJ |
Language
performance Metrics view and Metrics chart view interwork
Perspectives Filtering the items of the metric view based cn the value selected in the metrics chart view
Register external comman: Number of items to display: |5 |
source File Types [A The metrics chart view display a range of filtering in metrics view
» Target Test
5 Test Metrics Diagnosis Chart View
Theme (CS Labs) Show the sum of items that cannot be diagnosed
> ToolChain
key
< 5 Restore Defaults Apply
Apply and Close Cancel

You can check or set diagnostic information for metrics.

Set the message and diagnostic image (shown in the metrics view) to be displayed when the selected

metric value is included in each range.

B Preferences | X
type filter text Diagnosis v
w Analysis
y CFG Module  File Class  Function
» Call Graph
Function View Diagnosis of ~
v Metrics -
Diagnosis Message Range Image Edit...
View Simple(without mu... [0.00, 10.00) W
Test Mavigator Moare complex(mo...  [10.00, 20.00) -
Editor Complexthigh risk)  [20.00, 50.00) <2
Exclusion Greatly complexive... [50.00, max) =
Language
Performance
Perspectives

Register external comman:
Seurce Fils Types

Target Test

Test

Theme (CS Labs)
ToolChain

key

VoW

v

Restore Defaults Apply

Apply and Close Cancel

To edit the diagnostic information, click the [Edit] button.
A dialog box appears where you can edit the diagnostic information for the selected metric.
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Diagnesis Level: ¥
Set of Images: | Weatherd ~

Levell

Change Sort Order

Message: |Simple(withnut much rish)
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Range: [0.00 - Image: ¥
Level2
Message: | More compleximoderate risk)
Range: |10.00 ~ |20.00 Image: .
Level3
Message: | Complexihigh risk)
Range: [20.00 ~ |s0.00 Image:
Leveld
Message: | Greatly complex(very high risk)
Range: |50.00 ~ |max Image: ==
Cancel
1. Set the diagnostic stage (2 ~ 5).
2. Sets the diagnostic image to show in the metrics view.
3. Press the [Change Sort Order] button to change the sort order of diagnostic images.
4. Enter the diagnostic message and diagnostic range for each step.
5. Select the [OK] button.

CFG

You can change the settings for the control flow graph displayed in the control flow graph view.
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B Preferences O *

type filter text CFG S v ow

~ Analysis
Centrol Flow Graph Preferences:
> CFG P

Call Graph [15how Function Call
Function “iew Show Library Functicns
Metrics Enable Autc-Layout

Test Mavigator

Editor

Exclusicn

Language

Performance

Perspectives

Register external comman
Source File Types

Target Test

Test

Theme (CS Labs)
TeolChain

key

v

v

W

v

Restore Defaults Apply

Apply and Close Cancel

Node Color

You can change the color of nodes in the control flow graph.

B Preferences [m] %
type filter text Node Color Gvvw
~ Analysis ]
v CFG CFG Nede Color:
MNode Color Begin Node Color: | —
» Call Graph ]
Function View Epdliodedeolbon —
> Metrics Condition Node Color: | —
Test Mavigator
Editor Block Nede Color: —/1
Exclusicn
Language Goto Node Color: 1
Performance Return Node Color: —]
Perspectives
Register external commani | Function Node Color: —1
Source File Types . ) ]
s Target Test Library Function Mode Celor: 1
> Test Single Statement Node Color: |
Theme (CS Labs)
s ToolChain Single Declaration Nede Celer: |
ke
¥ Group Mode Color: —
< s Restore Defaults Apply
Apply and Close Cancel

Test Navigator

For each operation that copies or moves source files in the Test Navigator view, you can set options to
ask whether or not to continue.
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. Preferences

type filter text

~ Analysis
» CFG
> Call Graph
Function View
> Metrics
Test Navigator
Editor
Exclusicn
Language
Perfermance
Perspectives

Source File Types
Target Test

Test

Theme (CS Labs)
ToolChain

key

Test Mavigator

Register external comman

Copy source files te the other module by drag and drop.
(O Always O Never (@ Prompt

Move source files to the other module by drag and drop.
O Always O Never @ Erompt

Copy and paste a source file to a medule

O Always O Never (@ Prompt

Note: Drag and drop a source file to the other module with Ctrl key pushed down in order te copy a source file.

Restore Defaults Apply

Apply and Close Cancel

Function View

B Preferences

type filter text
~ Analysis

» CFG
» Call Graph

» Metrics

Editor
Exclusicn
Language
Performance
Perspectives

Function View

Test Mavigator

Register external comman
Source File Types

Function View

O

Gov v

*

-

Limit visible functions per group te (0: Unlimited): l:l

» Target Test
> Test
Theme (C5 Labs)
3 ToolChain
key
< s Restore Defaults Apply
Apply and Close Cancel

Call Graph

User Manual - 3.6_en

You can change the settings of the function call graph displayed in the call graph view.
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. Preferences O X
type filter text Call Graph e T
~ Analysis §

. FG Call Graph Preferences:

[J Show Library Functions

> Call Graph
Function View Call Depth Setting
> Metrics (O Does net distinguish the direction

Test Mavigator

2

Editor Depth setting:

Exclusicn (® Distinguish the direction

Language Incoming depth setting: |2 |
Performance S |3 |
Perspectives utgoing dep Mgz

Register external comman
Source File Types

Target Test

Test

Theme (CS Labs)
ToelChain

key

v oW

v

Restore Defaults Apply

Apply and Close Cancel

The [Show Library Functions] checkbox allows you to set whether or not to display library functions.

If you set the value of ‘Does not distinguish the direction’ to ‘2’ in ‘Call Depth Setting’, it shows the call
information of one depth for both the caller and callee, centering on the selected function(Just the callers
or callee of the selected function shown).

If you want to set the caller and callee separately, you can specify the value of each step by selecting
the sub-option. You can change the color of nodes visible in the function call graph.

B Preferences m] Py

type filter text Node Color Cro->

~ Analysis
> CFG
~ Call Graph Functicn Nede Color: 1
Node Color
Function View
> Metrics
Test Mavigator
Editer
Exclusicn
Language
Performance
Perspectives
Register external comman
Source File Types
Target Test
Test
Theme (CS Labs)
ToolChazin
key

Call Graph Nede Celor:

Library Functicn Nede Color: ([

v oW

v

Restore Defaults Apply

Apply and Close Cancel
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14.2. Exclusion

You can set the directories and files to exclude from the analysis.

B Freferences O X
type filter text Editor G- [

Analysis .

Editor Editer settings:

Exclusion Text file enceding

Language (® Default (UTF-8)

Performance Qother: |UTF-8

Perspectives -

Register extarnal comman: [ Automatic detection

Source File Types )

Target Test Yri g

Test Tab size:

Theme (CS Labs) dif

ToolChain Detect medifications

key [ Check the effect whenever the source file is medified (Including external modifications)
< N Restore Defaulis Apply

Apply and Close Cancel

* Add the analysis exclusion target.
1. Click [Add].
2. Select the directories or files to be excluded.
3. Click [OK] or [Open].

* Delete the analysis exclusion target.
1. Select the directories or files to be deleted.
2. Click [Remove].
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14.3. Performance

It provides the settings that can improve the work performance suitably for the user environment.

B FPreferences m} X

type filter text Performance Gror v

5 Analysis -
Editor Multi Core usage

Exclusion Perform Multi-core Analysis

Language Number of threads:

Performance
Perspectives [Jusing frozen code

Register external commary | Mote: Use this option if there are no changes te the source code.
Minimizing unnecessary tasks to improve performance.

Source File Types
Target Test
» Test

Theme (C5 Labs)
» ToolChain

key

v

Restore Defaults Apply

Apply and Close Cancel

Multi-Core Usage

The option [Multi Core usage] improves performance by using multiple cores when executing the project
analysis. (If PC has not enough CPU resource, it can affect the performance of the other tasks.)

« Perform Multi-core Analysis: Enter the number of the core to be used when analyzing the source
code. (The range of the core number: 2 ~ the maximum number of cores in the execution
environment)

Using frozen code

The option [Using frozen code] improves the performance by minimizing unnecessary tasks (detecting
and re-analyzing source code modifications etc.) assuming that there is no change in the source code
configuration.

Use this option only if the PC performance is very slow and the source code configuration is never
changed during testing. (If the source code or analysis setting is changed while the option is enabled, it
may cause unexpected problems.)

* Difference with Editor — [Detect modifications] option
While if [Detect modifications] option of Editor is enabled, it analyzes the modified source
code when executing [Analyze], if [Using frozen code] option of analysis is enabled, it
does not analyze the modified source code until re-analyzed even though the source
codes are modified. In addition, Editor — [Detect modifications] option is ignored.

Page 75 of 322



Suresofttech

14.4. Source File Types

User Manual - 3.6_en

You can set the extension to be used as a source file for each project type.

B FPreferences m} X
type filter text Source File Types (=14 v v
> Analysis .
Editor Source file types can add or delete.
Exclusion Project Category:
Language
Performance
Perspectives
Register external comman:
Source File Types
» Target Test C/C++ File Types:
> Test File Type  Description . Status Add
Theme (C5 Labs) . )
, ToolChain . C Source File Product Def... Remove
key =C C++ Source File Product Def
*.cc C++ Source File Product Def...
*.cpp C++ Source File Product Def...
0K C++ Source File Product Def...
< N Restore Defaults Apply
Apply and Close Cancel

* Add a source file extension.
1. Select the project type.

2. Click [Add].

3. Enter an extension, select the type and click [OK].

B c/C++File Type

C/C++ File Type
Enter a file type.

s

Pattern : *. ||

type C Source File

OK

Cancel

+ Remove a source file extension.
1. Select the project type.
2. Select the extension to be removed.
3. Click [Removel].
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Sets the language to be displayed in tools and reports.

You can select a language from the drop-down menu for [System] and [Report].

|ty'pe filter text

| Tl = 4

> Analysis

Editor

Exclusicn
Language
Performance
Perspectives
Source File Types
Target Test

Test

Theme (CS Labs)
TeelChain

key

W

v

System: |English (United States) |

Report: |English (United States) |

| Restore Defaults| |

Apply

|Apply and Closel |

Cancel

If you click the [Apply] button after changing the [System], a dialog box asking you to restart Controller

Tester will open.

|type filter text

| Le=TE B = 2

> Analysis
Editor
Exclusicn
Language
Performance
Perspectives
Source File Tvpes

System: |Korean (South Korea) v|

Report: |English (United States) ~|

s Targ [l Change Language
> Tes

» Too
key

The You need to restart Controller Tester to change the [System] language.
Would you like to restart?

| Restore Default5| |

Apply

|Apply and Closel |

Cancel

* When you change the system language, the report language also changes automatically.
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To set the report language differently from the system language, change the report
language after restart.
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14.6. Theme

It provides the settings for changing the theme of the Controller Tester.

* CS Labs allows you to preview new features that will be released in CodeScroll tools
later. Based on feedback for the new features, CS Labs features may or may not be
applied as formal features.

B Freferences [m| X
[type filter text | | Theme (€S Labs) v
> Analysis
Editor Enable theming (requires restart)
Exclusion Theme: | Light w ‘
Language
Performance Color and Font theme: |Defau|t (current) v‘
Perspectives
Register external commar
Source File Types
> Target Test
> Test
Theme (CS Labs) Description:
» ToolChain
key
[] Enable animations
Use mixed fonts and colors for labels
Visible tabs on overflow:
Show most recently used tabs
< N | Restore E_)efau\t5| | Apply |
IAppI)r and Closel ‘ Cancel |

Page 79 of 322



Suresofttech

14.7. Test

User Manual - 3.6_en

Provides settings related to editing test and execution.
[Except for non-executable tests when errors occur during test execution] is an option that allows you to
execute only executable tests, excluding non-executable tests, when the whole test cannot be performed

due to an error that occurs during test execution.
The [Using Macro Constant] option allows you to edit the test using macro constants defined in the
source file (ex: using macro constants for input/expected values of array indexes and test cases).

! This setting only applies to converted projects.

B preferences

type filter text
Analysis
Editor
Exclusion
Language
Performance
Perspectives
Register external comman
Source File Types
Target Test
Test
Theme (CS Labs)
ToclChain
key

Test G

Except for non-executable tests when errors occur during test execution
() Always (O Mever (@) Prompt
3 This does not apply to the target test.

Note: If you can not proceed with the test due to an error that cccurred

during the test run, continue to run only the runnable tests, with
the exception of non-executable tests

[Jusing Macro Constant

Note: Changes to the 'Use Macro Constants' opticn are not reflected in existing projects.
To be reflected in an existing project, you must perform a "reanalysis”

Restore Defaults

Apply

Apply and Close Cancel

Virtual Address

It provides the memory settings for the embedded environment test. You can manage the memory
address group to be used in the project properties.
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B Preferences

type filter text
> Analysis
Editor
Exclusion
Language
Performance
Perspectives

Source File Types

Target Test

v Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
Wirtual Address

Theme (CS Labs)

ToolChain

key

v

v

Register external comman

O x
Virtual Address (=T =
Configuration name Description Add...
Edit(E)

Remove

wirtual memory address value range list

Begin

End

Apply and Close Cancel

User Manual - 3.6_en

In the screen above, you can check the virtual memory address information set. Click [Add...] button to

add the virtual memory address.

Basic Cenfiguration

BB virtuzl memory address Create

Virtual memory address Configuration

(@ The count of virtual memory address value list is up to 50.
The virtual memory address value format is hexadecimal.

Mame:

Description:

Wirtual memery address Configuration

Begin \irtual memory addrer| - |End Virtual memory addrer|

Begin

End

Add(A)

Delete(R)

oK

Cancel

The virtual memory address areas can be specified up to 50 areas and it can be entered in hexadecimal.

Export test data

When exporting data, you can set the output direction of variables to either horizontal or vertical

Select the output direction of the export variable and click [Apply].
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. Freferences O %
spe filter text - v -
P Export test data
> Analysis

Editor Export data Configuration
Exclusicn (@ Horizontal

Language O Vertical

Ferformance

Perspectives

Register external comman

Source File Types

Target Test

v Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
virtual Address

Theme (C5 Labs)

ToolChain

key

v

v

Restore Defaults Apply

Apply and Close Cancel

External Editor

You can set the external editor to open CSV file.
Enter the path of the external editor and click [Apply].

B Preferences O X

type filter text External editor BB T
> Analysis
Editor
Exclusion Path: | notepad ‘ Search...
Language
Performance
Perspectives
Register external comman
Source File Types
Target Test
~ Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
Virtual Address
Theme (C5 Labs)
ToclChain
key

Enter the path to an external editor that cpened for the csv file

v

v

Restore Defaults Apply

Apply and Close Cancel

Unit Test View

You can set the function node display in the Unit Test view included in the test perspective that UI/UX is
improved.
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B preferences

type filter text
Analysis
Editor
Exclusion
Language
Performance
Perspectives

Source Fils Types
Target Test
w Test

Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
Virtual Address

Theme (CS Labs)

TeelChain

key

Register external comman

O
Unit Test View (=14 -
Function nede show mode
(O All functions @ Only functions where tests exist
Restore Defaults Apply

Apply and Close Cancel

Coverage

User Manual - 3.6_en

You can set the branch coverage measurement and whether to display the covered/uncovered.

B Preferences O
type filter text Coverage =2 -
Analysis
Editer Branch coverage column info display
Exclusicn (® Covered Decision
Language (O Uncovered Decision
Performance
Perspectives Branch coverage, MC/DC measurement operator
Register external comman: Conditional Operator(%)
Source File Types [JBooclean Cperator(&&, ||, !, =, <=, =, ==, ==, 1=)
Target Test [ constant expression at compile time
~ Test
Coverage Limit to measure MC/DC
Export test data MNumber Operators(&&, ||, 1=): E =
External editor
Mumber of truth-tabl binat ;| 20000 =
Perspective umber of tru & combinations =
Type Partition show MC/DC
Unit Test View (O show decision unit
Virtual Address
Theme (C5 Labs) 100 2 | % more than satisfied combinations show
ToclChain . - _
key (® show condition unit
Note: The cperator option change does not apply fo the existing project.
To apply, use 'Reanalysis’ and 'Run Unit Test' function
< 5 Restore Defaults Apply
Apply and Close Cancel

[Branch coverage Column Info display] radio button allows you to select the information of the marker to
be displayed in the left column of the editor.

« T/F marker option is shown in the source code editor.
* Covered Decision: T/F indication of a covered decision
* Uncovered Decision: T/F indication of an uncovered decision

The checkbox [Branch coverage, MC/DC measurement operator] sets the branch coverage measuring
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target. If it is re-analyzed and executed, the settings are applied.

» Conditional Operator(?:) expression: Measures the branch coverage for ternary operator
expression.

* Boolean Operator(&,||,!,<,<=,>,>=,==,1=): Measures the branch coverage for boolean operator
expression.

« If unchecked all, measures the branch coverage for ‘if’, ‘for’, ‘while’, ‘do-while’ and ‘switch’
statements only.

! When changing the ‘Conditional Operator(?:)’ setting, the COVER'’s [Toolchain] >
[Standard] must be set identically to share coverage with COVER. For details, please
refer to the Import Coverage by Ternary Operator Settings page in User Guides.

Type Partition

You can edit the basic type partition for each toolchain and restore it into the default value provided.
In Toolchain combo box, select the toolchain to be modified, edit the partition and click [Apply].

. Freferences m} *
type filter text Type Partition ProTw
> Analysis
Editor Toelchain: | Microseft Visual Studio 2015 (32bit_64bit) HES
Exclusicn
Language Type Partition ~ || Add
Performance _inted -9223372036854775808~-1,0,1~92233... EditE.
Perspectives _wchar t 0,1~65535
Register external commani char -128~-1,0,1~127 Remove
Source File Types double -1.7976931348623158e+308~-2.225073...
» Target Test float -3.402823466e+38~-1.175494351e-38,0...
v Test int -2147483648~-1,0,1~2147483647
Coverage long -2147483648~-1,0,1~2147483647
Export test data long double -1.7976931348623158e+308~-2.225073
External editor long leng -9223372036854775808~-1,0,1~92233...
Perspective short 32768~-1,0,1~32767
H}TTZ?G'::‘V signed _int64 -9223372036854775808~-1,0,1~92233...
Virtual Address 5fgned char -128~-1,0,1~127
Theme (€5 Labs) 5fgned int -2147483648~-1,0,1~2147483647
. ToolChain signed long -2147483648~-1,0,1~2147483647
key signed long leng  -0223372036854775808~-1,0,1~02233...
signed short -32768~-1,0,1~32767
unsigned _inté4  0,1~18446744073709551615
unsigned char 0,1~255
nnrinnad int N1 AMANETING v
< 5 Restore Defaults Apply

Apply and Close Cancel

Perspective

After the test has created, you can set the opening option for the perspective associated.
Select one among [Always open], [Never open] and [Prompt] and click [Apply].
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B preferences O *

|ty'pe filter text

Perspective Qo

Analysis
Editor Open the associated perspective when creating 2 new unit test
Exclusion (O Always open () Mever cpen (@) Prompt
Language
Performance
Perspectives
Register external comman
Source Fils Types
Target Test
w Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
Virtual Address
Theme (CS Labs)
TeelChain
key

v

v

v

| Restore Defaults | | Apply |

|Apply and Closel | Cancel |
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You can set the information for the toolchain to be used in the tool.

You must have a toolchain (compiler information) for the source to be tested in order to create or

analyze the project.

The detail description of the toolchain settings can be found in the ‘Set a Toolchain (Analyzer)'.

Export Toolchain

It sets the system header size of the toolchain to be exported. The system headers larger than the size

you set cannot be exported.

B Preferences m] X
type filter text Exporting =1 4 - v
Analysi
’ E;:::” Set the system header size of ToolChain to be exported.
Exclusion Toolchain system header size (MB): |SCC
Language
Performance
Perspectives

Register external comman:
Source File Types
Target Test
Test
Theme (CS Labs)
w ToolChain
Exporting
key

Vo

Restore Defaults Apply

Apply and Close Cancel
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You can change the settings related to the editor.

B Freferences

type filter text
Analysis
Editor
Exclusicn
Language
Performance
Perspectives

Source File Types
Target Test

Test

Theme (CS Labs)
ToolChazin

key

Editor (= d g

Register external commar

Editer settings:
Text file enceding
(® Default (UTF-8)
QO Other. |UTF-2
A Autematic detection

Indentation
Tab size:

Detect modifications
[ Check the effect whenever the source file is medified (Including external modifications)

Restore Defaulis Apply

Apply and Close Cancel

Text file encoding
You can set the encoding to be used when opening a text file in the editor. If the [Automatic detection]

option is on, it will automatically detect the encoding of the text file. (If it cannot be detected

automatically, it will open with the encoding you set.)

Indentation

If you change the tab size, the tab size shown in the editor is changed too.

Detect modifications

If the [Detect modifications] option is on, it checks the impact of the changes each time the source file is

modified.

* If the disc speed if slow, deselect this checkbox to improve the performance.
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The Test Perspective provides Ul for displaying only the necessary information so as to keep the flow of

the testing task and focus on the goal.

It provides a high DOF screen with Eclipse RCP. You can set it in the [Window] menu and in each view.

. CodeScrell Controller Tester RTV(Remote Target Verifier) + Target Plugin (x64) — o x
File Edit Search Project Target Window Help

o Dashboard part » oo
E 2 TR ‘ Show Coverage | TTCOverage —g MC/DC &7 ST ) Class Factory & Control Flow Graph oo Call Graph T3 Function Call Hierarchy ™) Error
[ adler32.c &2 = B8 Unit Test ntegration Test BE&s k-~ =8

se } while (@) ~ ’

51 selse m v Statement Coverage

52 4 define MOD(a) a %= BASE

53 # define MOD4(a) a %= BASE 18/0/6 2.9%

54 #endif

55 e file funchi -

56 type file, functicn, test, state, issue

57 © g ZEXPORT adler32(adler, buf, len) Name Result Coverage @

53 ulong adler; casa] 3 1

59 const Bytef *buf; case S!gna P

68 uInt len; 4 signalg

51 {

62 unsigned long sum2;

63 unsigned n;

64 .

85 /* split Adler-32 inte component sums */ -

66 sum2 = (adler >> 16) & Oxffff; 9 signaled

67 1@ Signaled

63 11

59 5

12

o Source code -

71

72[F] 11/0/0 100.0%

73 L]

74 < >

75[F]

76 k| adler32(unsigned long, const u... £ = 0

77 5 =

73 } Test Info (zlib/adler32_test0) B3 By

79

2e /* @ initial Adler-32 value (deferred check for len == 1 speed) */ - =

51[F] if (buf == Z_NULL) Test Structure Q [ TestInfo Edit

g h Test structure using a tree view and edit the informaticn in the test. Change the notaticn edit the partition A

34 /* in case short lengths are provided, keep it somewhat fast */ Name In out Set Numeral System

35[TF] if (len < 16) { Parameter/return 1 <

86[TF] while (len-237( hd R (@10 Numeral System ()14 Numeral System

87 adler += *buf++; h *

88 sum2 += adler; o adler

5 .- Test editor par

90[TF] if (adler »>- BASE) v o0 8 | ] A

91 adler -= BASE; v o 0] i B | add

92 MOD4 (sum2) ; /* only added so many BASE's */ . Single Value A

93 return adler | (sum2 << 16); ° [0] : unsigned b [

” } v o len - ulnt Partition List

e o len : unsigned int O 0" Delete

96 /* do length NMAX blocks -- requires just one modulo operation */ v o returnvar ulong

97[TF] while (len >= NMAX) { o returnvar © unsigned lc 215t Default

o &3 = = Before call code

929 n = NMAX / 16; /= WX is divisible by 16 */ - 16"

168 do { v After call code © 175551 v

T Test Info [ Test Case| Test Code| Configuration|

WM of 1038M |0

The components that make up the test perspective are:

+ Dashboard

+ Test Navigator View

+ Unit Test View

» [ntegration Test View

+ Coverage View

+ MC/DC View

+ Stub View

» Class Factory View

» Control Flow Graph View
+ Call Graph View

» Error View

» Debug Information View
» Fault Injection View

* Input/output Data Graph View
+ Console View

+ Requirement View
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Views that are not included by default can be opened from [Window]> [Show View]> [Other...] on the top
menu.
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15.1. Dashboard

The dashboard section provides a summary of frequently used functions or tests that are currently in
progress.

% test &= o & d Host @ ¥ [ [Globsl search (Ctri=3) Q)i = =
Mew Project New Test Import Export Properties Preferences -
& Tg | [ Show Coverage [+ Coverage —3MC/DC L% Stub (¢ Class Factory <% Control Flow Graph o Call Graph Requirement =3 Fault Injection

Project name

It shows the name of the project selected in the Test Navigator View.

% test &= o & d Host @ ¥ [ [Globsl search (Ctri=3) Q)i = =
Mew Project New Test Import Export Properties Preferences -
& Tg | [ Show Coverage [+ Coverage —3MC/DC L% Stub (¢ Class Factory <% Control Flow Graph o Call Graph Requirement =3 Fault Injection

Bookmark menu

You can use the [New Project], [New Test], [Import], [Export], [Properties] and [Preferences] features.

=% test = b & & & Host @ Y[R [ Global Search (Ctrl+3) Q)i s |[=
Mew Project New Test Import Export Properties Preferences -
& Tg | [ Show Coverage [+ Coverage —3MC/DC L% Stub (¢ Class Factory <% Control Flow Graph % Call Graph Requirement =3 Fault Injection

Host/Target setting menu

You can change the test environment to the host or target.

% test &= o & d |Host. | ¥ [ [Globsl search (Ctri=3) Q)i = =
Mew Project New Test Import Export Properties -
& Tg | [ Show Coverage [+ Coverage —3MC/DC L% Stub (¢ Class Factory <% Control Flow Graph o Call Graph Requirement =3 Fault Injection

Coverage-related menu

You can use the Show the [Merger coverage between host and target] and the [Show full coverage
(Include External Coverage)] features.

% test & B oM & ;@ L Host @ | ¥ & | (bl search (cut-3) CYHE: 2
Mew Project New Test Import Export Properties Preferences
P& Tg ‘ |43, Show Coverage |"] Coverage — MC/DC 5% Stub [c) Class Factory <5 Control Flow Graph =2 Call Graph Requirement =3 Fault Injection

Open Perspective menu

You can select and open the perspective located in Controller Tester

1% test & B oM & ;@ L Host @ X & [ clobsl Search (Cirl=3) alils =
Mew Project New Test Import Export Properties Preferences
P& Tg ‘ |43, Show Coverage |"] Coverage — MC/DC 5% Stub [c) Class Factory <5 Control Flow Graph =2 Call Graph Requirement =3 Fault Injection
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Global Search

The Global Search allows you to search New, Views, Editor, Menus, Properties, Preferences, Project
resource (source file, function), Test, Stub and Class Factory, etc. by keywords. Select the Global
Search window or press the shortcut key (Ctrl + 3) to use the Global Search feature.

8 8 @ Y @fcomsancis  Qlf mIE

Properties  Preferences
Views [[ll Bockmarks (General)
s=0 Call Graph (Analysis)
& Cheat Sheets (Help)
[t ] Class Factory (Test)
4" Classic Search (General)

ault Injection

Perspectives &% Analysis
[ External Test
= Test
Menus B8 About Controller Tester

@ £t - Exit Workbench
e Export... - Export
@ Generate command line interface IN| file
£ Import... - Import
MNew ﬁ C/C++ Project from Embedded(CodeWarrior, Green Hills, MEC) - Create a new project
B C/C++ Project from Existing CodeScroll Project - Create a new project from an existin
fi&¥| C/C++ Project from RTV Build - C/C++ Project from RTV Build
&l C/C++ Project from RTV Build Command - C/C++ Praject from RTV Build Comman
W C/C++ Project from Visual Studio Project - Create C/C++ Project from Visual Studio
Preferences @ Analysis
@ CFG - Analysis
@ Call Graph - Analysis
@ Coverage - Test

Results per category are limited. Press 'Ctrl+3' to see all

* The project resource (source file, function, etc.), test, stub and class factory can be
searched by selecting the analyzed project.

Perspectives & Analysis
[ External Test
= Test
Menus. About Contreller Tester

@ Close Project - Close Project
% Delete - Delete

® et - Exit Workbench

3 Export... - Export

New ﬁ C/C++ Project from Embedded(CedeWarricr, Green Hills, NEC) - Create 3 new preject from CedeWarricr(~xml), Green Hills MULTIc*.gpj) or N
B C/C++ Project from Existing CodeScroll Project - Create a new project from an existing CodeSeroll project file(* csp)
[ C/C++ Project from RTV Build - C/C++ Project from RTV Build
&l C/C++ Project from RTV Build Command - C/C++ Praject from RTV Build Command
" C/C++ Project from Visual Studie Project - Create C/C++ Project from Visual Studio Project. (.dsw, *sln, *.vexproj, *veproj)

Class Factory (© abstract - classFactery.cpp
© Abstract? - classFactery.cpp
© InfoLoader - classFactory.cpp
@ Processor - classFactory.cpp
@ Timer - classFactory.cpp

Project @ ConcretenConcrete() - classFactory.cpp
@ Concrete:func2() - classFactory.cpp
@ InfoLoader:InfoLoader(const char #) - classFactory.cpp
@ InfoLoader:getData) - classFactory.cpp
@ Processor:Precessor(infoLoader, Timer) - classFactory.cpp

Stub 4 Concrete 1 - classFactory.cpp

Unit Test 't Concrete::Concrete()_0 - classFactory.cpp
'&) Concrete-func2()_0 - classFactory.cpp
') InfoLoader:InfoLoader(const char #)_0 - classFactory.cpp
'] InfoLoader. -getData()_0 - classFactory.cop

Results per category are limited. Press 'Ctrl+3' to see all
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Show Coverage

It allows you to set the covered area in the source code editor is marked or not.

=7 test o Cig- - N~ | @ Host @ X [ [clobal search (ctr+3) Q)i |=

New Project New Test Import Export Properties Preferences

{5 g | £ Show Coverage | || Coverage -~ MC/DC (7% Stub () Class Factory < Control Flow Graph < Call Graph ] Requirement =3 Fault Injection

Open/Close the test-related view menu

You can open and close the test-related views.

= test £ g @ Host @ Y [ [ lobal Search Ctrl+3) Qlim|[=
New Project New Test Import Export Properties Preferences - : ;
& Tg | £ Show Coverage |27 Coverage - mc/DC_E7% Stub ¢ Class Factory < Control Flow Graph st Call Graph Requirement =3 Fault Injection |
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The Test Navigator View shows the hierarchy structure of the projects and the test models under the
projects included in the workspace.

The Test Navigator View does not occupy any space but remains the minimized state. If you select [Test
Navigator] in the dashboard, the Test Navigator View is located above the Source Code Editor.

o Tg |

Show Coverage |

T Test Mavigator

10 stub_sample
10 target
w 1 zlib
v '__:a Default Module

v [ adler3zc

@ adler32

@ adler32_combine
g, compress.c
[ creaze
|4 deflate.c
[ gzio.c
g infback.c
L inffast.c
g inflate.c
L inftrees.c
L, minigzip.c
L trees.c
L, uncompr.c

Lg, zutil.c

(= Headers

Icon
Icon Description(*: created after analysis)
= Open project
I Closed project
! Module
L] source file
® *Global variable
@  *Function
= *Header folder
lol  *Header file
[& *System header file
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Description

‘S Link with Selection Highlights the items selected in the other view.

=l Collapse Al

Icon overlay

Hides all tree nodes.

Icon overlay Description

S Analyzed

0 Changed after analysis

Copy the source file into the other module

To copy the source file into the other module, with Ctr1 key pressed, drag and drop the source file to be

copied into the target module.
Alternatively, right-click the source file to be copied, select [Copy], right-click the target module and
select [Paste]. (Shortcut keys: ctrl + Cand Ctrl + V)

Move the source file to the other module

To move the source file to the other module, drag and drop the source file to be moved into the target
module.

Export Requirement Traceability Information for V-SPICE

Connection information between requirements and tests can be exported to an xml file that conforms to
the V-SPICE format.

P Test Navigator | =] 5. ¥ = 5
B 9 =

G E

Cooocooog

New

Delete

Rename..

Import.

Export

Refresh

Close Project

Quality Management Tools

Run Target Test
Impart Target Test Log

Collect project log

Create Unit Test...
Run Test

Rebuild and Run Test
Reanalyze

d Delete Test Results (including coverage)

Merge Project coverage..

Properties

Delete
F2

F5

> Export Requirement Traceability Information for V-SPICE...

Export STAT data

> Upload data to STAT.
Export VPES data...
Uplead data to VPES.

F11

Alt+Enter
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Select a project and right-click on the menu to select [Quality Management Tools] > [Export
Requirements Traceability Information for V-SPICE... ] function.

Upload data to VPES

g Test Navigator | |- & v =09

New

Delete Delete
Rename.. F2
Import...

Export

LE

CooCoDDS

Refresh Fs

Close Project
Quality Management Tools

& Run Target Test
4 /mport Target Test Log

Collect project log

Create Unit Test

Export Requirement Traceability Information for V-SPICE...
Export STAT data

Uplead data to STAT.

Export VPES data...

Uplead data to VPES.

2 Run Test F11
¥ Rebuild and Run Test

Reanalyze
4 Delete Test Results (including coverage)

Merge Project coverage..

Properties Alt+Enter

When you select and right-click a project, [Upload data to VPES...] is indicated in the menu. For this
feature, please contact Technical support.

Collect Project Log

This feature collects the logs left in use of Controller Tester on a project basis in batch and exports them.
When you contact Technical support due to an error occurred, please send us the collected compressed
file so that we can solve the problem more quickly.

T Test Navigator

v I Zlib
w New ¥
K Delete Delete
Rename... E2
By Import..
ey Export..
Refresh F5

Close Project
Quality Management Tools »

& Run Target Test
=4 Import Target Test Log »
Collect project log
Create Unit Test...
™  Run Test F1
% Rebuild and Run Test
Reanalyze

Merge Project coverage...

Properties Alt+Enter

When you select and right-click a project, [Collect project log] item is indicated.
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If a project size is too large to run the test at once, you can run the test by dividing it into multiple
projects. [Merge Project Coverage] function runs the test by dividing one project into multiple projects
and then shows the overall coverage results by merging the result of the test for these projects.

Merge Project Coverage

1.

After selecting all the projects that you want to merge the coverage results, right-click it and select

[Merge Project Coverage].

Ty Test Mavigator
13 stub_sample

17 target
= zlib
=g zlib_copy
g zlib_co
g zlib_co Mew 4
¥ Delete Delete
Rename.. F2
Exg Import.
&y Export
Refresh FS

Close Project
Quality Management Tools >

Collect project log

Merge Praoject coverage...

Select [Merge Project Coverage] menu to open for creating the project name. Enter the project
name to be created in [Project Name].

u Merge project coverage results

Merge project coverage results

Project Mame: |z|ib_h19rged

Add project db files to merge:

*
Add project's db files(*.csp) to merge.
The merged project cannot create and run test.
=] P-wProduct WorkspaceWet_3_1_02%zlibW csdatawzlib.csp Add...
=] P#wProduct WorkspaceWct_3_1_02%wzlib_copy#.csdatawzlib_copy.cs
a8 P#wProduct_Workspacewct_3_1_02%zlib_copy_copy#.csdatawzlib_o i 2
B3 pwProduct_Workspacettct_3_1_02wzlib_copy_copy_copy# csdatas
Concel

» By clicking the [Add] button, you can perform a merge coverage function for projects not

included in the workspace.

Click [OK] to check that a new project that the project results had been merged has created in the
Test Navigator view. The merged project is displayed with a red mark on the upper right corner.
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Tq Test Navigator

stub_sample
target

zlib
zlib_copy

§EECE

=% zlib_merged

zlib_copy_copy
zlib_copy_copy_copy
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4. Select the project that the results had been merged and check the coverage view to see the

overall coverages.

[+ coverage 2

Host coverage informaticn of 'zlib' project

® e = 5

I |=] Coverage &2

e = o

| Host coverage information of 'zlib_copy' project

| Target Function

| Statementl Branch

| MC/DC |Funct\onCaH|Funct\on|A

| Target Functicn

| Statemeﬂtl Branch |

MC/DC | Function Call| Funetion] &

_tr_align(struct internal_state #)
_tr_init(struct internal_state )
adler32(unsigned long, const unsign

adler32_combine(unsigned long, un
bi_flush(struct internal_state #)

O @ NN W e

bi_reverse(unsigned int, signed int)
bi_windup(struct internal_state *
build_bl_tree(struct internal_state #)
build_tree(struct internal_state *, stru

o=
= o

12

Total

e

_tr_flush_block(struct internal_state *...

_tr_stored_bleck(struct internal _state .
_tr_tally(struct internal_state *, unsig...

= 0.00% (0... == 0.00% (0.
= 0.00% (0... == 0.00% (0.

== 0.00% (0...| = N/A

== 0.00% (0... == 0.00% (0.

= 0.00% (0...|= 0.00% (0.
= 07085 (. =8333% (
= 100.00%... = 100.00%
= 0.00% (0...== 0.00% (O
= 0.00% (0...|m= 0.00% (0.
= 0.00% (0...== 0.00% (O
= 0.00% (0...|m= 0.00% (0.
= 0.00% (0...== 0.00% (O

2.95% (1...|1.32% (2... 0.95% (1... 0.00% (0...

|==0.00% (0... ™= 0.00% (C...™= N

== 0.00% (0... == 0.00% (0...= N
= N/A = 0.00% (0...==N
== 0.00% (0... == 0.00% (0...= N
...[m=0.00% (0= N/A -
== 56.66% (.= N/A =y
= 100.00%... = N/A =y
= 0.00% (0..|= N/A -
- 0.00% (0| = N/A -
= 0.00% (0..|= N/A -
== 0.00% (0..== 0.00% (0. == N
== (.00% (0. == 0.00% (0. =N
0.95% (1... 0.00% (0. 175... v

@ In target testing mode, the coverage of the function including Asm code can not be measured.

=| Coverage I3

Host coverage information of 'zlib_copy_copy’

project

_tr_align(struct internal_state *)

_tr_init(struct internal_state *)

bi_flush(struct internal_state #)

Vo e R W N e

e
= o

12
Y O S G

Total

_tr_flush_blockistruct internal_state *

_tr_stored_block(struct internal_state
_tr_tally(struct internal_state *, unsig
adler32(unsigned long, const unsign...
adler32_combine(unsigned long, un...

bi_reverse(unsigned int, signed int)
bi_windup(struct internal_state #)

build_bl_tree(struct internal_state #)
build_tree(struct internal_state *, stru..

= 0.00% (O...| == 0.00% (O...== 0.00% (0...}== 0.00% (0...= N
== 52365, (.|=m 43 75% (.. /== 0.00% (0..|== 70.00%
= 100.00%... = N/A =N/A = 100.00%.
= 0.00% (0...|m= 0.00% (O...== 0.00% (0...== 0.00% (0.
= 0.00% (0...== 0.00% (0... == 0.00% (0..|= N/A
—1165% (.. = 20.83% (.. = 2.33% (1. N/A
= 0.00% (0...|= 0.00% (0...|= 0.00% (0..;= N/A
= 0.00% (0...|= 0.00% (0... = 0.00% (0., N/A
= 100.00%...|== 50.00% (.. ™= 0.00% (0..|= N/A
== 71,42 (.. == 50.00% (... == 0.00% (0../= N/A
= 100.00%...|== 75.00% (... == 50.00% (... = 100.00%..
= 100.00%...|== 75.00% (...|== 50.00% (...= 100.00%...

11.98% (... 8.22% (1...3.19% (4... 15.24% (...

il
Y
-
-\
-
-
-
=
-
=
-

@ In target testing mode, the coverage of the function including Asm code can not be measured.

®ElE= o | ='| Coverage 52
Host coverage information of 'zlib_copy_copy_copy' project

| Target Function

| Statementl Branch

| mc/pc | Function Call|Function| ~

check_header(struct gz_stream #)
compress(unsigned char *, unsigned..
compress2(unsigned char *, unsigne..
compressBound(unsigned long)

copy_block(struct internal_state *, ch
cre32(unsigned long, const unsigne...
crc32_bigunsigned leng, const unsi
crc32_combine(unsigned leng, unsi
cre32_little{unsigned long, censt un.

deflateBound(struct z_stream_s *, un

Anflatara

Total

compress_block(struct internal_state ..

= (3.00% (C... == 0.00% (0.
== 0.00% (0... = N/A

|==0.00% (... == 0.00% (0...

- .00% (0... = N/A

= (1.00% (0... == 0.00% (..
.= .00% (0... == 0.00% (0.
jm—=26.08% (... ™= 25.00% ..

== 100.00%.. == 100.00%.
== 100.00%... == 100.00%.
== 100.00%.. == 100.00%.

deflate(struct z_stream_s *, signed int) == 0.00% (0... == 0.00% (0.

== 0.00% (0... == 0.00% (0.

3.05% (1... 1.93% (4..

..|==0.00% (0...] = 0.00% (0.
=N/A -—0.00% (0.
= 0.00% (0...]== 0.00% (0.
=IN/A =N/A
= 0.00% (0..]= N/A
—0.00% (0...]== 0.00% (0...
= 0.00% (0...]== 50.00% (...
= 100.00%..|= N/A
= 100.00%...= 100.00%.
= 100.00%..|= N/A
= 0.00% (0..m= 0.00% (0.
= 0.00% (0= 0.00% (0

-

. 1.67% (2... 2.13% (8... 6.14... «

& In target testing mode, the coverage of the function including Asm code can not be measured.

[+ Coverage 2

Host coverage information of 'zlib_merged' project

| 70

| 73

®E

27.19... v

] = 8

| Target Function

| Statement Branch

Mc/DC | Function Call| Function] &

YipuLs oG v s

71
72

gzrewindivoid *)

74
75
76
77
78

gztell(void #)
gzungetc(signed int, void *)

@~

81
Total

gzread(void *, void *, unsigned int)

gzseek(void *, signed long, signed int) == 0.00% (0... == 0.00% (0.
gzsetparamsivoid *, signed int, sign... == 0.00% (0... == 0.00% (0..

gzwrite(void *, const void = unsigne.
inflate(struct z_stream_s *, signed inf)
inflateBack(struct z_stream_s *, unsi
9 inflateBackEnd(struct z_stream_s *)

0 inflateBacklnit_{struct z_stream_s *, s.
inflateCopy(struct z_stream _s *, stru

U
= 1.00% (0... == 0.00% (C...
== (1.00% (0... == 0.00% (..

el m G (e

= 0.00% (0...= 0.00% (0...==N
= 0.00% (0...= 0.00% (0...==N
= 0.00% (0...= 0.00% (0...==N
= 0.00% (0...= 0.00% (0...==N
=N/A —0.00% (0. =N
= 0.00% (0..]= N/A -
= 0).00% (0..m=0.00% (0. == N
= 0.00% (0..m= 0.00% (0.
= 0.00% (0..==0.00% (0
= 0.00% (0..m= 0.00% (0.
= 0.00% (0..==0.00% (0
= 0.00% (0..m= 0.00% (0.

= 0.00% (0... = N/A

== 0.00% (0... = 0.00% (0.-
= ().00% (0... == 0.00% (0.
== 0.00% (0... == 0.00% (0.
-—205% (1. ==0.30% (1
== 40.00% (... == 50.00% (
13635 (.. == 10.00% (
== 0.00% (0... == 0.00% (0.
0.65% (2... 0.14% (3...

-
-
-y
-

-

& In target testing mode, the coverage of the function including Asm code can not be measured.

f® El ] = B

Target Function Statement | Branch I MC/DC |Functiun CaIIIFunctiunl A

4 | _tr_stored_block(struct internal_state w0 00% (0. == 0 00% (0. =0 00% (0. == 0.00% (0=}
S |_tr_tally(struct internal_state *, unsig... == 0.00% (0... == 0.00% (0... == 0.00% (0. = N/A - [
6 |adler32{unsigned long, const unsign...[== 98 05% (... == 27.50% (.. == 75.00% (.. = N/& —
7 |adler32_combine(unsigned long, un... == 100.00%... == 100.00%... == 100.00%... = N/A —
8  bi_flush(struct internal_state #) - 0% (0. =—0.00% (0. =—=000% (0. = N/A — [
9 |bi_reverse{unsigned int, signed int)  |== 100.00%... == 50.00% (... ™= 0.00% (0..= N/A -
10  bi_windup(struct internal_state #) - 42% (=50 00% (.. == 000% (0. = N/A -y
11 build_bl_tree(struct internal_state *)  |[== 100.00%... == 75 00% (. == 50 00% (== 100.00%.  |[=—
12  build_tree(struct internal_state * stru (== 100.00%.. == 75 00% (. == 50 00% (. [==100.00%. |[=—
13  check_header(struct gz_stream *) - 0% (0. -0 00% (0. =0 00% (0. =0 00% (0 -
14 | compress(unsigned char * unsigned... == 100.00%... = N/A = N/A == 100.00%... ==Y
15 | compress2(unsigned char * unsigne.. == 95 23% (. == 37 50% (.. == 75 00% (.. == 100.00%.. ==Y

cimAn P LT — U PUNDS —RISA — KA —RlA — S

18.37% (...

11.44% (...

5.82% (7... 17.37% (... 37.71...

L

& In target testing mode, the coverage of the function including Asm code can not be measured.
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! The [Merge Project Coverage] function may not work properly when two or more
different functions in the project to be merged have the same function name.
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15.3. Unit Test View

The Unit Test View section is located on the right of the screen. The Unit Test View combines the test
and coverage information and provides it in a single view.

I codeseroll Controller Tester RTV(Remote Target Verifier) + Target Plugin (x64) - o X
File Edit Search Project Target Window Help

g lib 5 B N 2 B D Host@ ¥ B (Giobal Search C-D) il 31
New Project New Test Import Export Properties Preferences et
& 7Tg || show Coverage | | i'| Coverage —JMC/DC_ L7t Stub (¢ Class Factory < Control Flow Graph &= Call Graph T2 Function Call Hierarchy ™ Error
[£] compress.c [g] adlerz2.c 52 = B8 Unit Test ntegration Test EE2 H~ =8
101 D016 (buf); /* 16 sums unrolled */ ~ © Statement Coverage
1e2 buf += 16; R }
103[TF] } while (--n); e
108 #o0(adler); (655 / 0/ 283) 938 43.0%
105 MOD( sum2) ; 1719/3995
106 1 - -
67 type file, function, test, state, issue
108 /* do remaining bytes (less than NMAX, still just one module) */ Name Result Coverage ~
109[T] if (1en) /* avoid modulos if none remaining */ o s -
116[TF] while (len >= 16) { > 8~ _tr_align(struc 17071213 T2.7% (z2es
111 len -= 16; > tr_flush_block = 0/0/12) 12 54.7% (2242
112 D016 (buf); > tr_init(struc 1/0/0 100.0% (1111
113 ; buf += 16; > tr_stored_block 0/0/8)8 100.0%
114 7] 3 .
) > @ 0/0/3)3 22.2%

115[TF] while (len--) { ch
116 adler += *bufit; > 9/0/413 98.0% 01c
17 sun2 += adler; v 8 11/0/0; 100.0% (12712
118 3 > 1/0/0
119 MOD(adler); > bi_flush(st 5/07/6 100.0% 272
28 5 MOD(sum2) ; > @ bi_reverse 3/0/2)5 100.0% (5/5
132 > @ bi_windup (= 3/0/5 8 100.0% /7
123 /* return recombined sums */ > @ build_bl_tree 0/0/8)8 100.0%
124 return adler | (sum2 << 16); > B build_tree(s: 0/0/T)7 100.0% (22/22
125 1 > @ check_header 21/0/22 44.4% 20
125 > compress (unsig 3/0/0)3 100.0% (11
128 ong ZEXPORT adler32 combine(adlerl, adler2, len2) > 6/0/0)6 95.2% (2072
129 ulong adlerl; > 0/0)3 100.0%
138 uleng adler2; > @ y 1/0/7)8 F75% o0
131 z_off_t len2; > @ 0/0/5) 5 100.0%
132 { 2 cre32 6/0/1)7 9
133 TrsTTE L S 7 ‘:"32 . ; o0 30.4%
132 unsigned long sum2; > W cre3z_bigiy ~ ! 100.0%
135 unsigned rem; > @ ere32_combine 7/0/2)9 100.0%
136 > @ ere32_little(s ©/0/1)10 100.0%
137 /* the derivation of this formula is left as an exercise for the reader */ > @ deflate 27/0/5 3 31.4% -
138 rem = (unsigned)(len2 % BASE); 3 @ deflateBou 6/0/0)6 777% -
139 sunl = adlerl & BxfFFf; . . :
148 sum2 = rem * suml; ’ deflateCopy 070/3)3 21.8% (722
141 MOD(sum2) ; > B deflateEnd 19/0/7) 2 94.1% o
142 suml += (adler2 & OxFFFf) + BASE - 1; > e 2 20/0/0 84.4% 0o
143 sun2 += ((adlerl >> 16) & OxFfff) + ((adler2 >> 16) & OxFfff) + BASE - rew > 5/0/0 100.0%
144[TF] if (suml > BASE) suml -= BASE; 5 127070 95 2'% L
145[TF] if (suml > BASE) suml -= BASE; 50,05 s
145[TF] if (sum2 » (BASE << 1)) sum2 -= (BASE << 1); ’ - N ; 80.0% «/
147[TF] if (sum2 > BASE) sum2 -= BASE; > @ de 5/0/0)5 94.1% 1617
148 return suml | (sum2 << 16); > @ 7/0/T)14 92.3% 2406
149 H > @ deflateSetH 7007 83.3% =0
1@ ¥ | > Bderia 5/0/0)5 88.8% -0

< > \ M Aaflate Fack/oror cirnad $nr 17071m 11 a1 40 2

eSO TSmAE 1285 0 ERCOEC '}

Toolbar menu in the Unit Test View

Toolbar icon Description

Expand All Shows all test view tree.

=l Collapse Al Hides all test view trees.

&= Show as Unique Test Name Displays by unique test name.

& Total Displays all the tests.

g Failure/Error Displays only the tests that the test result is Failure/Error.

gl Failure Displays only the tests that the test result is Failure.

gl Error Displays only the tests that the test result is Error.

e Success Displays only the tests that the test result is Success.

E2 Function changed Displays only the tests that the function to be tested has been changed.
Er Run not guaranteed Displays only the tests that the test execution is not ensured.

¥ Host/Target result different  Displays only the test that the host result and the target result are different.
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Pull-down menu(V) in the Unit Test View

H e E

Show coverage at all elements

TE:E

~  Add description when duplicate test case
#0] Insert Default Values for Empty Input

Delete All Test case Descriptions
% Check Integrity

Menu name

Show coverage at all elements

Description

Displays the coverage in all items.
(function, test, test case)

Add description when duplicate test

case

Adds original test case number on duplicated test case.

Insert Default Values for Empty Input ~ When input data are empty, inserts default values.

Delete All Test case Descriptions

Check Integrity

Delete test case descriptions all together.

Checks integrity about functions and stubs. Then, reset test if it
needs.

» Insert Default Values for Empty Input

Variable type Default value

string (empty string)

without string 0

* For [Test reconfiguration], refer to [Source Code Modification and Test Reconfiguration]

Dashboard in the Unit Test View

Unit Test

type file, function, test, state, issue

Menu

(878 / 0 / 359) 1237

e EH~ =08

v  Statement Coverage

(655 / 0 / 283) 928 43.0%

(1719/3995)

Description

Runs unit tests.

Shows success, failure, error and total of test case.
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Selects the coverage type to be displayed in the Unit Test View.
(statement, branch, MC/DC, function call)

v  Statement Coverage

43.7%

(1952/4466) Shows the selected kind of full coverage.

Search

In the Unit Test View, you can search functions, tests and test cases by file, function, test, status
(success, failure, error) and issue name.

Unit Test ntegration Test Hes E ~ ¥ = 0O
m v Statement Coverage
(655 / 0 / 283) 938 43.0%

(1719/3995)

|t}-‘pe file, function, test, state, issue I

Status search keyword

In the Unit Test View, you can filter the tests that are displayed by the status search keyword. It provides
searchable keyword recommendation and auto-complete function.

Keyword Description
$TEST SUCCESS% Test success

$TEST FAILURES$ $TEST ERRORS% Test failure/error

$TEST FAILURES% Test failure

$TEST ERRORS% Test error

$TEST HAS NOT FUNCTION$% Function changed

$TEST NOT GUARANTEES Run not guaranteed
$TEST RESULT DIFFERENTS% Host/Target result different

* ‘Run not guaranteed’ is a case where test code is generated, but there is no guarantee
that it will run normally. This is the case when using a type that is difficult to specify as a
parameter or return value.

Structure of the Unit Test View

The Unit Test View presents the hierarchy structure of [Function] > [Test] > [Test case]. If there are more
than 100 test cases in a test, they are grouped in groups of 100 to represent a group.
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Unit Test

Integration Test

EEH~ ¥v= 08

| v statement Coverage|

(655 / 0/ 283) 938 43.0%
(1719/3995)
type file, function, test, state, issue
Mame Result Coverage (A
v adler32_combine(unsigned long 11/0/0) 11 100.0% (12/12
v adler32_combine(uns (11/0/0) 11
1
(5/0/86) 11 100.0% (2/2
_ 8 5/0/6) 11
1
2
3 Signaled
4 Signaled
5
6 Signaled
7 Signaled
8 Signaled
9
10
11
> W Bi_reverse ... t B3/7072)5 100.0% (5/5
» bi_windup( =t (3/0/5) 8 100.0% (7/7
» build_bl_tree 0/0/8 8 100.0% (11/11
» build_tree(: t ee_desc_s o/o0/M7 100.0% (42,42
> check_header 2170/ 2) 23 A4.4% o0as
» compress (ur . (3/0/0)3 100.0% 11
> B > compress2(uns ng 6/0/0)0 95.2% 120,27
3 compressBound(u (3/0/0)3 100.0% 11
» compress_block! = al_state truct ct_data M/o0/ns 77.5% 62020
» M mams Rlacl/ctrict frbarnal chaba #  chas b 005 s ANA AOS ~

Item icons in the Unit Test View

Item icon Description
None Function
Test

Test case, Test case group

Item status color in the Unit Test View

User Manual - 3.6_en

The execution information of functions, tests, and test cases in the Unit Test View is represented by

colors.
Color Description
Green Function/Test: If the execution result of all the test cases under it is success.
Test case: The result of execution is success.
Blue L .
Test case: The result of execution is failure.
Red Function/Test: If test cases with error exist under it.

Test case: The result of execution is error.

Function/Test: If only test cases with failure and no test cases with errors exist under it.
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Function/Test: All test cases have not been executed under it and test cases that are not
Orange guaranteed to run exist.
Test case: Run not guaranteed.

Function/Test: All test cases under it have not been executed.

Black
ac Test case: Not been executed.

Function

The functions provide the function name, the coverage and the test case execution results (success,
failure, error and total).

* For the coverage for each function, the test execution result of the other function may be
applied depending on the call relationship between functions.

Double-click on a function to check the location of the function in the Source Code Editor.

Unit Test Integration Test &= k> ¥ = 0

| v statement Coverage|

(655 / 0 / 283) 938 43.0%
(1719/3995)

type file, function, test, state, issue

Mame Result Coverage (A

I v adler32_combine(unsigned long, unsigned long...) mrso/mn 100.0% (12/12)
v ml adler32_combine{unsigned long, unsigned long, si M/ o701

1

2

3

4

5
6
7
8
9
1e
11
v bi_flush{struct internal_state *) G/0/6) 11 100.0% (22
v bi_flush{struct internal_state *)_& (B/0/6)11
1 signaled
2
3 Signaled
4 Signaled
5
6 Signaled
7 Signaled
8 Signaled

9

18

11
> bi_reverse(unsigned int, signed int) (3/0/2)5 100.0% 5/
> bi_windup(struct internal_state *) (3/0/5)8 100.0% 7/7
> build_bl_tree(struct internal_state *) o/0/88 100.0% 1114
> build_tree(struct internal state *, struct tree desc_s *) o/o0/n7 100.0% (42,42
> check_header (=truct gz _stream #) (21/0/2) 23 A44.4% oo
> compress(unsi char *, un d ) 3/0/0)3 100.0% (11
> > compress2(unsigned char *, unsigned long *...) ©6/0/0)6 95.2% 000
> compressBound(un d long) (3/0/0)3 100.0% 1/
> compress_block(struct internal_state *, struct ct_data_s 1/0/Mn8 77.5%

~ M rary hlark/ctmict Srtbacnzl ctaba * chae \ n/nJ/s s AAN NOS o
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Context menu of the function

Create Test
Copy Test Ctrl+C
K Delete Delete

Show Call Graph
Show Control Flow Graph
Show MC/DC

Host Cutput Value -= Expected Value
Test reconfiguration

Cet related file

Relevant issues setfings...

Import Test Data »
Export Test Data

Add Stub..

: 5 LK

Apply Class Code

Select Function
Deselect Function

mm Generate coverage report..

Context menu Description

Create Test Creates a test of the selected function.

Copy Test Copies tests of the selected function.

Delete Deletes tests and test cases of the selected function.
Show call graph Shows the function call graph of the selected function.
Show Control Flow Graph Shows the control flow graph of the selected function.
Show MC/DC Shows MC/DC of the selected function.

Host Output Value -> Expected
P P Pastes the host output value to the expected value.

Value

Test reconfiguration Reconfigure test information.

Set related file Selects the files containing that test.

Relevant issues settings Associates the selected test with the issue of the management tool.
Import Test Data Imports the test data saved in local.

Export Test Data Exports the test data to local.

Add Stub Adds the stub to the selected test.

Apply Class Code Apply the class code generated in the Class Factory View to the
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function.
Select Function Selects the checkbox of all the functions selected by a mouse.
Deselect Function Deselects the checkbox of all functions selected by a mouse.
Generate coverage report Exports the selected test coverage to the selected path.

* For [Test reconfiguration], refer to [Source Code Modification and Test Reconfiguration]

Test

The test provides coverage, test case execution results(success, failure, error, total).
Double-click on a test to open its Test Editor.

Context menu of the test

Add Test Case

Generate test cases automatically 3
Host Cutput Value -= Expected Value

Initialize Test Case

Copy Ctrl+C
Paste Cirl+W
Duplicate Ctrl+D
Duplicate multiple times...

W Delete Dielete
Rename... F2

Test reconfiguration

Cet related file

Relevant issues settings...

gy Import Test Data »
i Export Test Data

Large test data 3
% Add Stub..

<» Apply Class Code

Select Test
Deselect Test

mm Generate coverage report..

Context menu Description
Add Test Case Adds the test case to the unit test selected.
Generate test cases Creates the test case in various ways.
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automatically

Host Output Value -> Expected

Value

Initialize Test case
Copy

Paste

Duplicate

Duplicate multiple times
Delete

Rename

Test reconfiguration
Set related file
Relevant issues settings
Import Test Data

Export Test Data

Large test data

Add Stub
Apply Class Code
Select Test

Deselect Test

Generate coverage report

User Manual - 3.6_en

Pastes the host output value to the expected value.

Delete all the test cases.

Copies the test and test case.

Pastes the test and test case.

Duplicates the test and test case.

Duplicates tests and test cases as many as the number entered.
Deletes the test and test case.

Modifies the test name.

Reconfigure test information.

Selects the files containing that test.

Associates the selected test with the issue of the management tool.
Imports the test data saved in local.

Exports the test data in local.

Exports it locally or registers the file written by the user to the target test

as a test case.
Adds the stub to the selected test.

Apply the class code generated in the Class Factory View to the test.

Checks all checkbox of the tests selected.
Checks all checkbox of the tests selected.

Exports the selected test coverage to the selected path.

* Rule for importing test data
When importing the test data, if you select multiple test data numbered with the test name, it
imports those files by merging them.

* For [Test reconfiguration], refer to [Source Code Modification and Test Reconfiguration]

Import test data

You can import the test data in various formats (csv, xIsx, txt, json).
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C.

Add Test Case
Generate test cases automatically

Host Output Walue -= Expected Value
Initialize Test Case

Duplicate

Duplicate multiple times...
Delete

Rename...

Set related file
Relevant issues settings...

Import Test Data
Export Test Data
Large test data

Generate binary for debugging
Add Stub...

Select Test

Deselect Test

Generate coverage report...

Cirl+C
Ctrl+V

Ctrl+D

Delete
Fe

>

E43
E43

Basic format data
External format data

User Manual - 3.6_en

In the context menu of the Unit Test View, click [Import Test Data] and select either [Basic format

data] or [External format datal.

If you select [Basic format data], the test data with the format (csv) exported from the Controller

Tester is imported.

If you select [External format data], the test data is imported from the files in various formats (csv,

xlIsx, txt, json).
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B mport Test Data

Import Test Data

User Manual - 3.6_en

Select the format of the data file, and select the data file to import.

File format:

CT csv file 7HH 27|
CT excel file 7127

CT multiple test excel file 7t%
multiple_test_data_importer_ir
multiple_test_data_importer_Li
multiple_test_data_importer_w
text file FHR 27|

Data file

File extension: json

Description: Controller Tester json format.

open script location

Browse...

Remaove

oK Cancel

Generate test cases automatically

It creates a test case by using [Flat/Pairwise/Random combination], [Generates with Function
Generator], and [Search-based Test case Generation (CS Labs)].

Name

~ @ adler32(unzigned long, const unsigned char *

L~ IECEEE-T. —
o Add Test Case

Generate test cases automatically

Initialize Test Case

Set related file

Relevant issues settings.

Impeort Test Data
Export Test Data
Large test data

Generate binary for debugging
* Add Stub...

Select Test
Deselect Test

m  Generate coverage report.

Host Qutput Value -> Expected Value

Copy Ctrl+C
Paste Ctrl+V
Duplicate Ctrl+D
Duplicate multiple times...

Delste Delete
Rename. F2

Result. Coverage
7/0/6)13 97.0% (00/10:
7/0/86)13

Flat Combination
Pairwise Combination
Randem Cembination

Generate with Function Generator

Search-based Test case Generation (CS Labs)

11/0/0 11 100.0% (1818
11707011

1. In the context menu of the Unit or the Integration Test View, click [Generate test cases
automatically] and select one among [Flat Combination], [Pairwise Combination], [Random
Combination], [Generate with Function Generator] and [Search-based Test case Generation (CS

Labs)].

Method
Flat

Pairwise

Description

Combines simply based on variables having the largest number of test data.

Combines so that each selected parameter data is paired at least once with the
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parameter data other than itself.
%% The number of variable partitions must be more than 2 and less than 52.

Combines the test data as many as the number of test cases that the user defines
Random any value between the minimum value and the maximum value for the variable
partition of input parameters.

Generate with Creates a test case by using six function types. (Ramps, Random, Range, Sine,
Function Generator Toggle, and Single Value)

Search-based Test
case Generation
(CS Labs)

2% Currently, only C language is supported.

2. If you select [Random combination], the Random combination window is displayed so that the user
can enter the number of test cases.

B Random Combination >

Mumber of Test case |5

Cancel

3. If you select [Generate with Function generator], you can select the function type (Ramps, Sine,
Random, Toggle, Range, Single value and None) and change the settings of the function selected
via the settings of the function generator. In the properties window of the project, you can set the
function generator information in [Test] > [Generate test cases automatically] > [Function
Generator].
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. Generate with Function Generator

— *
Test Parameter  Type Function t... Function type: |Sine | v
adler unsigned |..  Sine
buf_rmem([0 unsigned ... Mone
- ol .g ) Amplitude: |I3-.I3- |
l=n unsigned i.. Mone
Period: | 1 | [samples]
Phase: |I3-.I3- | [deq]
Offset: (0.0 |

sample interval:
Sample count:
Start value:
Type Min:

Type Max:

a. Common settings

0

0

a0

0.0
4204967295

Function Generator Setting

Cancel

User Manual - 3.6_en

You can change the value in [Project] > [Properties] with the setting value common to each function.

Setting Description
Sample ) .
. The interval of samples to be sampled from the function.
interval
Number of i
sample The number of samples to be sampled from the function(The number of test cases).
The default value at which the function is started (the values are created based on the start
Start value
value).
Minimum The minimum value of variable partition. (If the return value of the function is less than the

value of type minimum value of type, the minimum value of type is returned.)

Maximum The maximum value of variable partition. (If the return value of the function is greater than
value of type the maximum value of type, the maximum value of type is returned.)

b. Ramps function

It is a function that creates a pulse by using Pre, Post and Hold values. If the number of samples is
greater than the period of the function, the function is called recursively.
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Setting Description

Pre delay The time to last Pre/Post sample value.

Rise samples The time to rise from Pre/Post sample value to Hold sample value.
Hold samples The time to last Hold sample value.

Fall samples The time to fall from Hold sample value to Pre/Post sample value.
Post delay The time to last Pre/Post sample value.

Pre/Post delay value Pre/Post delay sample value.

Hold value Hold sample value.

c. Random function

It is a function that creates a random value between the minimum value (Min) and the maximum
value (Max).

Setting Description
Min The minimum value of random range.

Max The maximum value of random range.

d. Range function

It is a function that creates values that increments or decrements by a certain interval (Step Size)
between the minimum value of type and the maximum value of type.

Setting Description

Step . .
size The size of increment or decrement value.
Hold The number of times that the Step size holds.
Risin The function type that rises by the Step size.
g Ex) if the step size is 30, 0,30,60......
) The function type that falls by the Step size.
Falling

Ex) if the step size is 30, 100,70,40......

If the result value of function meets the minimum/maximum value of type, the function type that
Alternate changes to rise or fall.
Ex) if the step size is 30 and the maximum/minimum value are 0~100, 0,30,60,90,60,30,0......

e. Sine function

It is a function that creates Sine value. If the number of samples is greater than the period of the
function, the function is called recursively.
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Setting Description

Amplitude The amplitude of Sine function.
Period The period of Sine function.
Phase The phase of Sine function.

Offset The offset of Sine function.

f. Toggle function

It is a function that creates FirstValue and SecondValue repeatedly.

Setting Description
First value The first value that is repeated in Toggle function.

Second value The second value that is repeated in Toggle function.

g. SingleValue function

It is a function that returns only a constant single value.

Setting Description

Value  The value to be created.

h. None
It does not create a function.

Relevant issues settings

It associates the selected test with the issue in the issue management tool registered. The Controller
Tester supports the following issue management tools: JIRA, Trac, Redmine, Mantis, Bugzilla.

1. In the context menu of Unit Test View, click [Relevant issues settings...].
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Add Test Case

Generate test cases automatically

Host Output Walue -> Expected Value

Initialize Test Case

Duplicate
Duplicate multiple times...
M Delete

Rename...

Set related file

Ctrl+C
Ctrl+W

Ctrl+D

Delete
F2

Relevant issues seftings...

Import Test Data
Export Test Data
Large test data

C. [

Generate binary for debugging
£} Add Stub..

Select Test

Deselect Test

mm Generate coverage report...

2. Enter the information of the issue management tool in the configuration file

(IssueManagement.ini).

| < | UnitTester
Home Share View

&« 5 v 1 <« AppData » Roaming » CodeScroll » UnitTester

"~ MName
7 Quick access

4.2.2

Date modified

Search UnitTester

Type

File folder

Size

I Deskto
? IB Issuehanagement.ini

Configuration sett...

{rs

¥ Downloads

Documents
[&] Pictures
.metadata

-
-
-
+

CodeScroll Cont:
cT3.2
D Music

@ OneDrive

[ This PC
[ Desktop
Documents
- Downloads
D Music
[&=] Pictures
B videos
‘e Local Disk (C:)

SO0 Drive (0 Vie ¥
2items  1item selected 0 bytes

3. Add the issues to be associated with the test.

User Manual - 3.6_en
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B:

= jssue O >
Select the issues to associate with the 1 selected tests. :
|t_\,-'p-e filter text |
ZLIB-5 || add
B Add associated issue x

Enter the ID of issue to add

[z |

ok || cencel |

lssue management tool information

Type:  JIRA Open Cenfiguration Folder

Address: http://211.116.223.80:3080 Update information

| oK || cancel |

-

4. Check the checked issue list and click [OK].
B set associate issue O X

Select the issues to associate with the 1 selected tests.

|t_\,-'pe filter text |
ZLIB-5 I Add... i
Edit...
Remaove
lssue management tool information
Type:  JIRA Open Configuration Folder

Address: http://211.116.223.80:8080 Update information

oK | Cancel |
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15.4. Integration Test View

The Integration Test View provides the integration test unit that can group the unit tests. The unit tests
under the integration test run in order with the context maintained.

I CodeScroll Controller Tester RTV(Remote Target Verifier) + Target Plugin (x64) - o X
‘gue Edit Search Project Target Window Help
4 2lib B [Ny 2 B 8 4.9 ¥ & (Ciobal seach i3 SSHEIE
New Project New Test Import Export Properties Preferences
& g || show Coverage &) Coverage -3 MC/DC ¥ Stub ¢} Class Factory <% Control Flow Graph <2 Call Graph £ Function Call Hierarchy ") Eror

[ adler32.c 2 = A Unit Test Integration Test Be OIEIEEHY v =8

.Wlﬁ(buf); /* 16 sums unrolled */
buf 4~ 165 m v Call Coverage

(33/0/1) 34 44.1%
165/374

type fil, test, state, issue
Name. Result Coverage
v € INTEGRATION 6 33/0/1 N/A

v [fest

11/0/0;
11/0/0
0/0/1

-
]
&

5

Signaled

PROONO VWS R

=53

+= (adler2 & @xffff) + BASE - 1;
+= ((adlerl >> 16) & OxFFff) + ((adler2 >> 16) & OxFFff) + BASE - rem
BASE;

{65t adler32_combine(unsigned long, W evorsiom [0

Toolbar menu in the Integration Test View

Toolbar icon Description

Expand All Shows all test view tree nodes.
=l Collapse Al Hides all test view tree nodes.

1" Move Up Test Moves the selected test up.

<> Move Down Test Moves the selected test down.
(& Create Creates an integration test.

&= Shows as Unique Test , ) )
Displays with unique test name.

Name

tl Total Displays all the tests.

B° Failure/Error Displays only the tests that the test result is Failure/Error.

gl Failure Displays only the tests that the test result is Failure.

gl Error Displays only the tests that the test result is Error.

el Success Displays only the tests that the test result is Success.

t2 Function changed Displays only the tests that the function to be tested has been changed.
E+ Run not guaranteed Displays only the tests that the test execution is not ensured.
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Displays only the test that the host result and the target result are

 Host/T t It different
ost/Target result differen different.

Pull-down menu(V) in the Integration Test View

B4 @2 E~Ele o
Show coverage at all elements
»  Add description when duplicate test case
50] Insert Default Values for Empty Input
Delete All Test case Descriptions
€3 Check Integrity

Menu name Description
Show coverage at all elements Displays the coverage in all items.(integration test, test, test case)

Add description when duplicate test . .

case Adds original test case number on duplicated test case.
Insert Default Values for Empty Input ~ When input data are empty, inserts default values.
Delete All Test case Descriptions Delete test case descriptions all together.

Checks integrity about functions and stubs. Then, reset test if it

Check Integrity needs

* Insert Default Values for Empty Input

Variable type Default value
string (empty string)

without string 0

* For [Test reconfiguration], refer to [Source Code Modification and Test Reconfiguration]

Dashboard in the Integration Test View

Unit Test Integration Test oo L|EE Ly =0
m v Call Coverage
(33/0/1) 34 44.1%

(165/374)

type file, test, state, issue

Menu Description
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m Runs integration tests.

(878 / 0/ 359) 1237  shows success, failure, error and total of test case.

Selects the coverage type to be displayed in the Integration Test View.
(statement, branch, MC/DC, function call)

v Statement Coverage

43.7%

(1952 /4466) Shows the selected kind of full coverage.

Search

In the Integration Test View, you can search the integration tests, tests and test cases by file, function,
test, status (success, failure, error) and issue name.

Unit Test Integration Test BT L @E|EEH Y2 B
m v Statement Coverage

(33/0/0) 33 43.0%

R el-Tel=1=1

ltg,-'pc— file, test, state, issue I

Status search keyword

In the Integration Test View, you can filter the tests displayed by the status search keyword. It provides
searchable keyword recommendation and auto-complete function.

Keyword Description

$TEST SUCCESS% Test success

$TEST FAILURES $TEST ERRORS% Test failure/error

$TEST FAILURES% Test failure

$TEST ERRORS% Test error

$TEST HAS NOT FUNCTIONS% Function changed

$TEST NOT GUARANTEES Run not guaranted

$TEST RESULT DIFFERENTS% Host/Target result different

Structure of the Integration Test View

The Integration Test View presents the hierarchy structure of [Integartion tes] > [Test] > [Test case].
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Unit Test

type file, test, state, issue

MName
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Integration Test ERETIEY | Gg_.?| i B > = = B8

v Call Coverage

(33/0/1) 34 44.1%
74)

(165/3

=

Result Coverage

w [ lest

v [ INTEGRATION_@ 33/0/1) 34 N/A

case] 1
case
case
case
case

adler32_combine(unsigned long, unsigned long, signed (11 /0 /0) 11

case
case
case
case
case
case
> [est] adler32_combine(unsigned long, unsigned long, signed (11 /0 /0) 11

PR Yoo u B wm

= ®

Item icons in the Integration Test View

Item icon Description

None

test

lesi®

case

Integration Test
Test
Global variable test

Test case, Test case group

Item status color in the Integration Test View

The execution information of functions, tests, and test cases in the Integration Test View is represented

by colors.

Color

Green

Blue

Red

Orange

Black

Description

Integration Test/Test: If the execution result of all the test cases under it is success.
Test case: If the result of execution is success.

Function/Test: If only test cases with failure and no test cases with errors exist under it.
Test case: If the result of execution is failure.

Function/Test: If test cases with error exist under it.
Test case: If the result of execution is error.

Function/Test: All test cases have not been executed under it and test cases that are not
guaranteed to run exist.
Test case: Run not guaranteed

Function/Test: All test cases under it have not been executed.
Test case: Not been executed
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Context menu in the Integration Test View

Create Test..

Create sub-integration test

Copy
Faste

Duplicate
Duplicate multiple times...

Paste as sub-integration test

¥ Delete
Rename...

Select Test
Deselect Test

Context menu
Create Test

Create sub-integration
test

Copy

Paste

Duplicate

Duplicate multiple times

Paste as sub-integration
test

Delete
Rename
Select tests

Deselect tests

Ctrl+C
Ctrl+V

Ctrl+D

Delete
F2

Description

Creates the dialog for creating a test

Creates a sub-integration test

Copies the test and test case

Pastes the test and test case

Duplicates the test and test case

Duplicates tests and test cases as many as the number entered

Pastes the integration test copied into the integration test selected as a sub-
integration test

Deletes the test and test case
Modifies the test name
Checks all checkbox of the tests selected

Checks all checkbox of the tests selected

Create Integration test and Rename

The integration test can be created in the toolbar menu. The name of the integration test is assigned
automatically and can be changed by using [Rename] context menu.

* Create
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Unit Test Integration Test i 4 | ZEH~- =0
| v statement Coverage|
;
(33/0/0) 33 43.0%
(1719/3995)
type file, test, state, issue
Name Result Coverage
v [ INTEGRATION_® (33/0/0)33 100.0% 12,12
v adler32_combine(unsigned long, unsigned long, signed a1s0/0 11
1
2
3
4
5
6
7
8
9
1e
11
* Rename
Unit Test Integration Test G L |E B e = O
m | v statement Coverage|
)
(33/0/0) 33 43.0%
(1719/3995)
type file, test, state, issue
Mame Result Coverage
v [ INTEGRAT Create Tast. \ (33/0/0) 33 100.0% 12/18)
v ad] Create sub-i I Rename o x !
1
Copy Mew name: |
1 g paste
Duplicate
Duplicate m oK | | Cancel ‘
Paste as sub
% Delete Delete
Rename... F2
Select Test -
Deselect Test g, signed 1 .-’.0 f. o0n
e. siened Mm/s0/01

Sub-integration test

You can create a sub-integration test under the integration test by using [Create sub-integration test]
context menu or pasting an existing integration test into other integration test using [Paste as sub-
integration test] context menu.

Unit Test Integration Test T 4| @B EHy =8
m | v Statement Coverage|
0,
(33/0/0) 33 43.0%
(1719/3995)
type file, test, state, issue
Mame Result Coverage
v @ INTEGRATION_© (33/0/0) 23 100.0% (15/18
> adler32_combine(unsigned long, unsigned long, signed Mmso/01
w INTEGRATION_1 (22/0/0 22
v adler32_combine(unsigned long, unsigned long, signe m/so0/0 1
1
2

[case] 3

Add a test and change the order of run

There are four ways to add tests to the integration test.
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There are two ways to change the execution sequence for the test.

1. You can select a test or test case and change it by moving with a mouse.

User Manual - 3.6_en

You can select an integration test and create it by using [Create Test...] context menu.

You can add by dragging and dropping the test in the Unit Test View to the integration test.

You can select the test of the Integration Test View and copy/paste it by using the context menu.
You can select the test in the Unit Test View and copy/paste it by using the context menu.

2. You can select a test or test case and change it by selecting either [Move Up Test] or [Move Down

Test] in the toolbar.

Unit Test Integration Test E| @2~ = A8

m [v Call Coverage |

(33/0/1) 34 44.1%
(165/374)

type file, test, state, issue

MName Result Coverage

v @ INTEGRATION_@ (33/0/1) 34 N/A
v adler32_combine(unsigned long, unsigned long, signed 1M1/0/0 11
1
2
3
4
5
6
7
8
9
1@
11
> adler32_combine(unsigned long, unsigned long, signed (11/0/0) 11

The coverage result of integration test

If you select the integration test, the result can be checked in the Coverage.
Unit Test Integration Test B L@ 2B 2O

| v statement Coverage|

(33/0/0) 33 43.0%
(1719/3995)

type file, test, state, issue

Name Result Coverage
+ [ INTEGRATION_®@ (33/0/0) 23

v adler32_combine(unsigned long, unsigned long, signed 11/0/0) 11

1

2

3

4

5

6

7

8

9

10

11
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It shows the coverage of the function to be tested after test has been run as a percentage.

|= | Caoverage &3

Host coverage information of 'zlib' project

N =]

1
2
3
4
5
B
7
8
9

10
11

Total

Target Function | Statement Branch MC/DC IFunctiun CaIII Funr:ti...l "
_tr_align(struct internal_state #) -T2 2% | T000% | |eemAQ 00% (w0000 0 Yy
_tr_flush_blockistruct internal_state _ |mm 54 7A%  |me g2 500  wem 35 355, e 70 00% =y
_tr_init(struct internal_state ¥ = 00.00%... = N/A — /A - 00.00... |-y
_tr_stored_block(struct internal_stat... == 100.005...[== 100 00%... == 100.00%... == 100.00... ==Y
_tr_tally(struct internal_state * unsi.. == 222575  ==(00% (.. ==000% (.. —MN/A -
adler32(unsigned long, const unsig... ™ 93.05% ... == 37.50% .. == 75.00% .. = MN/A =
adler32_combine(unsigned long, u... (== 100.00%... == 100.00%... == 100.00%... = N/A -
bi_flush(struct internal_state # w1 00.00%. .| == 100.00%... == 100.00%...[— N/A -
bi_reverse(unsigned int, signed int) == 100.00%... ™= 100.00%... ™= 100.00%...— N/A -
bi_windup(struct internal_state #) w1 00.00%. .| == 100.00%... == 100.00%...[— N/A -
build_bl_tree(struct internal_state *) |== 100.005%...|== 75.00% ... == 50.00% ... == 100.00... ==Y

43.02% (...|28.51% (... 19.07% (... 44.11% (... 100.0... «

& In target testing mode, the coverage of the function including Asm code can not be measured.

Coverage type provided in Controller Tester

Coverage Description

Statement

Branch

MC/DC

Percentage of branch executed by the test.

Percentage of source code statement executed by the test.

100% branch coverage includes 100% decision coverage and 100% statement coverage.

in MC/DC view).

Function

call

Function

Percentage of the function called by the test among all the functions.

Label icon in the Coverage View

Icon

i

@ Function containing Asm code.

Description

Function changed.

Percentage of functions that have been called at least once in all functions.

Coverage considering the condition coverage and the decision coverage complexly(described
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Toolbar menu in the Coverage View

Toolbar icon Description

E: Shows coverage for each test.
[ Shows full coverage.
] Shows full coverage(including the external coverage).

Show Coverage

You can check the coverage of the tests in the Coverage View or in the Source Code Editor.

Show coverage in the Coverage View

The Coverage View shows the coverage information of the test or test case selected in the Unit Test
View and Integration Test View. If you click [Show full coverage], the coverage information for all tests
can be checked by merging them. And if you click [Show full coverage (Include External Coverage)], it
shows also the coverage imported externally by merging them.

The coverage for the items selected in the tree is displayed at the bottom of the Coverage View.
Total 43.02% (171...| 28.51% (603/2115) | 19.07% (239/1253) 44.11% (165/... 100.00% (114/...

In the Coverage View, the coverage for each function is displayed for the items selected in the Unit or
Integration Test View.

"] Coverage &2 M B L) = O
Host coverage information of 'zlib' project
Target Function | Statement Branch MC/DC |Functiun CaIII Functi...l -
1 _tr_alignistruct internal_state # -2 V2% . | T0.00% | | e AQ 00% . (w0000, =YY
2 | _tr_flush_blockistruct internal_state .. == 54 75% .. == 52 50% ... "= 35 355 ... == 70.005% ... ==Y
3 _tr_init(struct internal_state ¥ 1 00.00%... = N/A = N/A - 0000, |-
4 | _tr_stored_block(struct internal_stat... == 100.00%... == 100.005%...[== 100.00%... == 100.00... (==Y
5 |_tr_tally(struct internal_state *, unsi... ™= 22 255 | =m0 00% (.. ==000% (.. = N/A -
6 adler32{unsigned long, const unsig... == 98.05% ... == 37.50% .. == 7500% .. = N/A -y
7 |adler32_combine{unsigned long, u... ™= 100.00%...[== 100.00%. . ™= 100.00%...— N/A -
8  bi_flushistruct internal_state % = 00.00%... == 100.00%... == 100.00%...[— N/A —
9 |bi_reversefunsigned int, signed int) ™= 100.00%...[== 100.00%. . ™= 100.00%...— N/A -
10  bi_windupistruct internal_state #) =] 00 005, [ 00 00, = 0005 = NAA -y

11 |build bl tree(struct internal_state *) ™= 100.005%... ™= 75 005 .. == 50 005 (== (0000 . (==
Total 43.02% (... 28.51% (... 19.07% (... 44.11% (... 100.0... +

& In target testing mode, the coverage of the function including Asm code can not be measured.

In the Coverage View table, you can the control flow graph, the function call graph and MC/DC for each
function via the context menu.
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| Coverage i3

Host coverage information of 'zlib' project
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[z MR =

2
3
4
5
5]
7
8
9

10
11

Total

| Target Function Staternent Branch MC/DC IFunctiDn CaIII Functi...| "
TTTTTT . R70.00... "®40.00... 7 100.00...° Y
_tr_flush_blockistru SiIlLs 62.50% ... w35 365 . (= 70005 .. (mmY
tr_init(struct intern 5how Call Graph N/A [ ON/A == 100.00. ==Y
_tr_stored_block(str Show MC/DC 100.00%. == 100.00%._[== 100.00_. (==Y
_tr_tally(struct internal_state # unsi... == 22 25% _ == 00% (. ==000% (.. = N/A -y
adler32{unsigned long, const unsig... ™ 93.05% ... == 37 50% .. == 75.00% ... — N/4& -
adler32_combine{unsigned long, u... == 100.00%... ™= 100.00%...[== 100.00%... = N/A -
bi_flushistruct internal_state # | 00 005, (= 00 00%. == 00.00%... — N/A =
bi_reverse(unsigned int, signed int) |[== 100.00%...[== 100.00%...|== 100.00%... = N/A -y
bi_windup(struct internal_state #) = 30.00%... == 100.00%... /== 100.00%...[— N/A -y
build_bl_tree(struct internal_state ¥) == 100.00%... == 75 00% ... [==5000% ... == 100.00... ==Y
43.02% (... 28.51% (.../19.07% (... 44.11% (... 100.0... «

@& In target testing mode, the coverage of the function including Asm code can not be measured.

Show coverage in the Source Code Editor

If you enable [ £ Show Coverage] icon in the main toolbar and click the wanted fucntion/test/test case in
the Unit/Integration Test View, it shows which part of the source code is covered by using the color
information. The green color indicates that the code is covered, the red color indicates that the code is
not covered, and yellow color indicates that the portion of the code is covered only.

adlerdz.c i
63

“ulong ZEXPORT adler32_z(adler, buf, len)

ulong adler;
const Bytef *buf;
z_size_t len;

unsigned long sum2;
unsigned n;

/* split Adler-32 into component sums */
sum2 = (adler >> 16) & OxFFFf;
adler &= @xffff;

/* in case user likes doing a byte at a time, keep it fast */
if (len == 1)
adler += buf[8];
if (adler >= BASE)
adler -= BASE;
sum2 += adler;
if (sum2 >= BASE)
sum2 -= BASE;
return adler | (sum2 << 16);

}

/* initial Adler-32 value (deferred check for len —
if (buf == Z_NULL)
return 1L;

1 speed)

/* in case short lengths are provided, keep it somewhat fast */
if (len < 16) {
while (len--) {
adler += *buft+;
sum2 += adler;
}
if (adler »>= BASE)
adler -= BASE;
MOD28 (sum2) ; /* only added so many BASE's %/
return adler | (sum2 << 16);

=/

(=]

A

Unit Test

Integration Test

type file, function, test, state, issue

Name

> @ _tr_align(struct int

> @ _tr_flush_bits(s
> @ _tr_flush_block
> B _tr_init(st
> @ _tr_stored
> @ _tr_tall
> adler32
> adler32_combine
> adler32_combine64(u
> adler32_combi|
v 8 adler32_z(unsi

- iest] adler

i

1 Signaled
2
3 Signaled
[Ea5€] 4 signaled
5
6 Signaled
(Ease) 7
8 signaled
(case] 9
10 Signaled
11 Signaled
12
13

\ Smart Insert | 5420

(907 / 0 / 269) 1176

:-M of 1226M ([}

CodeScroll Controller Tester - o X
File Edit Search Project Window Help
&5 test & B & &4 @ Host @ Y [ (Global search (curi+3) SYHEEIE
New Project New Test Import Export Properties Preferences -
L= Ty |I <\ Show Coverage I| || Coverage —4MC/DC (1% stub (¢ Class Factory < Control Flow Graph 2 Call Graph Requirement =3 Fault Injection

gEEBE- =0

v Statement Coverage

43.8%
(2041/4652)

Coverage 2

/18 71.4% (152
o 100.0% 11
212 57.1% 20042
/0 100.0% (10710
8 100.0% (17/17
3 22.2% (20
1 100.0%
o 100.0%
100.0%
100.0% 2172
100.0% (103/103

In the vertical column on the left of the Source Code Editor, the marker indicate whether the branch
statement is true or false.

Marker Description

T

E

The branch is only covered as true.

The branch is only covered as false.
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[ | The branches are all covered.
[ | The branch is not covered.

A line with multiple branches partially covered.
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15.6. MC/DC View

The [MC/DC] view shows the information of MC/DC coverage(Modified Condition/Decision Coverage).

MC/DC coverage

MC/DC is the improved condition/decision coverage allowing each individual conditional expression to
independently affect the result of the whole conditional expression without being affected by the other
individual conditional expressions and it is stronger than the conditional/decision coverage.

If there is no change in the other conditions and it affects the result when the own state has changed,
the state can be said to satisfy MC/DC, and the conditions for creating the truth table are as follows.

* The state of decision(decision statement) must satisfy at least once all possible results(true, false).

« All individual conditional expressions belonging to the decision must satisfy at least once all
possible results(true, false).

« Each conditional expression belonging to the decision affects independently the result value of
decision it belongs to without being affected by the other individual conditional expressions.

MC/DC view table

* View combination lists satisfying the target coverage
The following figure is a view that can identify easily the combinations which need to be covered to
achieve the target coverage.
The left section shows the list of Decisions for the selected functions, below which the list of
combinations satisfying the target coverage are displayed.
The right section shows the truth table of the selected Decision or combinations and whether or
not it is covered. The covered combination is displayed in green and the uncovered combination is
displayed in red.
In the Preferences page, you can change the target coverage rate and the screen view mode. And
you can select all for the truth table and use ‘Ctrl + C’ or Copy clipboard function from the context

menu.
~JMC/DC 32 A ¥ = 8
zlib »> Default Module == inflate.c == inflatelnit2_
v © Decision 0 DO = ((COJIC1)||C2) 0 1 2 3
(0,1,2,3) (100%)| L CO:version == 0 T F F F
L C1: version[0] 1="1.2.3"[0] x | T F F
! L C2: strearn_size |= (int)(sizeof(z_stream)) X | X T F
) T|T|T|F
]
o
<
< Decision 5
© Decision 6
© Decision 7
£ * | # If a decision or a condition has too many combination lists, only the top 20 is s
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» View combination lists satisfying the coverage for each condition
The following figure is a view that can identify a one-pair combination satisfying one condition. The
left section shows the list of combinations that satisfies the coverage for each condition. The right
section shows the truth table for the selected combinations and whether or not it is covered.

—JMC/DC 32 = ¥ = 0
zlib > Default Module == inflate.c == inflatelnit2_

wv © Decision 0 D0 = ((cojcnfica)
v =4 0 L CO: version == 0
=@ (0 3) L C1: version[0] !="1.2.3"[0]
v =4O L C2: stream_size != (int)(sizecf(z_stream))
& (1,3
Jcz
= (2, 3)
Decizion 1
Decision 2
Decision 3
Decision 4
Decision 3
Decision &
Decision 7

A X | H o
M| ™| M| T W

<

0000000

& If a decision or a condition has too many combination lists, only the top 20 is s
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15.7. Stub View
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In Controller Tester, if there are no libraries used in the target function when executing a test, if the
libraries are not yet developed, or if the variables not declared are used, it creates automatically the
stubs instead. The stubs are created when running the test and the body is not implemented.

You can add stubs directly in addition to the stubs created in Controller Tester. Multiple stubs can be
created for the same function and the stubs created can be linked to each test.

You can control the behavior of each stub by using user macro within the stub. The value used in the
user-entered macro can be controlled in Edit a test case tab for the test linked.

L stub 2
Manage stub items of sct-1332 project. (9 itemns)

tTHIEES T2 0

type filter text

w @ charlesFunc(signed int)

& D) charlesFunc_1
exit_error()

& (D) exit_error_1
float api12(char c)
% apin2_1
int CSUT_LOGQ
£ CSUT_LOG 1
int stubFunci(

& stubFunct 1
int stubFuncz(

%% stubFunc2_1
int swap()

2 swap_1
int test_stub0Q
% test_stub0_1
Global Variable
% sst_extern_A

v @

v @

Function type

Type Description

© Function Function without deficition
2 Function Function with definition

® Variable Global variable

Stub type

Type Description
A User stub User-defined stub
i Build stub Auto-created stub

=% Old version stub

Stub code  Configuration

/1 @Kind: User Function

@signature: int charlesFunc(int a)
@signatureHash: 3795858745

A @File: D:NCT34_Source\study sample\study_ sampli
5 return 8;

6]

Beowa ro

* CS_ASSERT(b) A
* (CS_ASSERT_MSG(_b, _msg)
# CS_INT_OUTPUT(v, _s)
# CS_UINT_OUTPUT( v, _s)
* CS_FLT_OUTPUT(v, s)
# CS_STR_OUTPUT(Y, _s)
# CS_INT_INPUT(L, _5)
* CS_UINT_INPUT(L, _s)
# CS_FLT_INPUT(L, _s)
# CS_STRINPUT(L, _s)
CS_ADDR_PTR(_3)
* * CS VIRTUAL ADDR( b, &) v
‘Ctrl + Space’ key pressed, show macro keyword fist.

*

Stub with 2.3 or less version
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Menu

Menu

¥ Create
X Delete
& Import
&3 Export
=) save

! Enable

#! Disable

Description

Creates stubs.

Deletes stubs.

Imports the stub file exported.
Exports a stub file.

Saves the change stub information.
Enables stubs.

Disables stubs.

Create stubs

e Create stubs in Stub view

1.

2. Check the functions to be created as stubs and select [OK].

Click the pull-down menu (V) in Stub view and click [Create] menu.

THEBEES YE O B

Create...

iture: void zcfree(wd
itureHash: 4113644488

Delete
Import...
Export...

Cenfiguration
User Function

zutil.c e

B CEF % &

Enable
% Disable

l

User Manual - 3.6_en
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B create stub d

Create Stub

Select the functions to create stubs

! | Function | Path ”~
| 1 [l @ _fr_align(struct internal_state #) frees.c
2 O @ _tr_flush_block(struct internal_state *, char * unsigned lon...| [ trees.c
3 | @ _tr_init(struct internal_state #) trees.c
4 | @ _tr_stored_block(struct internal_state *, char *, unsigned lo...||Z trees.c
5 | @ _tr_tally(struct internal_state *, unsigned int, unsigned int) frees.c
;6 O @ adler32{unsigned leng, const unsigned char *, unsigned i...|[E adler32.c
7 O @ adler32_combine{unsigned long, unsigned long, signed |... |Z] adler32.c
8 O @ bi_flush{struct internal_state #) trees.c
9 | @ bi_reverse(unsigned int, signed int) trees.c
10 | @ bi_windup(struct internal_state #) frees.c
11 1 @ build_bl_tree(struct internal_state #) frees.c
12 | @ build_tree(struct internal_state *, struct tree_desc s #) frees.c
13 | @ check_header(struct gz_stream *) gzio.c
14 O @ compress{unsigned char *, unsigned leng *, const unsign...|[=] compress.c
15 O @ compress2{unsigned char *, unsigned long *, const unsig... | =] compress.c v
. [ | - - " . [} . (=

Select All || Deselect All

1
cocl

» Create stubs by drag-and-drop from Test Navigator view to Stub view.

T Test Navigator = C==;'> = a8 8
' 7998 ~
3 MasiMaro

v I b
~ (5 Default Module

v [ adlers2.c
@ adler32

v
{iswb % TH EBEES Y= 0O
Manage stub item:

type filter text

lib project. (1 items)

stub cede  Configuration

~ @ adler3 Kind: User Functien

long, const unsigned char *, | 141
% (0) a 2

3
adler32 4 File: adler32.c
Sreturn @;

< b3
< > °Ctrl + Space’ key pressed, show macro keyword i

* Create stubs by drag-and-drop from Unit Test view to Stub view.
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£ stub 2 YHIEEES Y= O
Manage stub itemns of test project. (1 items)
|type- filter text Stub code  Configuration
5 @ _tr_flush_bits(struct internal_state #) 1

‘Ctrl + Space’ key pressed, show macro keyword list.

» Create stubs in source code editor
1. Select the functions to be created as stubs.

[ trees.c &2 = 0
381 */ ~
382 =void _tr_init(s)

383 deflate_state *s;

384 i

385 tr_static_init();

386

387 s-»1 desc.dyn_tree = s->dyn_ltree;

388 s-»1 desc.stat_desc = &static_l desc;

389

398 s-»>d_desc.dyn_tree = s->dyn_dtree;

391 s-»>d_desc.stat_desc = &static_d_desc;

392

393 s->bl_desc.dyn_tree = s-3bl_tree;

394 s-»bl_desc.stat_desc = &static_bl desc;

395

396 s-»bi_buf = 8;

397 s-»bi_valid = @;

398 s->last_eob_len = 8; /* encugh lockahead for inflate */

399 #ifdef DEBUG

460 s->compressed_len = @L;

4@l s->hits_sent = @L;

482 #endif

483 v
< >

2. Right-click it and select [Create Stub] context menu.

] trees.c 52 = 8
* "
=wvoid _tr_init(s)
deflate_state *s;

" mm——
Undo Ctrl-Z
5->1_de: Revert File
s5->1_de:
Save Ctrl+§
s->d_de:
s->d_de: Open With >
Show In Alt+Shift+W >
s->bl_de
s->bl de Cut Ctrl+X
s-3bi_bt Copy Ctrl+C
s->bi_wi Paste Ctrl+\
s->last_ For inflate */
#ifdef DEBU( Source Alt+Shift+5 >
s->compt Surround With Alt=Shift=Z >
s-rhits
#endif Search Text >
v
< +  Create Stub o >
£ Stub 52 Preferences... + | ® v =0

e Create and Link in Test Editor

1. In the test structure of Test Editor, select the stubs or sub nodes.

2. Select [Add New Stub...] button on the right section.

WOW W W W W W N W W W W W W W Ny

e0o00o0c0ccc0o0on
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AULEN DL LUNNULIineEo-
adler32_combine_
adler32_z(unsigne
bi_flushist
bi_reverse(.
bi_windupist
build_bl_tree(str
build_tree(struc
compress(un
compress2|unsi
compressBounduns:
compress_block (=t
erc32(unsign

crc32_bigi.
crc32_combine(uns:
crc32_combineBd(u
crc32_combine_(un
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| _trinit{struct internal_state... &3

Test Info (zlib/_tr_init_test0)

Test Structure Q, g Test Info Edit

Test structure using a tree view and edit the information in the test. Manage the stub items added to test.

Mame In Out Mame Description

Test global code
User code
> Global Wariable
> Test target function
User code
v Stub
Host
Target

-
E o

Add New Stub...
Add Stub..

Remove Stub

Test Info | Test Ca&el Test Code| Configuration |

3. Check the functions to be created as stubs and select [OK].
B create stub X

Create Stub

Select the functions to create stubs

! | Function | Path "~
| 1 1 @ _tr_align(struct internal_state #) frees.c
2 | @ _tr_flush_block(struct internal_state *, char *, unsigned lon...||Z trees.c
3 | @ _tr_init(struct internal_state *) frees.c
4 O @ _tr_stored_block(struct internal_state *, char *, unsigned lo... |5 trees.c
5 | @ _fr_tally(struct internal_state *, unsigned int, unsigned inf) trees.c
;| 6 O @ adler32(unsigned long, const unsignad char *, unsigned i |[E] adler32.c
7 | @ adler32_combine(unsigned long, unsigned long, signed |... |l adler32.c
8 | @ bi_flush(struct internal_state #) frees.c
9 | @ bi_reverse(unsigned int, signed int) frees.c
10 | @ bi_windup(struct internal_state #) frees.c
11 | @ build_bl_tree(struct internal_state #) trees.c
12 O @ build_tree(struct internal_state *, struct tree_desc_s %) trees.c
13 O @ check_header(struct gz_stream #) gzio.c
14 O @ compress{unsigned char *, unsigned long *, const unsign...|[=| compress.c
15 | @ compress2(unsigned char *, unsigned long *, const unsig... |5 compress.c v
- [ | - - e - [ B (=

| Select All | | Deselect All

1
e

Delete stubs

» Select and right-click unnecessary stubs and select [Delete] menu.
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LStub %2 THlEES Y= 0
hWanage stub items of zlib project. (1 items)
|1:;.-'pe filter text Stub code Configuration
v @ adler32(unsigned long, const unsigned char *, U syp key: |1?{,?593554453421459 |
& (3) adler3z_1
20 ad — Related Files: |P:#Example_Projectwcidipwzlib-1.2. |
¥ Delete Test:
Ly Export. _tr_init(struct internal_state *) 0-Host
“ Disable adler32_combine(unsigned leng, unsigned long, sigi
adler32_combine{unsigned long, unsigned long, sigi
< »
Description:
< 3 Save

Edit stubs

* You can check the macro information by pressing ‘Ctrl + Space’ in the Stub Code screen. After

editing the stub code, press ‘Ctrl + S’ or [Save] button in the toolbar to save it.
—— b -
Stub code  Configuration s e
1/// @Kind: User Function 5 ce
2/// @signature: uLong adler32(ulong : .

3/// @signatureHash: 191688526 <t
A4 /ff) @File: adler32.c » cr

P |

o on
=
n
-

CS_ASSERT )
CS_ASSERT_MSG(_b, _msqg)
C5_INT OUTPUT v, s):
CS_UINT_OUTPUT( v, _s)
CS_FLT_OUTPUT v, _s)
CS_STR_OUTPUT(v, _5)
CS_INT_INPUTt, _s)
CS_UINT_INPUT(_L, _s)
CS_FLT_INPUT(L, _s)
CS_STR_IMPUTLE, _s)
C5_ADDR_PTR(_a)

S MIRTUAL ADDREBL €)ooy ey el

>

AOM M MmO M M M R M M m -

Fs
T ®OE ® O® O®E O ® O O ® E =

‘ctn

* In the stub setting screen, the description can be edited.
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Stub code * Configuration

Stubkey:  [1707503554463421469 |

Related Files: | P:#Example_Projecticidipwzlib-1.2.]

Test:

_tr_init(struct internal_state *)_0-Host
adler32_cembine(unsigned long, unsigned long, sigl
adler32_combine{unsigned long, unsigned long, sigi

< >

Description:
adler32() stub|

Save

Link between stubs and tests

Each stub can be linked to the host/target test.

If you select “Stub” in the test structure editor, you can edit all the stubs included in the host and the

target.
w Stub
v Host
& adler3z v
v Target
& adler3z v

If you select “Host” or “Target”, you can only edit the stubs in the selected test environment.

» Dragging and dropping into the test editor in Stub view

L% Stub 22 + [‘5‘]| = <§> ¥ =0 _tr_init{struct internal_state [t/ adler32_cor

Manage stub items of Zlib project. (1 items) Test Info (zlib/adler32_combine_test0)
type filter text stub code  Cenfiguration The information has been changed after executi
v @ adler32(unsigned long, const unsigned char %, | sy key: ‘1707593554453421459 | Test Structure

& (3) adler32_1
& (0 adler32_2

Test structure using 3 tree view and edit the int

Related Files: ‘ P:Example_Projectwcwdipwzlib-1 .2.:|

Name
Test global code
User code
Global Variable
Test target function
User code
Stub

Host

A& ez
Target
& adlersz 1

1 internal_state *)_0-Host
[l

Description:

v

3 5 Save - -
Test Info | Test Case | Test Code | Configuration

* If linked by drag & drop, it is linked to all the targets and all the hosts.
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* Link with [Add Stub...] button in Test Editor.

1. Select stubs from the test structure in Test Editor.
2. Select [Add Stub...] button on the right section.

k| compress{unsigned char * unsi.. &3

Test Info (zlib/compress_test0)

Test Structure

QEE
Test structurs using a tree view and edit the informaticn in the test.
MName In Qut
Test global code
User code

Global Variable
» Test target function
User code
w Stub
Host
Target

Test Info Edit

Wanage the stub items added to test.

User Manual - 3.6_en

C.
o

Name Description

Add Mew Stub..
Add Stub..

Remaove Stub

Test Info | Test Case| Test Codel Configuration|

3. Among the existing stub list, check the stubs to be linked and select [OK].

B 2dd stub x

' Add Stub

Select stubs to add the test.
If the stubs of the same functicn have been already existed, they are overwritten with the

‘Input Filter Text

Stub name Descripticn
1 8 adier32 adler32) stub
O i adler32_2
O & adlersz_3
O i adler32 4

= Stub code

/f{ @Kind: User Function

Signature: ulong adler32(ulong adler, const Bytef * buf, uInt len)
Signatu’EHa;h: 191688526
File: adler3z.c

cance

Unlink between stubs and tests

Select the stubs linked in the Test editor and select [Remove Stub] button or select the stubs in the test

structure tree and right-click it to unlink them.
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k| *compress(unsigned char * unsi._. 3

Test Info (zlib/compress_test0)

Test Structure .'_‘;\

Test structure using a tree view and edit the information in the test.

Test Info Edit

User Manual - 3.6_en

=

0
3 B

[Manage the stub items added to test.

Mame In Out

Test global code
User code
Global Variable
> Test target function
User code
v Stub
w Host
& adlersz 4
v Target
& adlerzz 4

Mame Description

4 adler3z 4

& adlersz 4

Add Mew Stub...

Remove Stub

Test Info | Test Case| Test Code | Configuration

w Stuh
oy # Disconnect Stub |
Eadler3Z 4
v Target
& adler3z 4

Export stubs

1. Select and the stubs to be exported and right-click and select [Export...] menu.

2% Stub 33
Manage stub items of zlib project. (1 items)

|t_-,-'pe filter text

3 (3 adlgr?™ 1 medlae3 o bk

2 (0) adler Create
& (D) adler 3 Delete

% (0) adler .4 Export...
1 Disable

w @ adler32{unsigned long, const unsigned char *, 1

2. Specify the saving location of the stub file in the directory dialog and select [OK].
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Save

W Documents
v Export
w zlib
Stubs
UnitTests
export_stub
source
» * Downloads
» J': Music
» &= Pictures
» m Videos
5 = | ocal Disk (T
Folder: |New folder |

| Make Mew Folder I

Ok

| | Cancel

Import stubs

1. Select [Import...] menu from the pull-down menu (V) in Stub view.

Y| =

8% v =0

Create...

k.

Cenfiguration
User Function

iture: void zc
itureHash: 4113
zutil.c

Delete
Import...
Export...

free(vg
644458

B C.E % s

Save

| Enable
% Disable

2. Select the stub file to be imported and select the [Open] button.

CadeScroll Cont
CT3.2

D Music

B videos

@, OneDrive

& ThisPC
[ Desktop
Documents

v

File name:

e

| open

Cancel

B import... X
“ v A » ThisPC » Documents » export_stub v O Search export_stub p
Organize v MNew folder =+ [H 0
[ Desktop A " Name Date modified Type Size
& Downloads ] funch_1_1.382453298_20200402104945 5. 4/2/2 CFile 1KB
Documents [7] funcB_1_1_365675679_20200402104849 5.c 4/, CFile 1KB
& Pictures 4 ] main_1_1_3935363532 2020040210404 5.c  4/2/2 CFile 1KB

User Manual - 3.6_en
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! The old version stubs or the stubs that are the same as build stubs existed in the project

cannot be imported.
B import stub

Mot imported stub file list:

i{sampleTest C 3176540677 _20200402121638.c] The function included in the stub)

Use/Not use stubs

You can set whether to use the created stubs.

1. Select the stubs and right-click and select [Disable] menu.

v @ adler32(unsigned long, const unsigned char *, 1
& (3) adler32_1 - adler32() stub

& 0) adler3z 2

& 0) adler3z_3

& (0) adler3™ *

Create

Delete

Export...

Drisable

X . %

2. The stub image decorator is added and the color of the stub name changes to gray as shown in

figure below.

~ @ adler32{unsigned long, const unsigned char *, L
& (3) adler32_1 - adler32() stub

& (1) adler32_2

& (1) adler32_3

af (0) adler3z_4

Page 138 of 322



Suresofttech User Manual - 3.6_en

15.8. Class Factory View

When testing C++ source code, you can use class code to create class objects. Since abstract classes
cannot be instantiated, Controller Tester automatically generates instantiable class code.

£ Class Factory &2 [‘ﬁ‘]| = = O
type filter text Class Code  Configuration
& CodeMemoryReportFormatter ~ | Mame: |MemoryReportFormatter |
(® ConsoleTestOutput
(® ExecFunctionTestShell Class code:
(9 |EEE7S4ExceptionsPlugin

1class Concreate_cs_create_MemoryReportFormatter_h_MemoryRe a
® MemoryReportallecator 2 public :

v (& MemoryReportFormatter Concreate_cs_create_MemoryReportFormatter_h_MemoryRep:
<» MemoryReportFormatter (2) }
(® MemoryReporterPlugin
~ (3 MockActualCall
<% MockactualCall (D)
(® MockactualCallTrace

}

3
a
3
& void report_alloc_memory(class TestResult * result, «
7
2
g void report_testgroup_end(class TestResult * result,

(® MockCFunctionComparatorMode 1‘13 )

© MDCkCFunCtIDnC_DplerNDdE 12 void report_test_end(class TestResult * result, clas:

(® MockCallorderFailure 13 - -

(& MockCheckedActualCall 14 3

® MockCheckedExpectedCall 15 wvoid repert_free_memory(class TestResult * result, cl
v (& MockExpectedCall 1? )

N4 MDCkExpECtEdcalll @ . 18 void report_test_start(class TestResult * result, cl

® MockExpectedCallsDidntHappenFailure 19 - -

(® MockExpectedCallsList 20 1

(® MockExpectedObjectDidntHappenFailure 21 void report_testgroup_start(class TestResult * result,,

® MockExpectedParameterDidntHappenFailure o < >

* On the left side of the [Class Factory view], you can see the classes included in the project and
the class code for instantiating the class in a tree structure.

* On the right side of the [Class Factory View], you can edit the class code and name in the [Class
code] tab, and see the connected tests in the [Configuration] tab.

Toolbar menu of Class Factory view

Item Description
=) save Save modification of the class code.

Expand All  Expand all class tree in Class Factory view.

=l Collapse All Collapse all class tree in Class Factory view

Icon of Class Factory view

Icon Description
® Class Class included in the project.

<> Class code Class code that create class objects to use in tests.

Context menu of class

Item Description
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&
<» Create Create a class code of the selected class.

Context menu of class code

Item Description

¥ Delete Delete selected class codes.

Create a class code

User Manual - 3.6_en

When analyze the project, a list of all class included in source codes appears in Class Factory view.
Controller Tester automatically generates class codes of abstract classes. You can also manually create

class code from the context menu of class.
r| Class Factory &3

type filter text

G ngehﬂnmnnrﬂnnnﬁﬂnrmaﬂnr
A

(® Consol <3 Create

(& ExecFunctionTestShell

(3 IFFF754FxrentinnsPlunin

Apply class code

There are three ways to apply the class code to test.

Apply in Test Editor

1. Open the test editor by double-clicking on the test that you want to apply the class code. In the
[Test Info] tab, expand the test structure, select the object to which the class code is to be applied,
and select [Use class code] in [Test Info Edit] — [Constructor] on the right.

k| MemaryReportAllocator:setForm... 52

Test Info (class_factory/MemoryReportAllocator_setFormatter_test0)

Test Structure L"f\

Test structure using a tree view and edit the information in the test.

Mame In Out (]
Test global code
User code
Global ariable
w Test target function
~ o object MemoryReportallocator : cle
@ MemoryReportallocator:Memory
~ @ MemoryReportallocator:setForm.
Local Static Variable
v Parameter/return
~ o formatter : class Memon
w © formatter_mem ;- clas
<> MemoryReportForr
Before call code
After call code
User code

=| Test Info Edit

= 0
(2L
Set to create a object and select member field ~
Constructor
Use class code v
User code

MormalMemoryReportFormatter:MormalMemoryReportFormatter()
Function for object return.

Test Info | Test Case | Test Code | Configuration
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2. Select class code in [Test Structure]. In [Test Info Edit], check the class code to be applied and

save. Select the class code to see the code.
LI MemoryReportallocator: setForrm... 32

Test Info (class_factory/MemoryReportAllocator_setFormatter_test0)

C.
o

Select the class code to use for creating class objects.

MemoryReportFormatter:
[1 MemoryReportFormatter_2

Test Structure Q g Test Info Edit
Test structure using a tree view and edit the information in the test.
Name In Out ~
Test global code
User code
Global Variable

v Test target function
~ (& object_MemeoryReportallocator @ class Men
@ MemoryReportallocator:MemoryReportt
~ (4 MemoryReportallocator:setFormatter(Mvi
Local Static Variable
v Parameter/return
~ & formatter © class MemoryReport]
~w & formatter_mem : class Mem
<> MemoryReportFormatter
Before call code
After call code
User code

~ Stub v
< >

add class code

1 class Concreate_cs_create_MemoryReportFormatter_h_I A

2 public :
3

4 1

5

6

7

g 3

Concreate_cs_create_MemoryReportFormatter_h_Mer

void report_alloc_memory(class TestResult * m

'
>

Go to Class Factory

Test Info | Test Casel Test Co-de| Configuration |

+ Select [Go to Class Factory] to open the class code in Class Factory view.
* Click [Add Class code] to add new class code.

Apply by drag-and-drop

You can apply the class code by dragging and dropping the class code to be applied from Class Factory

view to the class object in Test Editor.

- Fara s T
v (& formatter : class MemoryReportFo
MemomRepoftRnetisement): class Memon
@ MormalMemoryReportForma
re call code
er call code
User cod

zst Info | Test Ca st Code | Configuration

| Class Factory
ype filter text

v (& MemoryR Formatter
< Memo portFormatter (7)
<» MemaoryReportFormatter_2 (0]
(® MemaoryReporterPlugin

Apply using context menu in Test view

1. In Test view, select [Apply Class code] in context menu of functions or tests.

Page 141 of 322



Suresofttech

2.

> MemoryReportAl]

I N

<R

Create Test
Copy Test
Delete

Show Call Graph
Show Control Flow Graph
Show MC/DC

Host Cutput Value -= Expected Value
Test reconfiguration

Cet related file

Relevant issues setfings...

Import Test Data
Export Test Data

Add Stub...
Apply Class Code

Select Function

Deselect Function

Generate coverage report...

Ctrl+C
Delete

User Manual - 3.6_en

In [Apply Class code] dialog, select the class code to apply to selected tests and click [Ok].
Expand [Class code] at bottom to see the selected class code.
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B Apply Class Code x

Apply Class Code

Apply the class code to the selected tests.
Select the class code to create the class you want to apply.

|t§,-'pe filter text
Class Class Code(Click to select)
MemoryReportFormatter MemuoryReportFormatter

Select All || Deselect Al

Class Code

ok || cancel

* With [Apply Class code] feature, the same class code is applied wherever the class code
can be applied.

Modify class code

You can modify the class code on [Class code] tab of Class Factory view. The modified class code is
reflected in all connected tests.

Delete class code

You can delete class code in context menu of Class Factory view.
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') Class Factory Eﬂ]

|type filter text

~ (& MemoryReportFormatter A
<» MemoryReportFormatter (7)
' Memqr}rﬁﬂmr‘tmrm:ﬂlﬂr 2.m
(® MemoryRep
5 (& MockactualCall

(& MockActualCallTrace
& MackrFunctinnTnmnaratnrhlnde

! itis impossible to delete the class code while it is connected to the test. Before deleting
the class code, all connections with the test must be disconnected.
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15.9. Control Flow Graph View

The [Control Flow Graph] view shows the control flow information for the function selected in graph
format.

If you click [Show Coverage] button in the main toolbar, the covered section is displayed in blue color
and the uncovered section is displayed in red color.

I CodeScroll Controller Tester RTV(Remote Target Verifier) = Target Plugin (x64) - 0 x
| Ele it Seach poject Taget Window selp

& zlib E- Ell N, A B b Host @ Y [ ( Global Search (Ctrl+3) Qlil e |[E

New Project Mew Test Import Export Properties Preferences

'8 Tg | show Coverage =) Coverage —JMC/DC L% Stub [£] Class Factory & Control Flow Graph | =i Call Graph T3 Function Call Hierarchy ¥ Error
& &b Control Flow Graph 53 rea eEEs ve -5 -
[ zlib >> Default Module >> inflate.c >> inflateEnd

i Declaration i Root
- | IF
- IF
IF i# Declaration
i-® Staternent
i@ block_retum
Condition e eniry
ew exit
\itu Statement

< 2 E2
Toolbar menu
Menu Description
Unfold All Shows all group nodes.
=l Fold All Hide all group nodes.
| Show Legend Shows the legend(the node type in the currently displayed graph).

) Copy to System Clipboard Copies the currently displayed graph into clipboard.

5% Show Outline Displays the graphs in a tree format.

2 Show Overview Shows the overview of a graph.

‘G Link with Editor Shows the selected items in the graph in the editor by one-click.
(2] Export View Content Exports the contents of view in a report.

= Print View Content Prints the contents of view.
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Pull-down menu

Menu Description

Unfold All Shows all group nodes.

=l Fold All Hides all group nodes.

Show Call Graph Shows the function call graph for the function selected in the current view.
= Show Legend Shows the legend(the node type in the currently displayed graph).

o= Show Outline Displays the graphs in a tree format.

2 Show Overview Shows the overview of a graph.

S Link with Editor Shows the selected items in the graph in the editor by one-click.

e Export View Content Exports the contents of view in a report.

Creates the graph model file for the graph displayed on the current screen.
Four kinds of formats supported:

* Graph Modeling Language XML (*.xgml)

* Graph Modeling Language(*.gml)

* yWorks Binary Graph Format(.ygf)

* Trivial Graph Format(*.tgf)

Save as Graph Format

Save as Image Format Saves the currently displayed graph as an image format file(jpg, gif).
) Copy to System Clipboard Copies the currently displayed graph into clipboard.

Preferences Opens the preferences.

Node Pop-up menu

Menu Description

Show Call Graph Shows the function call graph for the function selected in the current view.

History function

The node that had been selected in the current graph can be seen again by using the arrow button(Go
back, Go forward) in the lower-left corner of the view.

[ 4 plm:- A

Zoom out/in function

You can change the zoom out/in ratio by entering a number at the bottom of the view or by adjusting the
slider.

'1"911?1: . -[-—“::'
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You can reset the zoom out/in ratio by using *: [Initialize zoom out/in ratio] button at the lower right
corner of the view, and change the zoom out/in ratio accordingly to the view size by using (3] [Fit to view
size] button.
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15.10. Call Graph View
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The [Call Graph] view shows the function call information for the selected function in a report format.
(Ex: When calling function ‘B’ from function ‘A’, it is expressed ‘edge from node ‘A’ to node ‘B’, and it is

represented as one edge even if called multiple times.
If you select the node (function), it shows the function call information for that node.

[ codescroll Controller Tester RTV(Remote Target Verifier) + Target Plugin (x64)
‘EME Edit Search Project Target Window Help

B zlib 5 B N2 T a@

Y [ ( Global Search (Ctrl+3)

Q)i ==

New Project Mew Test Import Export Properties Preferences

a x

‘e T ‘ Show Coverage =] Coverage —{ MC/DC &7 Stub [¢] Class Factory 4 Control Flow Graph | =% Call Graph

& | oo call Graph 52
[ zlib >> Default Module >> inflate.c >> inflate

T2 Function Call Hierarchy ¥ Error

2B kwe v =5

- Found 3 matces

\/
\/

0
vl

inflate_fast

Root
e adlers?
i@ crel?
e crebig
e oo litle
- @ fivedtables
@ geread
[l inilate
@ inflate_fast
@ inflate_table
i@ uncompress
- ® updatewindow

fixedtahles

updatewindeow

cre32

adler32

cre32_little

inflate_table

ereaz_nig
v

< >

l 98Mof 1141M |}

Toolbar menu

Menu Description

% Edit Layout
ft =ayou edited when the graph is updated).
) Copy to System

) Copies the currently displayed graph into clipboard.
Clipboard

5= Show Outline Displays the graphs in a tree format.

) Show Overview  Shows the overview of a graph.

G Link with Editor Shows the selected items in the graph in the editor by one-click.

() Export View

Exports the contents of view in a report.
Content

= Print View

Prints the contents of view.
Content

Changes to make the node position of graph modifiable(it cannot be automatically
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Pull-down menu

Menu Description

Show CFG Shows the control flow graph for the function selected in the current view.
o= Show Outline Displays the graphs in a tree format.

<) Show Overview Shows the overview of a graph.

‘S Link with Editor Shows the selected items in the graph in the editor by one-click.

Creates the graph model file for the graph displayed in the current screen.
Four kinds of formats supported:

* Graph Modeling Language XML (*.xgml)

* Graph Modeling Language(*.gml)

* yWorks Binary Graph Format(.ygf)

e Trivial Graph Format(*.tgf)

Save as Graph Format

Save as Image Format Saves the currently displayed graph as an image format file(jpg, gif).
2 Copy to System Clipboard Copies the currently displayed graph into clipboard.

Preferences Opens the preferences.

Node Pop-up menu

Menu Description

Show CFG Shows the control flow graph for the function node selected.

Expand Shows the call relationship after the selected function one more step.
Collapse Hides the call relationship after the selected function.

Set to Start Node Specifies the start function for checking the call path for two functions.

Specifies the end function for checking the call path for two functions.

Set to End Node
Shows all paths possible in the current graph.

Search function

When you enter a search word in the top of the view, the functions with the name containing the entered
search word are highlighted.
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History function

The node that had been selected in the current graph can be seen again by using the arrow button(Go
back, Go forward) in the lower-left corner of the view.

- aw
m = ' _ -
L 4L 4

Zoom out/in function

You can change the zoom out/in ratio by entering a number at the bottom of the view or by adjusting the
slider.

o[l = == | & &

You can reset the zoom out/in ratio by using “ [Initialize zoom out/in ratio] button at the lower right
corner of the view, and change the zoom out/in ratio accordingly to the view size by using le3) [Fit to view
size] button.

Show/Hide function

By using the menu displayed when right-clicking a node, you can show or hide the edge out from that
node. If you select [Hide], it hides the call relationship for all functions called by the function
corresponding to the selected node. The Hide menu of the node having no function call information is
disabled. If you select [Show], it shows the functions called by the function corresponding to the selected
node one more step. Likewise, if there are no call relationships, the Show menu is disabled.

Highlight Path between Nodes function

By selecting the start node and end node, it highlights all paths exited between two nodes so that you
can see easily the interesting section in the complex function call relationship.
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15.11. Error View

You can check the analysis error information of the project in detail.

B Emor &2 = "
Errors in the zlib project.
Type filter text | & Open log in editor :
Message Lo IEkaﬂ Error ccl.exe: warning: command line option A
9 g '" '-fpermissive' is walid for C++/0bjC++
@'Valuel underlarad ifirct 1ica in - rarfanrace 2 Tact but not for C

‘& GO to error location
In file included from
P:YWProduct_Workspacehct_3_1 82%\zlib\.csda
tahsrc\build\compress_2.c:7:8:

£ Show error details...

cs_test¥compress_testB8¥User code start:
In function 'compress_test®':

cs_test¥compress_test@XUser code
start:1:1: error: 'wvalue' undeclared
{(first use in this function)

cs_test¥compress test@XUser code
start:1:1: note: each undeclared
identifier is reported only once for each

functicn it appears in W
Log type
Type Description
Build Errors occurred during build

L Statement analysis Errors occurred during statement analysis
= Link Errors occurred during linking

FE® Pre-processing Errors occurred during pre-processing

Error type

Type Description
Source Errors occurred int the source file
Stub Errors occurred in the stub file

Test Errors occurred in the test editor

Go to the error location

In the context menu, select [Go to error location] to go to the location where the error has occurred so as
to correct the error easily.
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Show error details

Double-click the error information or select [Show error details

information for the error.

B Error details - O x
¢ Log: aup Build
. Error. Test
Log location: | P-#Product_Workspacewct_3_1_02%zlibw.csdatawlogwbui |
Message: ‘walug' undeclared (first use in this functicn) ir
& |4
" Resolution:

A compile error has been occurred in the test code.

The test code is included in the file which the function under test has been definedit
To check if the types, variables or functions used in the test code can be used or not
1. Please correct the compile error by checking the error message.

2. Ifitis difficult to correct it, please contact support@suresofttech.com by attach

€ >

* Product information

Product version: 3.0.2.202002210735 ~
Product installation: C:#Program FilesstCodeScroll Controller Tester 3.2
Toolchain: GCC 5.3 (32bit)

Java version: 1.8.0_202-b028

0S: Windows 10-amde4-64

Buttons

Button Description

' Previous Shows the previous error information.

b Next Shows the next error information.

5= Copy Copies the error information.

‘& Go to Error Points to the location of the error.

User Manual - 3.6_en

...] in the context menu to check the detail
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15.12. Debug Information View

The debug information view shows information to help you determine the cause of an error in a test
case.

» Trace function calls in test cases with errors
» Actual value of variable/expression added to inspect debug information

If you select a test case that has [Inspect Debug Info] in the unit test view, debug information is
displayed in the Debug Information view.

% Debug Information &2 @ = 8
Test Case (test/func_test0) #1

Stack trace: List of variable/expressicn:
v o [Project: test] test run Variable/Expression Value Location

— i i &
= func3(signed int ¥) at test1.c42 o (test ¢ 40) 19310813 before line
= func2() at test1.c:30

= func(signed int) at test1.c12

» The Stack trace shows the function call trace when the test case in error was executed. The
location where the error occurred is displayed at the top.
* The variable/expression list shows the actual value of the variable/expression added to inspect the

debug information.

If the actual value of the added variable/expression is not displayed:

- When [Inspect Debug Info] of the test case is not executed after adding a new variable/
expression

- When the line where the variable/expression was added was not executed when the
test case was executed (it was not executed depending on the condition or an error
occurred before execution)

o =

Debug Information View toolbar menu

icon description

™= |ist of variable/expression to debug

In the list of debug variable/expression, you can check and remove variable/expression.
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B Lict of variable/expression o @] =]
List of variable/expression

This is a list of variable/expression added to inspect debug info.

Unnecessary variable/expression can be removed using [Remove], [Remaove All.

Variable/Expression Type Location Remove

a (testl.c: func3) line:dd Integer before line

a (testl.c: func3] line:da Integer after line Hemone 04l

b (testl.c : func?) line:27 Integer before line

p (testl.c: func3) line:d0 Integer before line

[ OK ] [ Cancel

Adding variable/expression to debug
You can add variable/expression to debug in the following ways.

1. Double-click the line area in the source code editor

User Manual - 3.6_en

2. Select [Add Variable/expression to debug...] from the line area context menu in the source code

editor

3. After specifying a variable or expression in the source code editor, select [Add Variable/expression

to debug...] from the context menu.

When the above operation is performed, the [Add variable/expression to debug] window appears.
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P

n Add variable/expression to debug

Add variable/expression to debug

2 You can add variable/expression only to the shaded area. (0: before line, O: after ling)

84 int test()

85 {

86 int a, b;

a7 a = func(®);
a8 b = fune(l);
89

90 if (a < b) {
91 return g(@);
92

a3

4 g(1);

95 a=a+b;
96

a7 while{a<@) {
98 a--;

99 }

100

101 return 8;
102

103

Fl

# Entering an invalid variable/expression can cause compilation errors or runtime errors.

Variable/Expression:
Type: () Integer (0) Unsigned Integer (©) Double (0) String

When you select a test case, you can inspect the debug info at once,

You can double-click on the line area to add or remove variables/expressions to debug at that location.

oK

o eE]

Cancel
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You can double-click on the line area to add or remove variable/expression to debug at that location.

marker description
Variable/expression added before the line

(i Variable/expression added after the line

You can add markers only in the shaded area.

84 int test()

&6 int a, b;
87 a = func(@);

88 b = func(l);

89

a0 if (a < b) {
a1 return g(@);

92 T

93

o4 g(1);
a5 a=a+ b;

97 while(a<@) {
s 08 a--;

® )

101 return 8;

103

If you can add a variable/expression to debug both before and after the line in the shaded area, a dialog

will pop up asking where to add it.
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P

- Add variable/expression location to debug EI

Please select a variable/expression location to add.

befare line
[T after line

| SelectAll || DeselectAll |

| ok || canca |

You can add or remove variables/expressions anywhere you can add to the target function through the
[Add All], [Remove All] buttons at the top of the source viewer.

After specifying the variable/expression and type and clicking the [OK] button, you can see that the
marker has been added to the source code editor.

[g] testl.c &2 = B
-m
—int test()
int a, b;
a = func(e);
b = func(l); =
if (a < b) {
return g(8); =
} a
gl1);
a=a+ b;
while(a<@) {
a--; 1
} E
=3
return @; E
} [
1 b

If the test case is selected in [Unit Test View], you can immediately perform [Inspect Debug Info] while
adding a variable/expression to be debug.

#: Entering an invalid variable/expression can cause compilation errors or runtime errors,

Variable/Expression:  val

Type: @ Integer () Unsigned Integer () Double () String

IInspect debug info: func(signed int)_0 #5 I

[ ok [ cancel

! If you enter an invalid variable/expression, a compilation error or a runtime error may
occur when performing [Inspect Debug Info].
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15.13. Fault Injection View

The Fault Injection View provides the feature for inserting the code needed to test additionally into the
specific area of the function to be tested.

1. Drag and drop the function that you want to inject a fault from the Test Navigator View or the Unit
Test View to the Fault Injection View.

CodeScroll Controller Tester RTV(Remote Target Verfier) + Target Plugin  (x64) - o x
File Edit Search Project Window Help
5 & Y e
=5 sample_code =) Cigr T I | o Host @ X [ [ lobal Search (Ctr+3) Q)=
New Project New Test Import Export Properties Preferences i ——
| /&2 Show Coverage || [+ Coverage -~ MC/DC i Stub ¢ Class Factory < Control Flow Graph 20 Call Graph 2] Requirement =23 Fault Injection
P Test Navigator B v=0O =0 Unit Test Integration Test B k- ~¥=0
<
> T faulfTest J v Statement Coverage|
+ (7 Default Module (82 70/ 20) 102 68.3%
v @ fault injection t =
(119/174)
v G study_sample @ ——
© G study_sample type file, function, test, state, issue
v 2 study_sample Name Result Coverage
v L study_sample.c > @ OutOfIndex_error(sizned int 3/0/2)5 100.0% (22
& abe > @ abe(signed int 0/0/55
sbc_1 > abe_1 (5/0/0)5
api > @ apil 12/0/0)12
lapi2 > api2(e ©9/0/0)9
charlesFune > @ charlesF 7/0/0)7
exit_error2 > B exit_error2i=i 0/0/0)0
fibonacci fail > @ Fibonacei_fail 3/0/3)6
> @ helper(signed 5/0/0)5
=3 Fault Injection 7 Bl@MEld =8 ;@ helperE 5/0/05
Inserts code before or after lected line. > @ loadFile(st 0/0/11
ype filer text Inserted Before: > @ main 3/0/6)9
1 > @ medel signed int 11/0/0)1
> @ (0) charlesFunc(signed int) > @ pTest(si t 5/0/05
> @ (0) exit_emer2(signed int) > stubFunc@(s d int 8/0/0)8
> @ (2) fibonacci fai(signed int) > @ stubFuncl 170701
> @ (0) helpertsigned in) > @ testMel2 0/0/1)1
> testMe3(signed int (5/0/05
> @ timeOutFunc 0/0/1)1
Inserted After > @ timeout 0/0/1)1
1
® testMe(signed int) ‘m of 784M |

2. In the tree structure on the left of the view, click the line that you want to inject a fault and, on the
right of the view, enter the user code to insert before/after the line. The number of the line where
user code is written is underlined.

== Fault Injection 52 El@Ela Y= O
Inserts code before or after the selected line.
type filter text Inserted Before:
[ 278: } ~ 1 count = 8;
279:
[ 280: return fibonacci_fail(index - 1) +

~ @ (0) helper(signed int)
[ 288: FILE* fp = fopen("D:\\read.txt", "r
[ 267: return fp;

v @ (1) loadFilestruct _jobuf %
[ 253: char data[1@24]; r
[ 254: int count; Inserted After:
[7] 255: count = fread(data, sizeof(char), 1
[v] 258: if{count != @){

1/*% test */

[7] 257: printf("FILE : ¥s", data);

[] 258: return @;

[]259: 1}

[ 26@: else {

[ 261: return -1; v
£ >

* When check checkboxes of lines to insert, the user codes are applied. In the source code
editor, 2 (before the line), & (after the line) markers appear at that lines. When mouse is on
the markers, the tooltip about fault injection information and written code appears.
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251
252 = int loadFile(FILE* fp){
253 char data[1824];
254 int count;
@255 count = fread(data, sizeof(char),
el if(count != @)
—==7 printf{"FILE : ¥s", data);
4[Fault Injection] return @;
& dinserted Before:j
dcount = O; else {
261 return -1;
262 1
263 }

! Single-line comments (//) and input/output user macros cannot be used.

Toolbar menu in the Fault Injection view

Toolbar icon Description
Expand All Expand all function trees in Fault Injection view.
=I Collapse Al Collapse all function trees in Fault Injection view.

{2} Show Only Non-empty Fault View only the line where the fault injection code is written among the
Injections fault injection lines.

Show Only Enable Fault

o View only active lines among fault injection lines.
Injections

(X Export Fault Injections Export fault injections information with .xls format.

Context menu in the Fault Injection view

Function nodes and lines can be multi-selected to bring up the context menu.

Context menu of function nodes

3 Remove Delete

Menu Description

# Remove Remove the function inserted by users.
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Context menu of lines

Copy Ctrl+C
Paste Ctrl+V

Clean

5

| Enable
[1 Disable

Menu Description

55 Copy  Copy the information inserted by user before/after the line.

[ Paste  Paste the information inserted by user before/after the line.

£ Clean  Uncheck the checkboxes of the selected lines and remove inserted code.
“ Enable Check the checkboxes of the selected lines and activate fault injection.

] Disable Uncheck the checkboxes of the selected lines and deactivate fault injection.

Pull-down menu

Menu Description

& Reconfiguring Fault Injection Note the Reconfiguring Fault Injection

When modifying the source code, contents of the fault injection may not be properly
reflected. In case of modification, contents of the fault injection must be rewritten.
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15.14. Input/output Data Graph View

The Controller Tester provides the data for input value/expected value/output value in graph format.

The horizontal axis of the graph indicates the number of the test case and the vertical axis indicates the
data of the test case.

A4 Input/Output Data Graph 23 sy T = B8
_fr_align_testl
2,000,000,000 £,000,000,000 A
1,500,000,000 1.500.000.000
1,000,000,000 1.000.000.000
500,000,000 500,000,000
0 0
-500, 000,000 -500,000.,000
-1,000,000,0004 -1.000,000,000
-1,500,000,000 -1.500.000.000
-2,000,000,000 -2,000,000.000
1 2 3 4 5 6 7 8 9 i 11 12 13
Test Case
— s_mem[0].last_eob_len —s_mem[0]. bi_valid s_mem[0]. bi_buf | -
<

Toolbar icon in Input/output Data Graph view

Toolbar icon Description
£49 Refresh Refreshes the input/output data.

5 Save graph Saves the input/output data.

Click [Save graph] to display the notification window that can enter the path for saving the graph. Enter
the path to save, the file name and the file format and click [OK] to save the graph.

/B save graph P

Path: | Ltreportwimagejpg | [search..{

oK Cancel

Graph settings

Select [Select input/output item] in the pull-down menu (V) to display the Graph settings window.
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» For the items selected in the checkbox, the [Input], [Output value] and [Expected value] are
displayed in the Input/output Data Graph. However, if the expected values are specified as ~, &, |
and ! etc., the expected value is not applied to the Input/output Data Graph view.

* [Number of test cases showed in a view] allows you to specify the number of test cases to be

displayed on one screen.

! W7 select input/output item X
1| Input Expect.. Output
1 int s_mem[0].last_sob_len s_mem[0].last_ecb_len (]
! unsigned short s_mem([0].bi_ i 5_mem[0].bi_buf L]
[ int s_mem(0] bi_valid s_mem([0].bi_valid O
1
|
. Number of test cases showed in a view:
Confirm Cancel
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15.15. Console View

Enter the instruction or batch file in [Pre-command for test run] and [Post-command for test run] of
[Project] -> [Properties] -> [Test] -> [External Command] and execute the unit test to display the
execution result for the external instructions before and after the test execution in the [Console] view.

Toolbar icon in the [Console] view

Toolbar icon Description
E# Clear Console Clears the console contents.
&B Scroll Lock Locks the scrolling of the [Console] view screen.

= Display Selected Console Shows the selected console.

If [Display Selected Console] is selected, the following two menus are displayed: [Pre-command for test
run] and [Post-command for test run].

B~= 08
_'® 1 Pre-command for test run
2 Post-command for test run
3 Target Log Collector command
4 Target test command

If you select [Pre-command for test run], the execution result for the external command before running
the test is displayed in the Console view.

El consale &2 5 BH _e| B~-= g
Fre-command for fest run

P:\Eclipse\eclipse-rcp-2019-89-R-win32-x86_64\eclipse>cd P:\Example_Projecth\c\dipizlib-1

P:\Example_Project\c\dip‘zlib-1.2.3>make clean all
rm -f *.o0 *~ example minigzip \
libz.* foo.gz so_locations
_match.s maketree contrib/infbackd/*.o
cc -0 -c -o example.o example.c
make: cc: Command not found
make: *** [<builtin»>: example.o] Error 127

If you select [Post-command for test run], the execution result for the external instructions after the test
execution is displayed in the Console view.
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El Consale &3

Post-command for test run

L'i"'
&l
o
I
1

P:\Eclipse\eclipse-rcp-2819-89-R-win32-x86_64\eclipsermake clean all
make: *** No rule to make target 'clean'. Stop.

P:\Eclipse\eclipse-rcp-2819-89-R-win32-x86_64\eclipsercd P:\Example Project\ch\dip\zlib-1

P:\Example Projectic\dipi\zlib-1.2.3:make clean all
rm -f *.o0 *~ example minigzip \
libz.* foo.gz so_locations
_match.s maketree contrib/infbackd/*.o
cc -0  -c -o example.o example.c
| make: cc: Command not found
make: *** [<builtin>: example.o] Error 127
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15.16. Requirement View

You can import requirements from a requirements management tool or a CSV file into Controller Tester.
You can connect imported requirements with tests and export the connected information.

[Z Reguirernent 3 £|E|E|E\;ﬂﬁ ¥ =08
type filter text
FR171 "Number of tablessss"
<7 FR12 "Mumber of seats per table”
[ FR13 "List of entrees”
<’ FR14 "Placing an order updates cccupied status”
FR15 "Placing an order updates number in party”
<°| FR1& "Placing an order updates a seat's order”
<°| FR17 "Placing an order updates check total”
<°| FR18 "Clearing a table resets occupied status"
FR19 "Clearing a table resets number in party”
<7 FR20 "Clearing 2 table resets orders for all seats”
<7 FR27 "Clearing 2 table resets check total”
-”| FR22 "Obtaining check total"
<7 FR23 "Size of waiting list"
<’ FR24 "Adding a party to waiting list"
<’ FR25 "Getting the head of the waiting list"
°| FR27 "Adding free dessert”

Requirement status

Status Description
B Not connected A requirement without connected tests
B Connected A requirement with connected tests

'/ Needs Review A requirement that need to be reviewed

Toolbar Menu in Requirement View

Icon Description

0@ Connect requirements
g Open the [Connect requirements and tests] dialog box.

and tests
Expand All Expand all requirements
=l Collapse Al Collapse all requirements

! Hide unconnected

) Hide unconnected requirements.
requirements

Importing requirements created with a CSV file or a requirements

&3 Import
management tool.

Export requirements to a requirements test coverage report or requirements

&3 Export
management tool.
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* For more information, please refer to the pages Export, Import.

pull-down menu (V) in Requirement View

Icon Description

= . . Exporting connection information between requirements and
‘= Export requirements traceability (csv)...

tests.
=) Export requirements traceability Export connection information between requirements and
[Including all test cases] (csv)... tests, including all test cases.

s ) . Importing connection information between requirements and
=} Import requirements traceability

tests.
Export Requirements Traceability Export connection information between requirements and
Information for V-SPICE tests in V-SPICE’s xml file format.

Connect tests and requirements

Requirements can be connect to test/test case/integration test.

+ Drag a requirement from the Requirements View and drop it on the target you want to connect to
in the Test View.

> @ zcfree(void #, voic 1/0/0)1 100.0% 22

> zcalloc d = 3/0/0)3 100.0% (22

> @ zError(signed int (3/0/0)5 100.0% (11

> updatewindow 0/0/3)3 13.3% 1120

> @ uncompress2(u 3/0/0)3 94.4% =400
> uncompress(uns 0/0)3 100.0% (11

> @ tr_static_init /0/0)9 N/A

3 synesearch(unsigre’ FR1G6 "Placing.an order updates a s /0/0)10 100.0% (13/13
> slide_hash(structiriflh = Plasing.anorder updates c /0/2)3 100.0% (12/12
v M eand trasictooct 1t =t~ strnct o+ 4/0/7 AA noL ner

(=] Requiremnent 2% o%|E||E|u\ﬂnﬁ = =8
type filter text
> FR11 "Mumber of tablessss"
<7 FR12 "Mumber of seats per table|
> [ FR13 "List of entrees”
<” FR14 "Placing an order updates occupied status”
» FR15 "Placing an order updates number in party”
< FR16 "Placing an order updates a seat's order”
< FR17 "Placing an order updates check total"
<’ FR18 "Clearing a table resets occupied status”
» [ FR19 "Clearing a table resets number in party”

* Drag an item from the test view and drop it on the target you want to connect to in the
Requirements View.
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Name

> > zlibVersion
> zlibCompileFlags
zcfree(: \

zcalloc(:
zError
updatewindow =
uncompress2(u
uncompressiur
tr_static_init
syncsearch(u
slide_hash
s M cend treals

Requirernent 57

type filter text

> [ FR11T "Number of
<" FR12 "Number of seats per table”

> [E@ FRI3 "List of entress”
<’ FR14 "Placing an order updates occupied s

> [@ FR15 "Placing an crder updates number in p
< FR1E "Placing an order updates a seat's order”
<’ FR17 "Placing an order updates check total”
<’ FR12 "Clearing a table resets occupied status”

> [@ FR19 "Clearing a table resets number in party”
<7 FR20 "Clearing 3 table resets orders for all seats"

>
»
>
>
b
>
>
>
>

oooacac[a

Result Coverage
/0/0)1 100.0%
40.4%
100.0%
100.0%
100.0%
13.3% o0
94.4% -
100.0% (1/1
@/0/0) N/A
(10 /0 0 100.0% (13
(1/0/2)3 100.0% (13
4/0/T AA NOL

B HE R md -

= 0

» Connecting via the Connect requirements and tests dialog

1. Select [Connect requirements and tests] from the toolbar menu.
0¥ |med = 0

Reguirernent &3
type filter text
» [E@ FR11 "Mumber of tablessss”

27 FR1Z2 "Mumber of seats per table”

» [ FR13 "List of entrees”

| Cennect requirements and tests L

27 FR14 "Placing an crder updates cccupied status”
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2. You can connect requirements and tests through the [Connect requirements and tests]

dialog.

onnect requirements and tests

Select the tests to connect with each requirement.

Find and select a test from the list on the right to connect with the requirement you selected in the list on the left
(3 If 3 function name is included in the title or content of the requirement, it is automatically connected.)

~ [FR11] "Number of tablessss® # (2) TC6 | TCZ
[FR12] “Number of seats per table”
[FR13] "List of entrees”
[FR14] "Placing an order updates occupied status’

[FR16] "Placing an order updates a seat's order’
[FR17] "Placing an order updates check total”
[FR18] "Clearing 2 table resets occupied status”
[FR19] "Clearing 2 table resets number in party”
[FR20] "Clearing a table resets orders for l seats”
[FR21] "Clearing a table resets check total”
[FR22] "Obtaining check total"

[FR23] "Size of waiting list"

[FR24] "Adding 2 party to waiting list

[FR25] "Getting the head of the waiting list"
[FR27] "Adding free dessert”

~ [FR15] "Plaing an order updates number in party” = _tr_flush_blockistruct int

l000o00DO0DOO00oOooo0oooooooooooooooooon

Test

_tr_aligntstruct intemal state %0

_tr_flush_bits(struct intemal_state %0

_tr_flush_blockistruct intemal_state ¥, char #, unsigned long, signed int.0
_tr_init(struct intemal_state *)_0

_tr_stored_blockistruct internal_state *, char *, unsigned long, signed int.t
_tr_tally(struct intemal_state *, unsigned int, unsigned int_0

8

adler32(unsigned long, const unsigned char *, unsigned int_0
cie

adler32_combine(unsigned long, unsigned long, signed long) 0
ce

adler32_combines4(unsigned long, unsigned long, signed long) 0
™

adler32_combine_(unsigned long, unsigned long signed long)_0
™z

adler32_z(unsigned long, const unsigned char *, unsigned int_0
bi_flush(struct internal_state #)_0

bi_reverse(unsigned int, signed int)_0

bi_windup(struct intemal state #)_.0

build_bl_tree(struct intemal_state #)_0

build_tree(struct internal_state *, struct tree_desc_s ¥).0

Tcis
compress_block(struct internal_state *, const struct ct_data_§ *, const struc
Tc24
Tc21

Function
_ir align0
_tr_flush_bits()
_tr_flush_block)
_trinitg
_tr_stored_block)
_wtallyo

adler320

adler320
adler32_combine)
adler32_combine)
adler32_combine64(
adler32_combine640
adler32_combine 0
adler32_combine 0
adler32_z0
adlerz2 z0
bi_flushy
bi_reverseQ

bi windup()
build_bl_treen
build_tree)
compress(
compressz()
compressgound()
compress_block)
crea20

cre32 big)
cre32_combine(
cre32_combines4(
cre32_combine_()
erea2 ittle)

rrr22 0

oK Cancel

Disconnect requirements and tests

You can disconnect requirements and tests from the context menu in the Requirements View.

Requirement &2

type filter text
> R FR11 "Mumhar nf tahlaccec”

2~ FR12 | % Delete
’ R EEJ Mark as reviewed...
5 R ER1 Disconnect requirements and tests...

Delete

R|EED| W |med 7= 8

7| FR1
<? FR17
<° FR1

"Placing an order updates a seat's order”
"Placing an order updates check total”

"Clearing a table resets cccupied status”
"Clearing a table resets number in party”
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Review of tests connected to requirements

1. When a requirement is re-imported, it will be marked as [Needs Review] if the title or description
has changed.

[£ Requirernent 53 R EE|W|md Y= O

type filter text
w V| FR11 "Number of tablessss" (Needs Review) ~
@ Success: 1
@ Error: 1
<’/ FR12 "Mumber of seats per table"
B8 FR13 "List of entrees”
<’/ FR14 "Placing an order updates cccupied status”
[E& FR15 "Placing an order updates number in party”
<’/ FR16 "Placing an order updates a seat's order”
<7 FR17 "Placing an order updates check total”
<’/ FR18 "Clearing a table resets occupied status”
B8 FR1% "Clearing a table resets number in party”

2. After reviewing the requirements and connected tests that need to be reviewed, you can mark
them as reviewed with the context menu.

[£ Requirernent &2 R EE|®|med Y= 1O

type filter text
W 1 FR‘ 1 "Nanhnr nf #ahlarcee
® Succer # Delete
@ Error:
< FR12 "N
B FrR13 "Lis
<’/ FR14 "Placing an order updates occupied status”
[E& FR15 "Placing an order updates number in party”
<’/ FR1& "Placing an order updates a seat's order”
.7 FR17 "Placing an order updates check total"
<’/ FR18 "Clearing a table resets cccupied status”
& FR19 "Clearing a table resets number in party”

hlande Do o A

Delete

Mark as reviewed...

Disconnect requirements and tests...

Export requirements traceability

You can export the connection information between requirements and tests to a CSV file.

User Manual - 3.6_en

[Z] Requirernent 52

type filter text

<7 SWDD-002 TransferOverVeltag [
° SWDD-003 MeasureChbjectiveV _

v @ =

@ Error: 1
SWDD-005 CheckMotorState2:

SWDD-004 CheckMotorState | =L

R EE|R|med ¥ = O
Export requirements traceability (csv)...
Export requirements traceability [including all test cases] (csv)...

Impert requirements traceability (csv)...

Export Requirement Traceability Information for V-SPICE...

S And checlhdntarCEabaa 2

Export requirements traceability [Including all test case]

You can export the connection information between requirements and tests to a CSV file, including all

test cases.

[£] Requirement 23

7 SWDD-003 MeasureObjectiveV _
v B

@ Error: 1
SWDD-005 CheckMotorState22

type filter text =]
°| SWDD-002 TransferOverVoltag

SWDD-004 CheckMotorState | =

BB E 8w ¥~ O
Export requirements traceability (csv)...
Export requirements traceability [including all test cases] (csv)...

Impert requirements traceability (csv)...

Export Requirement Traceability Information for V-SPICE..

SWDD-006 CheckMotorState23
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Import requirements traceability

After entering traceability information in the CSV file created by [Export requirements traceability], you
can import it through the [Import requirements traceability] menu.

[ Requirement 23 R|EES|md Y= O
type filter text [E  Export requirements traceability (csv)...
7 SWDD-002 TransferOverVoltag [  Export requirements traceability [including all test cases] (csv)...
<’ SWDD-003 MeasureCbjectiveV = =
~ [ swDD-004 CheckMatorState Import requirements traceability (csv)...
@ Error: 1
<7 SWDD-005 CheckMotorState22

Export Requirement Traceability Information for V-SPICE...

* Requirements traceability file description

Row Description
Test: 0

TEST_TYPE Integration Test: 1
Test Case: 2

Integration Test: Name

TEST_NAME .
- Test or Test case: a unique name for the test

Test case: number

TESTCASE NO
- Non Test case: 0

REQ_KEY The key of the requirement to be connected or connected to the test

Integration Test: Name
TEST_ID Test: The name displayed in the test view
Test case: The name displayed next to the number in the test view

* The unique name of the test can be found by selecting ‘Show as Unique Test Name’
from the toolbar menu of the test view or by searching.

Export requirement traceability information for V-SPICE

Connection information between requirements and tests can be exported to an xml file conforming to the
V-SPICE format.

[£] Requiremnent 2 R EE|Q|ms ¥ = O
type filter text [E  Export requirements traceability (csv)...

<7 SWDD-002 TransferOvervoltag: [  Export requirements traceability [including all test cases] (csv)...

7 SWDD-003 MeasureObjectivey’ _
- SWDD-004 CheckMotorState | =, Import requirements traceability (csv)

@ Error: 1
°| SWDD-005 CheckMotorState2:
.°| SWDD-006 CheckMotorState23

Export Requirement Traceability Information for V-SPICE...

Open in Requirements Management Tool

Requirements imported from the requirements management tool or tests exported to the requirements
management tool can be viewed in the requirements management tool through the [Open with Browser]
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context menu.

o B T L T T e L L L I e g e

- E TEST-151 US?....MM.....“LM_A.:H_-L.LM.&..- —_—
w [ Mot Exect
%] ExecFl 3¢ Delete Delete
<?| TEST-152
7] TEST-156 Mark as reviewed...

¢?| TEST-157 Disconnact requirements and tests...
25| TEST-15Q S
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16. Analysis Perspective
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The Analysis Perspective provides a Ul for analysis information that can be confirmed from the test
results.

The components that make up the analysis perspective are:

Metrics View

Metrics Chart View

Metrics Top Chart View
Metrics Bar Chart View
Metrics Diagnosis Chart View

Unused Function View
Source-Header Relation View
Global Variable Relation View

Function Call Hierarchy View
Source Code Editor section

Views that are not included by default can be opened from [Window]> [Show View]> [Other...] on the top

menu.
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16.1. Metrics View

The Metrics view shows the result that measures the metric for the project. It shows the summary
information for the overall metric and the metric information for each items included in the project
(module, file, class, function).

[l Metrics 53 "nﬁ@ ¥ =7

el

Metrics of ‘zlib_merged' project

~ Project Summary

Total Files 40 (13/27)
Analyzed Files 23 (1310)
Number of Functions 113

Line of Code 7018
Comments Ratio 52 %

~ File Metric

Metric: [ploc ~|[o <] ~ (100000 H X | §

File name pLOC LoC FICRO »

Compress.c 80 lines 46 lines 50 %

B zlibh 1358 lines. 192 lines 580 %

zeenfh 333 lines 252 lines 27% &
23 of 23 rows ||== | == | = 1 of 1 page = [== (== Goto |1 | page

Icon Description
) Module (a logical portion that divides the project for each function)

File (Source file and header file belonging to the project)

®  Class

@  Function

Toolbar menu

Menu Description
Show Diagnosis Displays a diagnostic image of the value in the left of the metric value.
LE"Zl Change Mode Changes the view mode (---:----I module, file, ® class, @ function).

(24 Export View Content Exports the contents of view as a report.

=) Print View Content Prints the contents of view.

Pull-down menu

Menu Description
Sort b Sorts based on the selected item (even if clicking the column name in the table, it is
0
y sorted equally).
Columns Changes the order and width of the columns (allows you to change the order by dragging
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and dropping the table’s column name).

Configure
diagnosis

Set to Hide/
Show metric

Sets whether to hide or show the metrics.

Metric View
Option

Sets the number of lines per page in the Metric view.

Filtering

o Metrics 52
Metrics of 'zlib_merged' project

User Manual - 3.6_en

Opens the diagnostics preferences page (allows you to set the diagnostic step and the
ranges or images for each metric).

+ Project Summary

~ Function Metric

Metric: |FUNST ~ | (20 = ~ | 100000 H |13

&  Filter matched 42 of 114 items

Function name FUNST FUCYC
@ gz_open 3 61 & 17
@ destroy 23 & 13
@ gzread 'y B2 <« 20
@ check_header 9 39 & 16
@ gzwrite 3 20 o6
@ gzseek 3 54 @ 23
@ do_flush 5 22 o 8
@ main 13 35 w 14
<

42 of 42 rows | |<< | | << < 1 of 1 page > > |53 Goto |1 = | page

The filtering allows you to view only those items within the desired range for the specific metric.

Select a metric, enter the range value and click [Filtering] button in the right section to see those values
corresponding to the entered information.
If you want to return to the status before filtering, click [Initialize the Filtering Criteria] button on the right

side of [Filtering] button.

Paging

i Metrics 52
Metrics of "zlib_merged' project

» Project Summary

~ Function Metric

Metric: [FUNST ~| |0 2| ~ (100000 H |3

Function name

@ bi_windup

@ adler32

@ adler32_combine
@ comprass2

@ compressBound
@ compress

@ uncempress

@ gzdopen

FUCYC

ER 3 < = A < < ot ¢

100 of 114 rows [[<<| | << < 1 of 2 page

The Paging allows you to view many items conveniently.

> [[>>|[>>]|Goto |1 3| page | =&
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16.2. Metrics Chart View

The Metrics Chart shows the metric view in a line chart. The x-axis is each item, and the y-axis is the
metric value of the item. You can compare the distribution of values between different metrics each other

in the project.

EL Metrics Bar Chart §[) Metrics Top Chart [ Metrics Chart 52 [/ Metric Diagnosis C.. = B
o] e B+
Metrics of 'zlib_merged' project
Function - FUCYC
1000 Metric
] B runst
= Ve
100 ]
(i)
=
[ind
=
10 1
Rank
Toolbar menu
Menu Description
=3 Show Log Scale Changes the y-axis of chart to log units.
MY Show Normalized Metric  Shows the standardized metric value.
7 Change Mode Changes the view mode ('---:---J module, E file, C class, @ function).

Pull-down menu

Menu Description

Sorts based on the selected item (even if clicking the column name in the table, it is

Sort b
y sorted equally).

Set to Hide/Show Sets whether to hide or show the metrics.
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metric

Metrics View
Options

Sets the connection function with Metric view.

Select Metric

If you select the checkbox left to the metric name in the right table, the checked metrics are displayed in
the chart. If you click the metric name in the checked metric, the items are sorted based on that metric
value.
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16.3. Metrics Top Chart View

The Metrics Top Chart view shows the top items of the metric value in a pie chart. You can see the ratio
of the top items in the total.

B Metrics Bar Chart | &) Metrics Top Chart £2 | [ Metrics Chart [} Metric Diagnasis C.. = O

%vv

Wetrics of 'zlib_merged' project

Function Metrics Metric: |
Top 10 Highest 'FUNST' Values
Function name FUNST
B other 1569.00
Pinflate 735.00
PinflateBack 499.00
P deilate 168.00
Winflate_fast 141.00
inflate_table 138.00

M adler3z 101.00
Bsend_tree 85.00
B ozread 68.00
l deflate slow 67.00
B compress_block 63.00

Menu Description

[72) Change Mode Changes the view mode (ﬁ’ module, = file, (C) class, @ function).

Pull-down menu

Menu Description

Metrics Hide/Show

) Sets whether to hide or show the metrics.
Setting

Sets the number of top items to be displayed and sets whether to show the sum of

Metrics View Options o
the resting items.

The selection of the pie chart and the selected item in the table are connected together.
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16.4. Metrics Bar Chart View

The Metrics Bar Chart view shows the metric values in a bar chart. You can check the value size for

each item in the bar chart.

BL Metrics Bar Chart 3% | &) Metrics Top Chart [ Metrics Chart Metric Diagnosis .. = 0O
v &~ =
Metrics of 'zlib_merged' project
Function Metrics Metric: | FUCYC
Function name FUCYC &
@ inflate 270.0
@ inflateBack 178.00
@ deflate 58.00
@ inflate_table 38.00
@ inflate_fast 32.00
@ gzseek 23.00
@ zlibCompileFlags 21.00
@ deflate_slow 20.00
@ gzread 20.00
@ send_tree 19.00
@ gz_open 17.00
@ check_header 16.00
@ deflate_fast 15.00
@ gen_bitlen 14.00
@ main 1400
@ adler3z 12.00
g 12 AN e
< »
Icons

Icon Description

' Module (a logical portion that divides the project for each function)
File (Source file and header file belonging to the project)

(C) Class

@  Function

Toolbar menu

Icon Description

") Change Mode Changes the view mode (--:---' module, = file, C class, @ function).
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Pull-down menu

Icon Description
Metrics Hide/Show Setting Sets whether to hide or show the metrics.

Metric View Options Sets the number of items to be displayed.
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16.5. Metrics Diagnosis Chart View

The Metric Diagnosis Chart view shows the number of items included in the diagnostic range in a pie
chart. You can check the number of items within each diagnostic range in the project.

B Metrics Bar Chart 4 Metrics Top Chart [ Metrics Chart | [7] Metric Diagnosis C.. 32 | = B

TR
Metrics of 'zlib_merged' project

Function Diagnosis Metric: |FUCYC  w

Distribution of Diagnosis Diagnosis Table
Message Range a Image Count
B simplefwithout .. [0.00, 10.00) 4 92
. More complex(m... [10.00, 20.00) 13
. Complex(high risk) [20.00, 50.00) <2 &
Greatly complex(... [50.00, max) =2 3
Bl rione value 0

Toolbar menu

Menu Description

3 Change Mode Changes the view mode (- module, E file, @ class, @ function).

Pull-down menu

Menu Description
Configure Opens the diagnostics preferences page (allows you to set the diagnostic step and the
Diagnosis ranges or images for each metric).

Metrics Hide/

Sets whether to hide or show the metrics.
Show

Metric View

) Sets whether to display the items having no diagnostic value.
Options
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The selection of the pie chart and the selected item in the table are connected together.
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16.6. Unused Function View
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The Unused Function view shows the functions included in the selected project by classifying them
according to the specified criteria. It shows the currently unused functions and the criteria for classifying
can be added.

) Unused Function 53

Total 42 functicns - in "zlib' project

sl ¥ = 0O

Mame

~ 22 Unused (42 items)

Menu

_tr_tally

]

Compress

deflateBound
deflateCopy
deflatePrime

deflateTune
deflate_fast
deflate_slow
deflate_stored
get_crc_table
zclearerr
gzdirect
gzeof
n7flich

P® e o000 OO OTDETE OO ST S @

crc32_combine

adler32_combine

deflateSetDictionary
deflateSetHeader

Description

Maodule

Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module

Default Module
Nafanlt Modola

File

frees.c
adler32.c
COMEpress.c
cre32.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
cre32c
Zio.c
gzio.c
gzio.c

n7inr

) Copy to System clipboard Copy unused function view image to system clipboard.

Save as PNG

Icons

Icon

Description

Save unused function view as image.

Classification criteria

Function group

Function

Pull-down menu

Menu

Description

Function View Options Sets the number of functions to be displayed for each group.
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16.7. Source-Header Relation View

Source-Header Relation view shows <include> and #include relations between the source file and

the header file

‘= Source-Header Relation 53 {3 3ol = 8
13 files included by 'zufil.c' - in 'zlib' project
v [ zutil.c

(& _mingw.h

[ msvertverh

[# stddefh

[& string.h

[ w32apih

[# strings.h

[B zlib.h

[ sdkddkver.h

[B] zeenfh

[ weharh

[ errno.h

[B) zutilh

[# stdlib.h

Icons

Icon Description
L Source file
[ Header file

[ System header file

Toolbar menu

Menu Description
{} Show System Header Shows the system header.
' Show Includers Shows the files that includes the selected file.

*ls Show Files Included  Shows the file included in the selected file.

Show Includers, Show Files Included
You can display the files that includes the selected file or the files that the selected file is included by

using the menu displayed when right-clicking a file in the view.

‘= Source-Header Relation 52 £ ok sls &= B
13 files included by 'zutil.c’ - in zlib’ preject
v [ zutilc

(B _mingw Show Includers

@ msverty
[ stddef k Show Files Included

[# string.h Show Includers

[ w3z2apih
[# strings.h

[ zlibh

[ sdkddkver.h
[R zeonfh

[#& wcharh

[# erma.h

[R] zutilh

[# stdlib.h
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16.8. Global Variable Relation View

The Global Variable Relation view shows the function where the global variable is defined and used. If a
function is selected, it shows the global variables defined or used in the function, and if a global variable
is selected, it shows the functions where the global variable is defined or used.

2 Global Variable Relation 3% B = 8
‘compress_block' - & relaticns in project 'zlib'
Name Definition Use

v @ compress_block
@ _dist_code
@ _length_code
@ base_dist
@® Dbase_length
@ extra_dbits
@ extra_lbits

LLLLLL

Menu Description
) Copy to System clipboard Copy global variable relation view image to system clipboard.

Save as PNG Save global variable relation view as image.

Icons

Icon Description
@ Function

®  Global Variable

Show Relation

You can view the relation for the selected items again by using the menu displayed when right-clicking
the related item in the view.

2 Global variable Relation 22 & = B8
‘compress_block’ - & relations in project 'zlib'
MNarme Definition Use

v @ compress_block
@ _dist_code
@® _length_o22-
@ base dis Show Relation
@ base_length
@ extra_dbits
@ extra_|bits

show Relation

CLLCLCL <
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16.9. Function Call Hierarchy View

The [Function Call Hierarchy] view shows the information for the function called by the selected function

or the called function in the hierarchy structure.

You can change the call information for the selected function by using the context menu that appears
when selecting and right-clicking the function displayed in the hierarchy structure and double-click it to
open the editor for the source file that the function is defined and to go to the location of the selected

function. (However, not included if it is a system function)

e Function Call Hierarchy 52

Calls from 'read_buf' - in 'zlib'

f|| elog (@ = O

w @ read_bufistruct z_stream_s *, unsigned char *, unsigned int)
@ adler32{unsigned long, const unsigned char *, unsigned int)
v @ crc3z2unsigned long, const unsigned char *, unsigned inf)
@ crc32_biglunsigned long, const unsigned char *, unsigned int)
@ cre32_littlequnsigned long, const unsigned char *, unsigned int)
+H+ memcpy(void * const void *, size_t)

T2 Function Call Hierarchy 3
Calls from 'read_buf - in 'zlib'

H| e otz @ = O

w @ read_buf(struct z_stream_s * unsigned char * unsigned int)
@ adler32(unsigned long, const unsigned char #, unsigned int)

v @ cre32(unsigned oke  Show Caller Hierarchy rd int)

@ crc32_bigi h I i H unsigned int)
o crc32 litile| *le  Show Callee Hierarchy + unsigned int)

+ memcpyivoid *, const void #, size_t)
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Menu Description
£+ Show System Sets whether to indicate the call information for the system function in a
Function hierarchical structure.
" Show Caller
) Shows the functions that call the selected functions in a hierarchical structure.
Hierarchy
*(2 Show Callee
Hi h Shows the functions called by the selected function in a hierarchical structure.
ierarchy

) Copy to System

) Copy function call hierarchy view image to system clipboard.
clipboard

Save as PNG Save function call hierarchy layer view as image.
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16.10. Source Code Editor section

The source code editor section is a pre-reserved area, located on the left of the screen.

I codescroll Controller Tester RTV(Remote Target Verifier) + Target Plugin (x64) - 0o x
File Edit Search Project Iarget Window Help

5 zlib =1 B N A B hod Host @ ¥ [ (Global Search (Ctl=3) Q)i s

New Project New Test Import Export Properties Preferences - S

[ = 7a || show Coverage | [+"] Coverage —JMC/DC §i%Stub [¢) Class Factory <o Control Flow Graph o Call Graph T3 Function Call Hierarchy ®7 Error
[ adler32.c 53 =8 Uit Test gration Test BE U~ v=08

50 } while (@) ~

= et v Statement Coverage

52 # define MOD(a) a %= BASE

53 # define MOD4(3) @ %= EASE (18/0/6) 24 2.9%

54 #endif (118/3995)

55

s /e ,, type file, function, test, state, issue

57 £ ZE Name Result Coverage ~ *

58 uLeng adler; "

59 const Bytef *buf; 3 signaled

) unt len; 4 Signaled

61 { 5

62 unsigned long sum2; 6

53 unsigned n; 7

64 o

65 /= split Adler-32 into componant sums */ °

&6 sum2 = (adler >> 16) & @xffff; 9 signaled

67 adler &= oxFFFf; 18 Signaled

68 11

69 /= in case user likes doing a byte at a time, keep it fast */

70[TF] if (len

71 adler ) -

72[F] if > @ adler3 11/0/0) 100.0%

73

74 sum2 += adler; < >

75[F] if (sum2 >= BASE

76 ] adler32(unsigned long, const u... 53 =g

77 return adler | (sum2 << 16); .

. ) Test Info (zlib/adler32_test0) oA

79

80 /* a initial Adler-32 value (deferred check for len == 1 speed) */ "

B1[F] if (buf == 2 NULL) Test Structure o Test Info Edit

SS h Test structure using 2 tree view and edit the information in the test Change the notation edrt the partition ~

84 /* in case short lengths are provided, keep it somewhat fast */ Name in  out Set Numersl System

85[TF if (len < 16

as%w} = (lénf,) c v Parameter/retum @10 Numerzl System O 16 Numeral System

87 adler += *buf+i; v o adler - uleng

88 sum2 += adler; o adler - unsignedlong 4 [ Variable Partition

89 } ~v o buf : const Bytef *

98[TF] if (adler >= BASE) ~ o [0] : Bytef W‘” | e

91 adler -= BASE; o [0] - Byte

92 HODA(sum2) ; /= only added so many BASE's */ Y [n] 0] i dc O [single value || add

EE] return adler | (sum2 << 16); [0] : unsigned c

o ) v o len : unt Patition List

s o len : unsigned int %] g Delete

96 f* do length WAX blocks -- requires just one modulo operation */ v & retumvar : uLeng et

97[TF] while (len >= NHAX) { o returnVar - unsigned Ic ioos- Default

% len ~= NAX; Before call code

99 n = NMAX / 16; /= NMAX is divisible by 16 */ "16"

100 do { . Adter call code v 11755517 ©

Test Info| Test Case| Test Code | Configuration |

-7M of1038M |}
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In File menu, Create a new project or module, Editor-related operation, Refresh, Change Workspace,
Import and Export, View Properties of the selected item and Exit Tool etc. can be carried out.

File Edit Search Project Target Window
Mew »
Close Ctrl+w
Close All Ctrl+Shift+W
Save Ctrl+5
Save All Cirl+Shift+5
Rename... F2
Refresh ]
Switch Workspace...

=y Import...

iy Export..

Properties Alt+Enter
Exit
New:

o Create a project

o Create a module

Close/Close all/Save/Save all: Editor-related menu
Rename: You can modify the name of project or module.
Switch workspace

Import

Export
Exit: Exit tool.
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17.1. Create a Module

You can create a new module in the project. The information other than the module name is created the
same as the modules already existed in the target project.

B rew Module O *

Meodule

Create 3 new module.

Select the project:
I Stub_sample
=% zlib

Module name: ||

Einish Cancel

In [New] menu, click [Other...], select [Module] in [Other] and click [Next].
Select the project that you want to create a new module.

Enter the module name. The module name existed already cannot be used.
Click [Finish] to create the module.

hoON -

* You can also create a module by using the [New] menu displayed when right-clicking a
project in Test Navigator view.
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17.2. Switch Workspace

You can switch the directory of workspace. When you witch the workspace, the tool restarts with the
switched workspace.

B switch Workspace *

Pick Workspace

Your workspace is where settings and varicus important files will be stored.

Workspace: F-#Product_Workspace w Browse...

- [] Use this as the default and do not ask again

Clone Cancel

Click [Browse...] to select the workspace directory to be switched or to enter it manually. You can select
the workspace directory selected previously in the list displayed when clicking [ V].

If you select the checkbox [Use this as the default and do not ask again], you are not prompted again to
select a workspace directory the next time you execute the tool.

If you click [Clone], the selected workspace is copied to the other directory.
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Controller Tester provides a feature that import project and data used other version or other PC.

1.

2. Select a item to import and click [Next].

C E

Mew

Close
Close All

Save
Save All

Rename...
Refresh
Switch Workspace...

Import...
Export...

Properties

Exit

Ctrl+W
Ctrl+Shift+W

Ctrl+5
Ctrl+5Shift+5

F2
Fa

Alt+Enter

H

Choose import wizard.

Select an import wizard:

|t_\,-'pe filter text

v [= Coverage
== Import Coverage
w [= General
[, File System
=% Import project
w [ Preferences
=], ToslChain
~ [= Requirement
Impaort from CSV file
b import from Polarion
=% Import from V-SPICE
w [ Test
Impart test

(] Import test using test code file

= Back

Mext =

Parent item Child item

Coverage

Import Coverage

Description

import coverages in csd format.

Select [File] -> [Import] from the main menu or [Import] from the dashboard to open the Import

Wizard.
, File | Edit Search Project Target Window
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General

Preferences

Requirement

Test

File System
Import project

ToolChain

Import from CSV file
Import from Polarion
Import from V-SPICE

Import test
Import test using test
code file

User Manual - 3.6_en

Import files or projects.

Import toolchains exported before.

Import requirements from CSV files or requirement
management tools.

import tests exported before or tests from test codes.
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17.3.1. Requirement — Import from CSV file

You can import requirement documents written in CSV file to Controller Tester.

1. In the Import Wizard, select [Requi_rem_ent_] -> [_I[nport fro_m CSV file] and click [Next].
npaort O ®o |

Import requirements from a CSV file. @

Select an import wizard:
type filter text

» [ Coverage |
» [= General |
5 [= Preferences
v [= Requirement
Import from CSV file |
b import from Polarion |
y [ Test |

= Back Finish Cancel

2. Enter informations for importing requirements and click [Finish].
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BE Import requirements from a €SV file O *
Import requirements from a C5V file
File Selection
File: | -#¢requirements_example.csv | | Browse. . |
Configuration
Walue separator: | v|
Enceding: US-ASCll v|
format: | EXCEL ~ |
The CSV file contains a header
Assgin Attribute
Key: | Key ~ |
Title: Title v|
Description: |Description v|
Mext > | Finish | | Cancel |

a. File Selection
» Enter the path of a file that the requirements are stored.
b. Configuration
+ Value seperator : Enter a separator that separate each value in the CSV file. Default
value is ,(comma).
* Encoding : Enter a encoding of the CSV file. Default value is US-ASCII.
+ format : Enter a format of the CSV file. Default value is EXCEL.
+ The CSV file contains a header : Check when the CSV file contains a header.
c. Assign Attribute
+ Key : Select the column that corresponds to the key of the requirements.
» Title : Select the column that corresponds to the title of the requirements.
» Description : Select the column that corresponds to the description of the
requirements.

* The information you entered in the previous import is automatically filled in.
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17.3.2. Requirement — Import from Polarion

You can import requirement documents from Polarion to Controller Tester.

1. In the Import Wizard, select [Requi_rem_ent_] -> [_I[nport fro_m Polarion] and click [Next].
nport O *

Impaort requirements from Polarion. @

Select an import wizard:
type filter text

> [= Coverage
» [= General |
5 [= Preferences
v [= Requirement
Import from CSY file |
b import from Polarion |
y [ Test |

= Back Finish Cancel

2. Enter the information to connect with Polarion server and click [Next]. You can see the entered

password to click hod button.
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B® Import requirements from Polaric | x
Import requirements from Polarion

Enter the information to access the Polarion server.

Server: | https://almdeme.polaricn.com

Port  [443

Username: |admin

Password: |***** | ®

= Back Finish Cancel

* The information of Polarion’s demo server is entered in server and port.

User Manual - 3.6_en

+ If you use a local server, enter http://ip address in server and port number of local

server in port.

3. When you enter the Project, Document, and Type to import from Polarion, the corresponding
requirements list appears. Check the requirements and click the [Finish] button to import the

requirements.

BH import requirements from Polaricn O >
Import requirements from Polarion

Select the information of what you want to import requirements

from.

Project: TEST(TEST) v

Document: | Specification/Cataleg Specification v

Type: Reguirement v
D Title Description G
TEST-101 User name must be validate  User name must be validated when a n¢
TEST-147 Password must be validatec  Password must be validated when the u
TEST-209 Password must contain at | Password must contain at least 8 charat
TEST-210
TEST-146 User name may not contair  User name may not contain spaces
TEST-152 User name must be longer  User name must be longer than 3 chara
TEST-151 User name must contain at - User name must contain at least one n
TEST-149 Password must differ from  Password must differ from the user narm
TEST-148 Password must contain at | Password must contain at least one nur
TFST-15A Ileer et he infarmed nn - 1lcar mnst he infarmed nn the lnain <o ¥
< >

< Back Next = Cancel

Page 194 of 322



Suresofttech

4.

» If you do not select the Document, you can also import requirements that are not included in

a specific document.
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[Connect requirements and tests] dialog appears where you can connect the imported

requirements and tests. If the title or description of the requirement contains the name of the

function associated with the test, it is automatically linked. Click [Cancel] to finish [Connect
requirements and tests] without linking requirements and tests.

Connect requirements and tests

Select the tests to connect with each requirement.

Find and select a test from the list on the right to connect with the requirement you selected in the list on the left.
(% If a function name is included in the title or content of the requirement, it is automatically connected)

[TEST-101] User name must be validated when a new user account is created
[TEST-146] User name may not contain spaces

[TEST-147] Password must be validated when the user wants te change it
[TEST-148] Password must contain at least one number

[TEST-148] Password must differ from the user name

[TEST-151] User name must contain at least one number

[TEST-152] User name must be longer than 3 characters

[TEST-156] User must be informed on the login screen when Caps Lock is turned +
[TEST-157] User may not be told if the password or user name is wrong
[TEST-159] System should meet the following acceptance criteria Use Case Accept
[TEST-160] System rnust suppert all following web browsers Browser Support Leve
[TEST-209] Password must contain at least 8 characters Password must contain at
[TEST-210]

jooogoooooooooooooooooooooooooooo

Test

_tr_align(struct internal_state *)_0
_tr_align(struct internal_state *)_0_copy_0'
_tr_flush_bits(struct internal_state *)_0

_tr_flush_blockistruct internal_state *, char *, unsigned long, signed int)_0

_tr_init(struct internal_state *)_0

_tr_stored_blockistruct internal_state *, char *, unsigned long, signed int)_t

_tr_tally(struct internal_state *, unsigned int, unsigned int)_0
adler32(unsigned long, const unsigned char *, unsigned int)_0
adler32(unsigned long, const unsigned char * unsigned int)_0
adler32_combine(unsigned long, unsigned long, signed long)_0
adler32_combine(unsigned long, unsigned leng, signed long)_0
adler32_combinet4(unsigned long, unsigned long, signed long)_0
adler32_combineé4unsigned leng, unsigned leng, signed leng)_0
adler32_combine_{unsigned long, unsigned long, signed long)_0
adler32_combine_(unsigned long, unsigned long, signed long)_0
adler32_z(unsigned long, const unsigned char *, unsigned int)_0
adler32_ziunsigned leng, const unsigned char *, unsigned int)_0
bi_flushistruct internal_state *)_0

bi_reverse(unsigned int, signed int)_0

bi_windup(struct internal_state *)_0

build_bl_tree(struct internal_state #)_0

build_tree(struct internal_state *, struct tree_desc_s *)_0

compress{unsigned char *, unsigned leng *, const unsigned char *, unsigi
compress2(unsigned char *, unsigned long *, const unsigned char *, unsii

compressBound{unsigned long)_0

compress_block(struct internal_state *, const struct ct_data_s *, const struc

cre32(unsigned long, const unsigned char #, unsigned int)_0
crc32_bigiunsigned long, censt unsigned char #, unsigned inf)_0
cre32_combine(unsigned long, unsigned long, signed long)_0
crc32_cembineg4iunsigned long, unsigned long, signed long)_0
cre32_combine_(unsigned long, unsigned long, signed long)_0

rrr22 littHlafuincinned lonn ranct uncianed char 5 nncinnad int 0

Function

_tr_aligng)
_tr_alignQ
_tr_flush_bits()

_tr flush_block(
_tr_init)
_tr_stored_block()
_tr_tally

adler32()

adler32)
adler32_combine()
adler32_combine(
adler32_combineg4d()
adler32_combineg4)
adler32_combine_()
adler32_combine_)
adler32_z()
adler32_z0)
bi_flush()
bi_reverse()
bi_windup(
build_bl_tree()
build_tree()
compress()
compress2()
compressBound()
compress_block(
crc32(0)

cre32_bigQ
cre32_combine()
cre32_combineg4)

cre32_combine )
rre2? litHan

oK Cancel
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17.3.3. Requirement — Import from V-SPICE

You can import requirement documents from V-SPICE to Controller Tester.

1. In the Import Wizard, select [Requirement] > [Import from V-SPICE] and click [Next].
B Import O pd

Select

Import requirements from W-5SFICE. @

Select an import wizard:
type filter text

s [= Coverage

» = General

» = Preferences

w [= Requirement
mn Impert from CEV file
@ import from Polarion
=2+ Import from V-SPICE

% = Test

= Back Mext = Finish Cancel

2. Enter the information to connect with V-SPICE server and click [Next]. You can see the entered

©

password to click button.
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4.

B Import requirements from W-SPICE

Import requirements from V-SPICE

Enter the information to access the W-SPICE server.

Server: | http://

Port  |32080

Username: |

Password: |

= Back Mext =

Finish Cancel

mport requirements from V-SPICE

Import requirements from V-SPICE

d x

Select the information of what you want to import requirements

from.

Project: [oNS_TNR_GLE_TPU

Doc Type: | ALL (ALL)

D

CN3_TNR_GLB_TPU_REC 5
CNS_TNR_GLB_TPU_REC O
CMN3_TNR_GLB_TPU_REC_1
CNS_TNR_GLB_TPU_REC 2
CMN3_TNR_GLB_TPU_REC 3
CNS_TNR_GLB_TPU_REC 4
CN5_TMR_GLE_TPU_REQ &
CNS_TNR_GLB_TPU_REC_7
CM5_TNR_GLB_TPU_REC 2
CNS_TNR_GLB_TPU_REC 9

Title

CN3_TMR_GLB_TPU_REC_S
CN5_TNR_GLE_TPU_REQ 0
CN3_TMNR_GLB_TPU_REQ_1
CN5_TMR_GLB_TPU_REQ_2
CN3_TMR_GLB_TPU_REQ_3
CN5_TNR_GLB_TPU_RECQ 4
CMN5_TNR_GLB_TPU_REC &
CN5_TNR_GLB_TPU_RECQ_7
CN5_TNR_GLE_TPU_REC 8
CNS_TNR_GLBE_TPU_RECQ_ 2

Description

CM5_TMR_GLB_TPUREQ.!
CM5_TMR_GLB_TPUREC!
CM5_TMR_GLB_TPUREQ,
CM5_TMR_GLB_TPUREC..
CM5_TMR_GLB_TPUREQL:
CM5_TMR_GLB_TPUREC.:
CM5_TMR_GLB_TPURECL
CM5_TMR_GLB_TPURECQ
CM5_TMR_GLB_TPUREQ. !
CM5_TMR_GLB_TPUREQ.!

= Back Next =

cocl
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When you enter the Project to import from V-SPICE, the corresponding requirements list appears.
Check the requirements and click the [Finish] button to import the requirements.

[Connect requirements and tests] dialog appears where you can connect the imported
requirements and tests. If the title or description of the requirement contains the name of the
function associated with the test, it is automatically linked. Click [Cancel] to finish [Connect
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requirements and tests] without linking requirements and tests.

BB Connect requirements and tests O X

Select the tests to connect with each requirement.

Find and select 2 test from the list on the right to connect with the requirement you selected in the list on the left.
(# If a function name is included in the title or content of the requirement, it is automatically connected.)

[TEST-101] User name must be validated when a new user account is created |
[TEST-146] User name may not contain spaces Test Functi N
[TEST-147] Password must be validated when the user wants to change it s _ _ unction
[TEST-148] Password must contain at least one number [ _tr_alignistruct intemal_state *)_0 _tr_aligno
[TEST-149] Password must differ from the user name O _tr_alignistruct intemal_state *)_0_copy_0 _tr_align(
[TEST-151] User name must contain at least ane number [ _tr_flush_bits(struct internal_state *)_0 _tr_flush_bits(
[TEST-152] User name must be longer than 3 characters [0 _tr_flush_block(struct internal_state *, char *, unsigned long, signed int)_0 _tr_flush_block(
[TEST-156] User must be informed on the login screen when Caps Lock is turned «| [ _trinit(struct internal_state *)_0 _tr_init0)
[TEST-157] User may not be told if the password or user name is wrong [ _tr_stored_blockistruct internal_state *, char * unsigned long, signed inf)_l _tr_stored_block()
[TEST-159] System should meet the following acceptance criteria Use Case Accept | [ _tr_tally(struct internal_state *, unsigned int, unsigned int)_0' _tr_tally
[TEST-160] System must support all following web browsers Browser Support Leve | ] adler32(unsigned long, const unsigned char *, unsigned int)_0 adler32()
[TEST-209] Password must contain at least 8 characters Password must contain at | ] adler32(unsigned long, const unsigned char *, unsigned int)_0 adler3z
[TEST-210] [ adler32_combine(unsigned long, unsigned long, signed long)_0 adler32_combine()
[ adler32_combine(unsigned long, unsigned long, signed long) 0 adler32_combine()
[ adler32_combineg4iunsigned long, unsigned long, signed long)_0 adler32_combinedi)
[ adler3z_combineG4(unsigned long, unsigned long, signed leng) 0 adler32_combinegd()
[ adler32_combine_(unsigned long, unsigned long, signed long)_0 adler32_combing_()
[ adler32_combine (unsigned long, unsigned long, signed long) 0 adler32_combine_()
[ adler32_ziunsigned long, const unsigned char * unsigned int)_0 adler32_zn
[ adler3z_z{unsigned long, const unsigned char *, unsigned int)_0 adler3z_z()
[ bi_flush(struct internal_state #)_0 bi_flush()
[ bi_reverse(unsigned int, signed int)_0 bi_reverse()
[ bi_windup(struct internal_state *)_0 bi_windupd
[ build_bl_tree(struct internal_state *)_0 build_bl_tree()
[ build_tree(struct internal_state *, struct tree_desc_s *)_0 build_tree()
[ compressiunsigned char *, unsigned long *, const unsigned char * unsigi compress()
[0 compress2(unsigned char * unsigned leng *, const unsigned char * unsii compress2()
[ compressBound(unsigned long)_0 compressBound()
[1 compress_blockistruct internal_state *, const struct ct_data s *, const struc compress_block()
[0 cre32(unsigned long, const unsigned char *, unsigned int)_0 ere320)
[ crc32 big{unsigned long, const unsigned char #, unsigned int) crc32_bigQ)
[ cre32_combine(unsigned long, unsigned long, signed long)_0 cre32_combing()
[l cre32_combinef4{unsigned long, unsigned long, signed long) 0 cre32_combine64()
[ cre32_combine_funsigned long, unsigned long, signed long)_0 cre32_combing )
M1 rer22 littlafiincianed lana ranct nncianad rhar # nnciansd inf 0 rre2? litan e
oK Cancel
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You can add the source files to the project by using [Import] — [File System] feature.

1. In the Import Wizard, select [General] -> [File System] and click the [Next] button.

Select

B Import

Import from File System.

Select an import wizard:
type filter text

> [= Coverage
w = General

[, File System
=% Import project

5 [= Preferences
> [= Requirement
y [ Test

= Back

Finish

Cancel

2. Enter the information of the file to be imported and click the [Next] button.
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B Import O b4

Import

Select source files.

Top Directory: |C:‘#Program FileswSuresoftwCodeScroll Controller Tester 3.5%| Browse...

Directory File
v [m] examples |t}-‘pe filter text |
v [m] c
» [#] sample sample.c

Text file written list of source files

Browse...
¥ The entered text file is separated by ' or newline character. Remove
1 items selected

Into project: | test Browse...

= Back Next = Cancel

Item Description
Top Directory Select the directory of the source files to be imported.
Directory, File Select the source files to be imported.

Text file written list of source  Select the directory of the txt file containing a list of source
files files.(Option)

Into project Select the project to add the imported source files.

3. Select the module that the source file will be added from the list of modules included in the project
and click the [Finish] button.
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B import m| *®
File System

Select modules to add.
Select module to add:

71 Default Module; Select Al

Deselect All
< >
< Back Next > Einsh || Cancel

User Manual - 3.6_en
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17.3.5. General — Import project

Using the Import Project feature, you can import a project exported from another PC.

1. In the Import Wizard, click [General] -> [Import Project] and then click the [Next] button.

B Import O pd
Select \
Import the project, including project settings and tests. H

Select an import wizard:
type filter text

> [= Coverage
w = General
[, File System
=% Import project
5 [= Preferences
> [= Requirement
y [ Test

= Back Mext = Finish Cancel

2. Click the [Next] button after entering the exported project directory and selecting the toolchain.
When you select a directory, the toolchain associated with the project to import is automatically
selected. If you don’t have a suitable toolchain, you need to import the toolchain using the
toolchain export/import feature before importing the project.
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- Import = \@
Import a Project -~
Import the exported project.
-l
Project directory: DhvprojectlE_20200513113853
Project name: projectlE
Location: ChUsers\vagrant\Desktop\workspace\CT\1
Select Toolchain
Default Toolchain Name ° Description
[} goc B4
[} vs2019 x64_x64
] vs2019 x64_xE6
] vs2019 xB6_B6
= GCC 4.7 (32bit) Automatically generated.
GCC 5.3 (32bit) Automatically generated.
Toolchain Setting
<Back | Net» Finish
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3. You can check the path information included in the project to be imported. Invalid paths are

4.

. Import
Check the paths included in the project
(v, Invalid path: 15/15

Path(click to edit):

C\Users\seo hyunji\Desktop'target plugintzlib-1.211%zlib-1.2.11N\adler32.c
C\Users\seo hyunji\Desktopitarget plugintzlib-1.2.11%zlib-1.2.11\ere32.c
C\Users\seo hyun)i\Desktopitarget plugintzlib-1.2.11%zlib-1.2. 11\ deflate.c
C\Users\seo hyun)i\Desktopitarget plugintzlib-1.2.11%zlib-1.2.11\gzclose.c
C\Users\seo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2.11%gzlib.c
C\Usershseo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2.11\gzread.c
Ch\Users\seo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2.11\gzwrite.c
C\Usersiseo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2 11\infback.c
C\Users\seo hyunji\Desktopttarget plugintzlib-1.2.11%zlib-1.2 11\inffast.c
C\Users\seo hyunji\Desktopitarget plugintzlib-1.2.11zlib-1.2 11\inflate.c
C\Users\seo hyunji\Desktopitarget plugintzlib-1.2.11%zlib-1.2 11\inftrees.c
C\Users\seo hyun)i\Desktopitarget plugintzlib-1.2.11%zlib-1.2. 11 trees.c
C\Users\seo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.211\uncompr.c
C\Users\seo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2.11\zutil.c
C\Usershseo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.213\ compress.c

Mext >

Finish

Cancel

marked in red and can be modified by clicking with the mouse or pressing the F2 key.

If you edit one path, all paths that can be found in the relative path are automatically corrected.
The number of modified paths is displayed at the top of the wizard. After editting, click the [Finish]

button.
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. Import
Check the paths included in the project -~
(D) Invalid path: 0/15
15 paths have been resolved. -

Path(click to edit):

C\Users\wagrant\Desktop\sourcelzlib1 211\zlib-1.211\adler32.c
Ch\Users\wagrant\Desktop\sourcetzlibl 211'\zlib-1.2 11\compress.c
C\Users\wagrant\Desktop\sourcezlibl 211\zlib-1.2 11Nerc32.c
C\Usersh\wagrant'\Desktop\source\zlib1 211'\zlib-1.2 11" deflate.c
Cih\Usershvagrant\Desktophsource\zlibl1211zlib-1.2 11\ gzclose.c
Ci\Users\wagrant\Desktop\sourcehzlibl 211\zlib-1.2 11\ gzlib.c
C:\Users\wagrant\Desktophsource\zlib1211\zlib-1.211\gzread c
Ch\Users\wagrant'\Desktop\sourcetzlib1 211'\zlib-1.2 11\gzwrite.c
Ch\Users\wagrant'\Desktop\sourcetzlibl 211'\zlib-1.2 11\infhack.c
C\Users\wagrant'Desktop\source\zlibl1211'zlib-1.2 11%inffast.c
C\Users\wagrant'\Desktop\sourcelzlibl211'\zlib-1.2 11%inflate.c
Ci\Users\wagrant'\Desktop\sourcelzlib1 211\zlib-1.2 11 inftrees.c
Ch\Users\vagrant\Desktop\source\zlib1211\zlib-1.2 11\ trees.c
C\Users\wagrant\Desktop\sourcetzlibl 211\zlib-1.2 11uncompr.c
Ch\Users\wagrant'\Desktophsourcetzlib1 211\zlib-1.2 11zutil.c

Next » [ Fnsh ][ concel

* If path is not in absolute path format of Windows OS, the path is not checked for validity.
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17.3.6. Coverage — Import Coverage

! ifthe version, the coverage type, and the ternary operator option of the coverage file to
be imported are the same as those of Controller Tester, the coverage can be imported.
For details, please refer to the Coverage Import Guide page of User Guides.

1. In the [Import] wizard, select [Coverage] > [Import Coverage] and click [Next].

B Import O b4
Select y
Import external coverage to the selected project. H

(Coverage shared data file, *.csd)

Select an import wizard:
|t}-‘pe filter text |

v [= Coverage
== Import Coverage
(= General
[= Preferences
= Requirement

>
>
>
» [= Test

< Back Next = Finish

2. Enter the path of coverage file to be imported and click [Finish].
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. Import coverage O *

Import coverage

Select the file for sharing coverage information(*.ced).

File path: ZWexportizlib.csd ‘Browse._.!

* The imported coverage information can be checked by selecting [Show full coverage
(Include External Coverage)] in the toolbar menu of the Coverage View.

") Coverage &3 8 E i) = O
Host coverage information of 'zlib' project

Target Function | Statement Branch MC/DC |Fur1cti|:bn Calll Functi...l -
1 _tr_alignistruct internal_state ) -T2 T2% . | T0.00% . | A0 00% . (== 10000, =
2 | _tr_flush_blockistruct internal_state ... == 54 755% ... == 52 50% ... == 35.36% ... == 70005 ... ==Y
3 _trinit(struct internal_state ¥ = 00.00%... = N/A = N/A — 0000, (-
4 | _tr_stored_block(struct internal_stat... == 100.00%... == 100.005%...[== 100.00%... == 100.00... ==Y
5 |_tr_tally(struct internal_state *, unsi... ™= 22 22%  ==000% (.. ==000% (.. — N/A -y
6 |adler32{unsigned long, const unsig... ™ 93.03% .. == 37.50% ... == 7300% .. — N/A -
7 |adler32_combinefunsigned long, u... ™= 100.00%...[== 100.00%. .. ™= 100.00%...— N/A -
8  bi_flush(struct internal_state #) ] 00 00%. (= 00 00%. . = 100.00%... =/ N/A -
9  |bi_reverse(unsigned int, signed int) == 100.00%...[== 100.00%. .. == 100.00%... = N/A -

10 bi_windupistruct internal_state #) | 00 005, [ 00 000w 100.00%... — N/A -
11 |build_bl_tree(struct internal_state *) |== 100.005.. == 75 00% . == 50005 _ (== {0000 . (==Y

Total 43.02% (... 28.51% (...|19.07% (... 44.11% (... 100.0...| v

& In target testing mode, the coverage of the function including Asm code can not be measured.
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1. In the Import Wizard, select [Test] -> [Import Test] and click [Next].
B import O *

Select

Import test information. @

Select an import wizard:
type filter text

» [= Coverage
w = General
=% Existing Projects into Workspace
[, File System
5 [ Preferences
v = Test
Import test
[E' Import test using test code file

< Back Next = Finish Cancel

2. Enter the information for the test to be imported and click [Finish].
B import tests O *

Import tests

Import project's test informations.

Import path: | Z-#exported_testwzlib

Unit Test
Test
Test Data

Integration Test
Test
Test Data

Stub
(O Connected Stub
® All Stub

Option
[] Ovenwrite existing test files without warning

(O If the same stub exists already, it is not imported.
(@ If the same stub exists, it is added as a new stub.

= Back Mext = Cancel :
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3. If there are items that the name has been changed or the file has been deleted when importing the
test information, the notification windows is displayed, allowing you to select whether to import the
information except for that items. This notification window is displayed only if the information was
exported from Controller Tester 2.6.14 or later version at a time. If the information is exported from
the other menu and previous version, the notification is not displayed.

B o

File is deleted, or renamed files exist..
with the exception of this file, Do you want to run the import?

ZMewported testilzlibWUnitTestseyncsearch_testQ utest:
Ztexported_testwzlib¥UnitTestsitupdatewindow_test0.utest
Z#exported testwzlibWUnitTestswset_data_type testO.utest
Zitexported_testwzlibsUnitTestsstr_static_init_test0.utest
Z#texported_testwzlibWUnitTestsWuncompress_testD.utest
Zirexported_testwzlibstUnitTests#zError_testl.utest
Ztexported_testwzlibWUnitTestswzlibCompileFlags_testO.utest
Zyexported_testwzlib¥UnitTestswzofree_testO utest
Z#texported_testwzlibWUnitTestsWzealloc_test0.utest
Zyexported_testwzlib¥UnitTestswzlib\Version_test0.utest

| Cancel

4. If the same test exists in the project, select whether to overwrite the test. Select [Yes] to overwrite
and select [No] to cancel the import.
- mport tests B O *

Import tests

Import project's test informations

Irmport path: | Z:Wexported testizlib Search...

Unit Test
Test

| ¥
B import X

@™% There is a test with the same name as adler32_combine_test0.utest. Do you wish
)  to overwrite?

Yes Yes To All No Mo To All Cancel

[TTTRTAIISHE |

theut warning
not imported.
added as a new stub.

(1/114) UnitTest: adler32_combine_test0 utest
I |

< Back Next = Finish Cancel

5. After the import has completed, it is applied to the selected project.

Import information exported from Controller Tester 2.6.14 or earlier

1. Enter the path to import the test in [Import path].
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| M = | Export
Home share View

«— v > ThisPC > Documents > Export ~ O | Search Export
3 Downloads "~ Name - Date modified Type Size
& Documents Zlib 4/1/2020 218 PM  File folder
=1 Pictures
CodeScroll Conti
132
$ Music
| zlib
B Videos
Hom sh Vi
@ OneDrive
v « Documents > Export > zlib v O | Searchzlib »
~ = ThisPC ~
™ Name Date modified Type
= Desitop st Quick access
> [ Documents Stubs 4/1/20202:18PM  File folder
s Downloads UnitTests 4/1/2020 2:18 PM File folder
- \J testinfo.export 4/1/2020 2:18 PM EXPORT File
& Music |2 Documents
& Pictures v = Pictures
1item
CodeScroll Contl
732
J Music
B Videos
@ OneDrive
= This PC
m Desktop
|2 Documents v < >
3 items ==
 If [testinfo.export] file exists in the test path to be imported, select the directory containing

the file.
If you import the information exported separately from Controller Tester 2.6.14 or less
version, select the higher-level directory containing the information exported.

2. In [Unit Test] group, check whether to import [Test] and [Test data] respectively.

3. In [Integration Test] group, check whether to import [Test].

+ The test and data must always be in the same directory, and if it is not, the data is not
imported.

4. In [Stub] group, select the stub to be imported among [Connected Stubs] and [All stubs].

» For the stubs created in Controller Tester 2.3 version, or the stubs migrated to Controller
Tester 2.6, if the same stubs exist in the project, the import cannot be carried out.

» For the stubs created in Controller Tester 2.6 version, if the same stubs exist, you can select
either not to import them optionally or to create as a new stub additionally.

* There is no feature to link the stubs to the test in Controller Tester 2.3 version, so you
need to link directly to the test when migrating to version Controller Tester 2.6 or
later.

5. In [Option] group, select whether to overwrite the existing test files if they exist and how to handle
them when the same stub exists.
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17.3.8. Test — Import test using test code file

1. In the Import Wizard, select [Test] -> [Import test using test code file] and click [Next].
B import O *

Select

Create tests from test code files. @

Select an import wizard:
type filter text

» [= Coverage
w = General
=% Existing Projects into Workspace
[, File System
5 [ Preferences
v = Test
Import test
[“E Import test using test code file

< Back Next = Finish Cancel

2. Click [Add...] and select the test to be imported.
B import test using test code file O *

Import test using test code file

Create tests using test code files. Please select files.

Test files:

Ztexportitunittests_tr_align_testO.c -~
Ztexportitunittestw_tr_flush_block_test0.c
Ltexportitunittestd_tr_init_testO.c Remove
Zexportitunittests_tr_stored_block_testO.c —
Zexportytunittestsw_tr_tally_testO.c
Zexportdtunittestwtadler32_combine_test0.c
Iexportitunittestitadler32_testO.c
Texportatunittestwbi_flush_test0.c
Ziexportitunittestwbi_reverse_test0.c
Ztexportdunittestwtbi_windup_test0.c
Ztexportitunittestwtbuild_bl_tree testO.c
Zitexportitunittestwbuild_tree_test0.c
Iexportsunittestwtcheck_header_testO.c
Ztexportitunittestitcompress_block_testO.c
Itexportiftunittestitcompress_test0.c
Litexportitunittestitcompress2_testl.c
ZexportitunittestitcompressBound _test0.c
Zwexporttunittestwtcopy_block_testO.c
Zitexportitunittestwtere32_big_test0.c

Ztexportftunittestitcre32_combine_test0.c
C | F-evnnrtdh inittect¥rrr 32 little tech r

= Back Mext = Cancel
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3. Click [Finish] to apply the selected test to the selected project.
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17.3.9. Preferences — ToolChain

You can import the toolchain information exported by using the Import function.

1. In the Import Wizard, select [Preferences] -> [ToolChain] and click [Next].
B Import O pd

Select

Import ToolChain configuration informations. @

Select an import wizard:
type filter text

> [= Coverage

» [= General

w [ Preferences
=], ToolChain

> [= Requirement

y [ Test

= Back Mext = Finish Cancel

2. If you select the file (*.tch) to be imported, the list of toolchains included in the selected file are
displayed. Select the toolchains to be imported from the toolchain list.
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B import O X
Select
Select the toolchain and destination location.
Select the import location: | Z:#exportitexported tch Browse...
Select the toolchain to import:
Default  Toolchain Name Description Status in import
[ CPP_TI_TMS320_8000_SoC._. Meed to configure
GCC 4.7 (32bit) MNeed to configure
GCC 5.3 (32bif) Meed to configure
| Microsoft Visual Studio 20... Meed to configure
O Microsoft Wisual Studio 20.. MNeed to configure
| Microsoft Visual Studio 20... Meed to configure
O Microsoft Visual Studio 20... MNeed to configure
O jar Need to configure
Select all Deselect all
|
- [JOpen Toclchain preference page after wizard is finished.
|
< Back Next = Finish Cancel

User Manual - 3.6_en

3. If the toolchain name is duplicated with the name of the existing toolchain, the import status
becomes “Need to modify”. You can change the toolchain name to be imported in the [Select how
to resolve] window displayed when clicking [Next] button.

. Import

Resolve conflicts

The toolchain that have the same name exist.
Enter the new name.

Select how to resolve:

Toolchain MNew Mame

GCC 4.7 (32bit) GCC 4.7 (32bit)(1)
GCC 5.3 (32bit) GCC 5.3 (32bit)(1)

Except

= Back

4. Click [Finish].

Finish

Cancel
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You can export projects, tests, toolchains, and etc in Controller Tester.

1.

Select [File] -> [Export] from the main menu or [Export] from the dashboard to open the Export

Wizard.

, File | Edit Search Project Target Window
Mew »
Close ctl-w |
Close All Ctrl+Shift+W
Save Ctrl+5
Save All Ctrl+Shift+5
Rename... F2
Refresh F5

Switch Workspace...

Import...
Export...

Properties Alt+Enter

B B

Exit

Select a item to export and click [Next].

i Export O

Select }

Choose export wizard. H

Select an export wizard:
type filter text

w [= Coverage
== Export Coverage
w [= General
1= Export project
v [= Metrics
] Metrics
~w [ Preferences
=l ToolChain
v [= Requirement
Wb Export test results connected to requirements to Polarion
Requirement test coverage report
v = Test
t] Export test
{=| Generate test report

= Back Mext = Finish Cancel
Parent item Child item Description
Metrics Metrics

Export the project’s metrics measurement results in
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a report format.

Export test results
connected to requirements  Export the results of tests associated with

Requirement to Polarion requirements to a requirement management tool or
Requirement test coverage to a CSV file.
report

General Export project Export Controller Tester projects.

Coverage Export Coverage Export the coverage results in a csd file.

Export test
Test Export tests or generate test reports.

Generate test report

Preferences ToolChain Export the toolchain information.
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17.4.1. Metrics — Metrics

It exports the metric result of the project in a report file.

1. In the Export Wizard, click [Metric] -> [Metric] and then click the [Next] button.

B 500 ==
Select ﬁ
Export project's metric information to report. H

Select an export wizard:

type filter text

> (= Coverage

i [= General

4 [= Metrics
| Metrics |

[+ [ Preferences

b (= Test

< Back Next > —

2. Select the project and metric type to export metric information and click the [Next] button.
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B sport

Export Metrics
Export project's metric informations to report file.

Available Projects:

=zlib Select All E
|

1 of 1 selected.

Metric Type
Class
File

' Maodule

<Back | Nest> || Ensh || cancel |

3. Select the path and report format to export the report and click the [Finish] button.

B sport m| X

Export Report
Choose export destination and extension.

Use default location
Location: | ChlUserswxwExport Browse...

File Extension

HTML (html)

[IMS Excel (xdsx)

[IMs PowerPaint (pptx)

[IMms word (.docx) i
[JrDF (-pdf) !

| Select Al || Deselect Al

Mext > Ensh || Cancel
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17.4.2. Requirement — Export test results
connected to requirements to Polarion

You can export test results, which is connected to requirement, to Polarion.

1. In the Export Wizard, select [Requirement] -> [Export test results connected to requirements to
Polarion] and click [Next].

Export test results connected to requirements to Polarion. | g E I

Select an export wizard:
type filter text

> [= Coverage
5 [= General
» [= Metrics
5 [= Preferences
~ [= Requirement [
Qb Export test results connected to requirements to Polarion |
Requirement test coverage report |
5 (= Test |
|
|

= Back Finish Cancel

2. Enter the information to connect with Polarion server and click [Next]. You can see the entered

password to click hod button.
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Import requirements from Polarion

Enter the information to access the Polarion server.

Server: |https:ffaImdemo.pnlarion.com

Port  [443

Username: |admin

Password: | wEAEE

= Back Finish Cancel

* The information of Polarion’s demo server is entered in server and port.

User Manual - 3.6_en

+ If you use a local server, enter http://ip address in server and port number of local

server in port.

3. Enter the information of target to export test result and click [Finish].

BR Export test results connected to requirements to Polarion

Export test results cted to

(%, There are no test results to export.

qui ts to Polarion

[m]

x

Project: TEST(TEST)
Document: | Testing/Test Specification ~ | | 2 Requirements

Type: Test Case

TEST-101  User name must be validated whena 11
TEST-152  User name must be longer than 3 cha 1
TEST-151 User name must contain at least one 1 1
TEST-148  Password must differ from the user n: 1
TEST-148  Password must contain at least one i 1
]

1]
0
o
1]
1]
TEST-147  Password must be validated when the 0

(SRR =]
o O oo oo

D Title Success Failure Error Mot Exec... Total

Cancel

* Project : Select a project to export test results. The project from which the requirements

were imported is selected by default.

* Document : Select a document and a content to export the test results. You can export test

results without selecting a document.

* Type : Select a type of work item to export the test results.

Page 219 of 322



Suresofttech User Manual - 3.6_en

17.4.3. Requirement — Export test results to
V-SPICE

You can export test results to V-SPICE.

1. In the Export Wizard, select [Requirement] -> [Export test result to V-SPICE] and click [Next].

My Export O X

Select F
Export test results to V-SPICE. H

Select an export wizard:
type filter text

» [= Coverage

> [= General

» = Metrics

» [ Preferences

v [= Requirement
b Export test results connected to requirements to Polarion
=2+ Export test results to V-SPICE
Requirement test coverage report

» [= Test

= Back Next = Finish Cancel

2. Enter the information to connect with V-SPICEserver and click [Next]. You can see the entered

password to click = button.
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B Import requirements from W-SPICE O *

Import requirements from V-SPICE

Enter the information to access the W-SPICE server.

Server: | http:// |

Port  |32080 |

Username: | |

Password: | |

= Back Mext = Finish Cancel

3. Enter the information of target to export test result and click [Finish].

i Export test results to V-SPICE O >

Export test results to V-SPICE

Select target information to export test results.
(3#The table below shows only test results related to the requirements of the selected target)

Project: | WBS_TEST

D Title Success Failure Error Mot Exec... Total
WBS_TEST_ WBS_TEST_REQ_O 1 0 1 0 2
WBS_TEST_ WBS_TEST_REQ_3 2 ] 0 0 2
WBS_TEST_  WBS_TEST_REQL6 1 0 1 0 2
WBS_TEST_ WBS_TEST_REC 8 1 0 0 0 1

< Back Met= | [ Fmsh ][ cancel |

* Project : Select a project to export test results. The project from which the requirements
were imported is selected by default.

* If there are no tests connected with a requirement in the selected V-SPICE project, the
list of requirements is not displayed. All test information is exported even if the
requirements list is not displayed.
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17.4.4. Requirement — Requirement test
coverage report

You can generate requirement test coverage report in excel format.

1.

2. Select the path to export requirement test coverage report and click [Finish].

My Export

Select

Export the requirement test coverage report.

O

>

Select an export wizard:
type filter text

» [= Coverage

> [= General

» = Metrics

» [ Preferences

v [= Requirement
b Export test results connected to requirements to Polarion
Requirement test coverage report

» [= Test

= Back Next = Finish

Cancel

In the Export Wizard, select [Requirement] -> [Requirement test coverage report] and click [Next].
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e Export Requirement Test Coverage Report O x

Export Requirement Test Coverage Report

Select the path to export the requirement test coverage report.

Path: | D-texport | | Browse... |

Mext = | Finish | | Cancel |

3. You can check the exported report by clicking [Open Folder] .

eue Report export successed x

@ The report is generated.

COpen Folder | | Confirm
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17.4.5. General — Export project

The project can be exported including the project settings and the test. The exported project can be
imported with [Import Project].

1. In the Export Wizard, click [General] -> [Export Project].

B eport a *
Select ﬁ
Export the project, including project settings and tests. H

Select an export wizard:
type filter text

» [= Coverage
w [ General
I= Export Project
¥ [= Metrics
s [= Preferences
y [= Test

< Back Mext = Finish Cancel

2. Select the project to be exported and the export path and click [Finish].
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. Export Project

Export Project
Export the project, including project settings and tests.

Project:

I =ik

1 of 1 selected.

Fath:

Deselect All

Mext = Finish

Cancel

User Manual - 3.6_en
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17.4.6. Coverage — Export Coverage

You can export the coverage information measured in the project as a file in Coverage Shared Data
(*.csd) format. The exported coverage can be imported with [Import Coverage].

1. In the Export Wizard, select E)overage]_-> [Exp(_)_rt Cov_erage] and click [Next].
. Export O x

Select F

Export the project's coverage information as 3 Coverage Shared Data File H
Format(*.csd).

Select an export wizard:
type filter text

v [= Coverage
== Export Coverage
= General
= Metrics
= Preferences
= Test

= Back Mext = Finish Cancel

2. Select the project that you want to export coverage information and click [Next].
B export Coverage O X

Export Coverage

Export project coverage

Project:

Select All

Deselect All

1 of 1 selected.
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3. Enter the directory path to export and click [Finish].
B eport Coverage O >

Export Coverage

Select a directory to export the file for sharing coverage
information(*.csd).

Directory path: |Z:‘N\export | | Browse... |

Next > Finish | | Cancel | 5

4. A file with the same name as the project name is created.

5] | Texports

Size  Modified
4 606 2020-03-31 16:29
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17.4.7. Test — Export test

The test information created in the project can be exported at once. Before a project is not analyzed or if
there is no test information (Unit/Integration Test, Stub) created, the export cannot be carried out.

1. Click [Test] -> [Export Test].
. Export O x

Select /N
Export test information H

Select an export wizard:
type filter text

= Coverage

= General

= Metrics

= Preferences

v = Test

{=| Create Test Report
k| Export test

?
?
?
?

= Back Mext = Finish Cancel

2. Select the project that tests are exported and click [Next].
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B Export tests O b4

Export tests

Export project's test infermaticns.

Project:
=5 test Select Al
Deselect All
1 of 1 selected.

3. Select the export path, the unit test items, the integration test items, the stub items, and the
options, and click [Finish].
B eport tests O >

Export tests

Export project's test informations.

Export path: | Z:wexported_test Search...

Unit Test
Test
Test Data

Integration Test
Test
Test Data

Stub
(® Connected Stub
() All Stub

Cption
] Ovenwrite existing test files without warning
[JExport only checked tests in Unit/Integration Test View.

LxBack [ Nexts Cancel
a. In [Export path], enter the path to export the test.
b. In [Unit Test] group, check whether to export [Test] and [Test Data] respectively.
c. In [Integration Test] group, check whether to export [Test].
* When exporting the integration test, it is exported with the test data in a set.
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d. [Stub] group, select the stub to be exported among [Connected stubs] and [All stubs].

+ Connected stubs: The stubs connected with the test to be exported. If the stubs have
no link with the test or the test to be exported is not selected, it does not export that
stubs.

« All Stub: It exports all the stubs created in the project.

e. In [Option] group, choose whether to overwrite the existing test file when they exist, and
whether to export only the tests checked in the Unit/Integration Test view.
4. Click [Open Folder] button in the message “Test has been exported successfully.” to check the test
exported in the folder where it is saved, or click [Confirm] to finish the export.
- Export tests *

@& The test has been exported successfully.
W' Open the path exported?

j Open Folder Cenfirm

* From Controller Tester 2.6.14 or later version, when exporting tests, [testinfo.export] file
is created in the project directory exported.
(testinfo.export: the file that records the exported information)
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17.4.8. Test — Generate test report

You can create the test result report in various formats by using Export.

1. In the Export Wizard, click [Test] ->_[Create Tes_t Report]_ _and click [Next].
B eport O >

Select }
enerate test report. H

Select an export wizard:
type filter text

» [= Coverage

> [= General

5 [ Metrics

v [= Preferences

W [= Test
|=| Create Test Report
bp] Export test

= Back Mext = Finish Cancel

2. Select the project that you want to generate the report and the report type.

Page 231 of 322



Suresofttech User Manual - 3.6_en

B Export O b4

Export Test Result
Select Project and Opticn

Project:
test Select All

Deselect All

1 of 1 selected.

Cption
File coverage report (format: XLS)
[1Report for each test (format: XLS)
[ Test stub report (format: XLS)
[[]Report with external coverage
[JUncovered function report (format: XLS)

= Back Mext = Finish Cancel

a. In [Project], select the project that you want to generate the report
b. In [Option], check each report to be exported.

Report type Description

Generate reports of covered functions for each files in the

File coverage report )
selected project.

Generate reports of test result and coverage for each test in the

Report for each test i
selected project.

Test stub report Generate a report of stubs created in the selected project.
Report with external Generates a report containing the external coverage in the
coverage selected project.

Uncovered function Generate a report of the uncovered function in the selected
report project.

3. Select the location where the reports are exported and the report file extensions and click [Finish].
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B Export O =

Export Test Result
Select file type to be exported.

[ uUse default location

Location: | D¥export Browse...

File Extension

[CTHTML {html)

[IMS Excel (xlsx)
[IMS PowerPoint ( pptx)
[Ims werd (docx)

[ PDF (pdf)

Select All Deselect All

Mext = Finish Cancel

a. Selecting the checkbox [Use default location] specified “User Account\Export” directory by

default.
b. [File Extension] provides the report file format with html, pdf, docx, pptx and xlsx. The report

file extension can be selected in duplicate.

1. Click [Open Folder] button in the message “Report has been created” to check the report in the

folder where it is saved.
‘B Export Success X

| @l Success Result files location: Z#reportitstub_sample

k. E

: Open Folder Confirm
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17.4.9. Preferences — ToolChain

You can export the information of the toolchain created.

1. In the Export Wizard, click [Preferences] -> [ToolChain] and click [Next].

B Export ooox
Select F
Export ToolChain configuration informations. H

Select an export wizard:
type filter text

> [= Coverage

» [= General

y = Metrics

w [ Preferences
J=| ToolChain

> [= Requirement

y [ Test

= Back Mext = Finish Cancel

2. The list of toolchains registered currently is displayed. Check [Exporting system header] to export

including system header. Enter the_export__path_and cIick_[Finish].
B Tcolchain Export O *

Toolchain Export

Select the toclchain and destination location.

Available Teolchain List:

Defa..  Toolchain Name Description Exporting system header directory Exporting system header
| CPP_TI_TMS320_6000_... CwWorkspace_CCStudicwSoC_Build_...

O GCC 4.7 (32bit) cgooid. 7 2% 32bit

[l GCC 5.3 (32bit) CHgCCHS.3.032bit

O Microsoft Visual Studio... C:wProgram Files (x86)

O Microsoft Visual Studio... C:wProgram Files (x86)

O Microsoft Visual Studio... C:wProgram Files (x86)

O Microsoft Visual Studio... C:wProgram Files (x86)

O iar Mo configured value

Select All | | Deselect All
_ Exporting system header size: 0 / 500 (MB)

Selected the export location: | Browse...

< Back Next > Finish Cancel
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18. Edit Menu

In the Edit menu, you can carry out the functions such as Cut, Copy, Paste, Delete and Find/Replace the

items selected in the view or editor, or undo or redo the last action performed.
Edit Search Project Target Window Help

| Undo Ctrl+Z
10 Redo Ctrl-Y
Cut Ctrl+X

Copy Ctrl+C
Paste Ctrl+W
#K Delete Delete
Select All Ctrl+&
Find/Replace... Ctrl+F

The menu may vary depending on the selected view or editor.
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Search Analysis Result

You can search the result created after analysis.

B search

4" Analysis Result Search] £57 File Searchl

Search string (* = any string, ? = any character):

- | [] Case sensitive

Search For
[ Global variable []Function []Any Element

Scope
(O Workspace (@) Selected resource

Customize...

Search

Cancel

Search word

Enter characters to be searched.

The available wildcards are displayed in the Search dialog box.

« “*”Wildcard string: matches the set of characters containing the empty string.

o “?” Wildcard character: matches all characters.

Search target

Select the target to be searched. The global variable, function or all targets can be searched.

Search range

Select the searching range. It can be searched within the workspace or the selected item range.

File search

A file can be searched.
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B search O >

<" Analysis Result Search | E7 File Search

Containing fext:

| v | [] Case sensitive

* = any string, 7 = any character, % = escape for literals: * 7 %) [ Regular expression

File name patterns (separated by comma):

| * V| Choose...

(* = any string, 7 = any character, Ix = excluding x)

[] Derived resources

Customize... Replace... Cancel

Text included

Enter a character to be searched. To search a file, the field must be empty.
Click [ V] to select the characters searched recently.
The available wildcards are displayed in the Search dialog box.

« “*”Wildcard string: matches the set of characters containing the blank string.
+ “?” Wildcard character: matches all characters.

e To search “*”, “?” or “\” character, enter a backslash before the characters in order to indicate that
you do not use these characters by “\ *” wildcards. (Ex: “\?” or “\ \")

File Name Pattern

Enter the pattern of all file names for the files to be searched by using the specific expression.
The wildcards that can use the file name pattern are displayed in the Search dialog box.

12 311

Wildcard string: matches the set of characters containing the blank string.
« “?” Wildcard character: matches all characters.
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20. Project Menu

In the Project menu, you can execute the operations for the project (open, close, initialize).

Project Target Window Help
Open Project
Close Project

E .2 Initialize Project...

Generate command line interface M| file
Collect project log

1 Properties

Open Project

You can open a closed project selected in the Test Navigator view.

Close Project

You can close an open project selected in the Test Navigator view.

Initialize Project

You can initialize all the open projects in the workspace or the selected projects in the project list below.

If you initialize the project, all analysis results are cleared.
B initialize O x

Initizlize will discard all analysis information.

(O Initialize projects selected below

=zlib

2 zlib_copy
= zlib_copy_copy

= zlib_copy_copy_copy
122 zlib_merged

coe

Generate Command Line Interface INI File

Based on the project information selected in the Test Navigator, you can create the configuration file
needed to execute the Controller Tester in CLI environment.

Collect Project Log

You can export the log file of the project selected in the Test Navigator view into the specified path.
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Properties

You can see the information or change the settings for the project selected in the Test Navigator view.
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21. Window Menu

In the Window menu, you can open the same new editor as an active editor, open a perspective or a
new view, and see the preferences.

Window Help
Mew Editor
Open Perspective ¥
Show View S

Save Perspective As.
Reset Perspective...

Close Perspective 1

Preferences

New Editor

It copies the selected source code editor or test editor.

Open Perspective

You can select and open the perspective registered in Controller Tester.

Show View

You can select and open the view registered in Controller Tester.

Save Perspective As

Saves the perspective reconfigured by the user as the other name.

Reset Perspective

Resets the perspective into the initial state.

Close Perspective

Closes the perspective currently open.

Preferences

You can check or change the settings currently applied to the tool.
For more information, please refer to Preferences
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In the Help menu, you can find manuals, troubleshooting guides, tutorials, license settings, changing and
reverting analysis settings, and information about the installed product.

Help

Welcome

Show Manual
Show Troubleshooting Guides
" Cheat Sheets...

Lo License.
[] Parser Config >
ede  About Controller Tester

Welcome

You can see the welcome page that appears when the tool is executed for the first time.

lugin (:62) - o x

T00L SW ENGINEERING SUPPORT COMPANY

TOOL

S CONTROLLER TESTER

Unit/Integration Test Tool

Show Manual

You can see the Controller Tester User Manual.
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oNTRoLLER TEsTER USer Manual 36

| English

N -
e Before Starting &
<
Overview
Purpose of Document
Install This document provides the information on how o use the CodeScroll Confroller Tester Product.
Uninstall
Overview »
Run
SetlLicense Need more help with this?

Don't hesitate to contact us here.
+ Seta Toolchain (Analyzer)
Auto-registration of Taolchain
Add a Toolchain
Edit a Toolchain e L

Duplicate a Toolchain
Remove a Toolchain
Export a Toolchain

Import a Toolchain
v Create a Project
CIC++ Project with Source Files

CI/C++ Project from Embedded

CUCs+ Praiort frne Visnal Sturdia

Show Troubleshooting Guides

You can see the Controller Tester Troubleshooting Guides.

controLLer TesTer Controller Tester Troubleshooting Guides 36 (

arch | English

~ Controller Tester Troubleshooting Guide =&

v Controller Tester
Troubleshooting Guide
B e follloatie This is a guide to solving common problems you may encounter using Controller Tester
array members
How to increase heap memory in

« How to assign values to flexible array members.
JAVA when memory is low

How to increase heap memory in JAVA when memory is low

« Project DB file (*.csp) is damaged due to abnormal termination

« Testrun.exe crashes when testing QNX software

« When a specific function is not displayed in the coverage view

« If the error message is not displayed after the project analysis fails

« The screen is cut off when the Windows display magnification is not 100%

Project DB file {*.csp) is damaged
due to abnormal termination

Testrun.exe crashes when testing
QNX software

When a specific function is not

displayed in the coverage view

If the error message is not displayed
after the project analysis fails

The screen is cut off when the

« Windows.h file not found

If INFO [ut hio] runTest testrun exit code(105) is displayed in the log and the unit test is not
executed

« When “Extract Toolchain Info” fails

Windows display magnification is
not 100%

‘Windows h file not found

Messages display abnormally in the error view

* When testing with source code containing C++20 items.

« Errors that may occur during test execution
IFINFO [ut.hio]: runTest:testrun exit « When cannot find global values after importing integration test
code(105) is displayed in the log and ) . . h §

« “C2118 : negative subscript” error occurs during fest execution
the unit test is not executed

« SDK version issue when using Visual Studio 2015 toolchain
‘When “Extract Toolchain Info” fails

« Issues during installation of Controller Tester
When cannot save a large control flow graph as a image file
« When workspace is broken

Messages display abnormally in the
ermor view

Cheat Sheets

You can run cheat sheets on how to use Controller Tester.
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& Cheat Sheet Selection ot

Select the cheat sheet to open:
(® Select a cheat sheet from the list:

> [= Controller Tester Basic Usage

() Select a cheat sheet from a file:

Browse...

() Enter the URL of a cheat sheet:

0K Cancel

Modify Parser Config

You can modify the parser config by entering the compressed file provided by SureSoft Technologies,
Inc.

How to use

1. Select [Help] > [Parser Config] > [Modification...] menu.

Help
Welcome E_
(7) Help Mew Proje
L} License.. |
|| Parser Config > < Modification...
B About 5 Revert...

2. Click [Open...] to select the compressed analysis setting file and enter the changes of analysis
settings to [Comment] text as an option.
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B Parzer Config
Medification

Select a parser config file.

Parser config: ||

Open...
Comment:
oK Cancel
3. Click [OK].
B Parser Config X
Modification
Select a parser config file.
Parser config: | Z:#parserConfig.zip Open...
Comment: 000 compiler settings have been added.
Concel

Format of the parser config file

User Manual - 3.6_en

* The directory [parserConfig] must exist immediately when opening the compressed file as shown

in the figure below.
* The extension is “zip”.

5 ] ‘ ¥ ZwparserConfig zip

Size
241 261

Revert the Parser Config

You can revert the parser config by selecting one among the previous parser configs.

How to use

1. Select [Help] > [Parser Config] > [Revert] menu.

Packed Size
40758

Help
Welcome E:_
@ Help MNew Proje
L} License... |
|1 Parser Config » = Modification. .
B About 5 Revert

2. Check the parser config to be reverted in the list of the existing parser configs and select [OK].
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B Parzer Config X

Revert
Press 'Ok’ button.

Date Comment
O initial
2020-03-31 10:38:15 ok Compiler analysis settings updated.

ook Compiler analysis settings updated.

0K | | Cancel

Information

You can see the information and version of the product installed.

. Apout Controller Tester O X
CodeScroll Contreller Tester RTV(Remote Target Verifier) + Target Plugin
(x64)
Version: 3.2.2

() Copyright Suresoft Technologies Inc. All Rights Reserved.
Visit http://www.suresofttech.com/
b

#it CODESCROLL

cee

Installation Details

Click [Installation Details] to see the features installed and plug-in.
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23. Troubleshooting

If it conflicts with the security program at installation

Some security programs may stop running the tool installation package. If an error occurred, temporarily
stop the security program operation and proceed with the installation again.

If the product does not operate after specifying the
workspace when executing it

When executing the product for the first time, the global data of CodeScroll is stored in \APPDATA\ path.
If access to this path is restricted, the product may not be operated.

To solve this problem, please use the feature to set the global data path.

Setting method: Enter the global data path to be set instead of —g default (default value) in CodeScroll.ini
file. (the same if a case of -g or —global and csc.ini file)

If the -g option is not given, the dialog for setting any global data path when executing the product for the
first time is displayed. If canceled here, it is set to the default path.

If it is installed and run in Windows Vista/7

It can only be run with the User Access Control (UAC) features disabled.

If you want to use it without disabling UAC, change the directory during installation so that it is not
installed under the Program Files.

In addition, the Windows accounts for installation and execution must be the same and must be installed
with an administrator account.

If an analysis is failed or Compile (pre-processing) error
occurred

It is the state of source code that the test cannot be run. Please check the compile/link flag and header
file/library settings.

You can check the settings in [Preferences] -> [Toolchain settings].

If all settings are correct (if it is possible to build without any problems in the actual development
environment (IDE etc.)), please contact SureSoft Technologies, Inc.

If it fails to run all test cases

This is because the test engine operation is blocked by the firewall. The test engine loaded in memory
when executing the test must be added as an exception to the firewall setting to run normally.

If it fails to register toolchain automatically

If it fails to register toolchain automatically due to some problem with toolchain information installed on

Page 246 of 322



Suresofttech User Manual - 3.6_en

PC, the toolchain auto-registration feature can be turned off. (--disableAutoToolchain option)

* Add --disableAutoToolchain option to CodeScroll.ini file

Etc.

For other issues, please refer to the Troubleshooting Guide.

Technical support
If you find any problems, please contact the Technical support contact below.

* help@suresofttech.com
* +82-2-6472-2800
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24. CONTROLLER TESTER Target Plug-in

Introduction

Controller Tester Target Plug-in complements the functionality of the default Controller Tester.
Controller Tester allows you to automate testing in your own host environment. In other words, you run
the test in a software development environment (normal PC). Controller Tester Target Plug-in allows you
to run tests of Controller Tester in a real embedded target environment. This makes it easy to check
whether the test results are the same in the host and target environment and to run tests that cannot be
executed in the host environment because of factors dependent on the target environment.

Page 248 of 322



Suresofttech User Manual - 3.6_en

24.1. Target Environment Settings

To run tests in a target environment using Controller Tester Target Plug-in, you need to enter information
about the target environment.

Controller Tester Target Plug-in builds a test harness using information about the target environment
entered by the user and automatically gets the results of running in the target environment.

The target environment can be set in the project properties page or in the new target test project wizard.

Target environment settings

Target environment settings are divided into basic information and detailed settings.
b GMU Compilers » geoc b 5.3 others b [l Elialls

After entering the basic information, detailed settings that require input are displayed.

Settings

Analysis Name Value

Build Toolchain Name Micresoft Visual Studio 2010 (32bit)

Run Status This toclchain is supported.

e C Compiler C:#wProgram Files (x86)#%Microsoft Visual Studio 10.0%VC#bintclexe
System Header(C Compiler) C:#Program Files (x86)#Microsoft Visual Studio 10.0%VCHRATLMFCH..
Library(C Compiler) C:#Program Files (x86)#Micresoft Visual Studio 10.0%VCRATLMFCHLI..
C++ Compiler C:#Program Files (x86)#Microsoft Visual Studio 10.0%VC#bin¥clexe
System Header(C++ Compiler) C:#Program Files (x86)#Microsoft Visual Studio 10.0%VCHATLMFCH...
Library(C++ Compiler) C:#Program Files (x86)wMicrosoft Visual Studio 10.04VCHRATLMFCHLI...

Description:

Target environment detailed settings

Target environment detailed settings are divided into the analysis, build, run, and etc.

Category Description

The toolchain information is displayed, and in the case of a target test project, the target

Analysis compiler related settings required for analysis are displayed.

Build The settings for building the test software are displayed.

Run Settings for running tests and getting results in the target environment are displayed.
etc. Other settings are displayed. (Program entry point, etc.)

Required settings for each category are indicated in red. Depending on whether the required settings for
each category are entered or not, the behavior when clicking the [Run] button is different as shown
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below.

Required settings

Description
completed category
None Test run impossible
Analvsis If you click [Run], it overwrites the original source code with the test code. To
i
y perform the test, the user must manually build and run the test.
) ) If you click [Run], it builds the test code. To perform the test, the user has to
Analysis, Build
manually run the test on the target.
Analysis, Build, Run Automatically run tests in the target environment.

Import target test results

Controller Tester Target Plug-in saves and imports the result of running the test in the target
environment in log format.

If you do not use the debugger, you need the settings for saving the target test results(Log interface) and
the settings for importing(Target Log Collector — Preferences).

Log interface

Log interface is a setting for saving the test results in the target environment. Log interface is written in
the form of a source code that is actually run in the target environment.

B properties for target O X
type filter text When running the target test, it will build and run the test code. [CRA-VEZ 4
Inclusion and Exclusion
Info » GNU Compilers b gcc b 5.3 b others b nodebugger Import Target Envircnment Seitings
 Target test Settings
Target set |
Test Analysis ‘ Batch script: | P-#Example_Project#CTTP test#run.bat Browse.
Build 3 You must select an execution script (.bat) that will run the project on the target after the build
Run Log interface
etc
filewrite ~  Restore Defaults
1#include "cs_TFX_types.h" ~
2
3FILE *fpw;
4char filePath[] = "C:\\Users\\x\\AppData\\Reaming\\Codescroll\\ TargetLogCollects
5
6void cs_io_initialize()
8 fpw = fopen(filePath, "w");
9}
10
11void cs_io_finalize()
2]
13 fclose(fpw);
1
15
16void cs_io_flush() {}
18void cs_io_putbyte(char v)
19 v
< >
< >

Apply and Close Cancel

Log interface structure

Function Description

viod cs io initialize() Initial function for transfer

void cs io finalize() Transfer end function

void cs_io flush() Remaining data transfer function

void cs_io putbyte (codescroll byte v) 1-byte data transfer function
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Import target log automatically

The target log, which is the result of the test execution, can be automatically imported through the target
log collector. For the target log collector settings, please refer to [Target Log Collector] in Target Log
Collector and Target Test Preferences.

Import target log manually

If the target log cannot be imported automatically, you can import the target log manually.

Import from a log file

1. After selecting an analyzed project, click [Target] -> [import Target Test Log] -> [Import from Log

File...] in the global menu.
Target  Window Help
#  Run Target Test | E_';_

=5

. *4 Import Target Test Log > Import from Log File...
Import from Target Log Archive...

Impert from Target Log Collector...

2. Select a target test log file and click the [OK] button.
B import 2 target test log x

Import a target test log
Select the log file of target test.

Path: | | Browse...

oK Cancel

Import from a target log archive

1. After selecting an analyzed project, click [Target] -> [import Target Test Log] -> [Import from

Target Log Archive...] in the global menu.
Target  Window Help

®  Run Target Test | E.';. El:
1]

. =4 Import Target Test Log > Import from Log File...
Import from Target Log Archive...
Import from Target Log Collector...

2. Select a target log archive file and click the [Next] button.
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B import from Target Log Archive m] K

Import from Target Log Archive
Import the target test results from the archive in the target log collector archive directory.

Path || Browse...

< Back Next = Finish Cancel

3. Check a target test log file and click the [Finish] button.
B import from Target Log Archive O X

Select Test Logs
Select the target test logs to import.

Select target test logs: [ Show excluded logs Show applied logs
Project Test code generation time Status
target 2020-04-01 13:57:26 Applied
target 2020-04-01 13:52:13 Applied
target 2020-04-01 Applied
target 2020-03-31 Applied
target 2020-03-311 Applied

3 You can import the target test logs that are neither applied(v’) nor excluded() on next time.

< Back Next = Cancel

Import from target log collector

’

1. To get logs from the target log collector, you need to select ‘Use the default target log collector
from [Preferences] -> [Target Test] -> [Target Log Collector].
2. After selecting an analyzed project, click [Target] -> [import Target Test Log] -> [Import from

Target Log Collector...] in the global menu.
Target  Window Help
®  Run Target Test | E'_;

- R

=3 Import Target Test Log > Import from Log File...
Import from Target Leg Archive...
Import from Target Log Collector...

3. Click the [Yes] button to import all the new target test logs or click the [Show details] button.
B mport Target Log b4

@& Do you want to apply the target test logs to project 'target'?

=

: Show details Yes Mo

4. If you click the [Show details] button, check the target test log to be imported and click the [OK]
button.

Page 252 of 322



Suresofttech

B import a target test log

Select Test Logs

Select the target test logs to import.

Select target test logs:

2 [ Show applied logs

Project
target
target
target
target

Test code generation time
2020-04-01 1352113
2020-04-01 13:50:45
2020-03-31 174535
2020-03-31 174148

Status

Applied
Applied
Applied
Applied

3 You can import the target test logs that are neither applied(v) nor excluded(X) on next time.

Result

[ ox

Cancel
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After the import is completed, you can check the target coverage information in the coverage view.

=) Coverage 52
Target coverage information of 'target project

BiElE = 5

| Target Function Statement I Branch MC/DC | Function CalllFunchnnl

%add(dnublg double) == 100.00% _.. == 100.00% .. == 100.00% == 100.00% ==y

2 divide(double, double) == 100.00% ... ™= 100.00% ... ™= 100.00% .. == 100.00% . ==y

3 longhameFunctionTestiongMameFun... == 100.00% .= N/A = N/A —100.00% ==Y

4 longhameFunctionTestiongMameFun... ™= 100.00% .= N/A = N/A ==100.00% ==Y

5 longhameFunctionTestiongMameFun... == 100.00% .= N/A = N/A —100.00% ==Y

6 main() = 45459 [ W 2000% (. = M/A = 5555% (_ =Yy

7  multiply(double, double) == 50 00% (.. == 50.00% (.. ==(000% (0. ==5000% (. ==y

8  subtract{double, double) = 100.00% ..— N/A = NSA = 100.00% .. ==Y
Total 67.34% (... 53.84% (... 50.00% (... 73.91% (... N/A

* [Import Target Test Log] may fail because the target test run information and the host
test information are not valid if the host test case, source file, function information, etc.

are changed before importing the log of the target test result.
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24.2. C/C++ Target Test Project
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The C/ C ++ target test project (hereinafter referred to as the target test project) is a project for target

environment testing. Target testing projects do not support host testing.

Create a target test project

C/C++ Target Test Project with Source Files

1. Create a project by selecting [File]-> [New]-> [Other ...] in the global menu and clicking [C/ C ++

Target Test Project with Source Files].

. New

Select a wizard

Create C/C++ target test project with source files.

Wizards:
type filter text

= C/C=++ Project
(= C/C++ RTV Project
~ [= C/C++ Target Project

[F] C/C++ Target Test Project with Source Files
5 Create a C/C++ target test project with Build Information
= Cther

[ C/C+ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)

= Back Mext > Einish

Cancel

2. Enter a project name and select a toolchain to use.

. Mew Project

New Project

Create 3 C/C+=+ target test project with source files.

] bed

Project name; ‘scurce,target

Location: ‘Pwproduct,WUrkspace'Mt,sj,02

Select Toolchain

Select StéEus Teclchain Mame Description

CPE T TNI5320 6000 _50C_Unit

GCC 4.7 (32bit)

GCC 5.3 (32bit)

Microsoft Visual Studic 2010 (32bit)
Microsoft Visual Studio 2010 (32bit_6...
Microsoft Visual Studio 2015 (32bit)
Microsoft Visual Studio 2015 (32bit_6...
gees

gcc 5.4

iar

oooooooEOb
(<RI TR N N N N NN )

Toolchain Setting

< Back Next = Finish

Cancel

3. After selecting the basic information of the target environment, enter the detailed settings for each

category and click the [Next] button.
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4. Select the source files under test and click the [Finish] button.

B new project

Target Environment Settings

& Please fill out the target environment information. (% Red: a required field)

» GNU Compilers » gcc b 5.3 b others b please select a debugger Import Target Environment Settings
Settings
—_
Analysis Name Value
Run Toolchain Name GCC 5.3 (32bit)
ey Status This toolchain is supported
C Compiler C:#gecHS.3.0432bitwbinsgcc.exe
System Header(C Compiler) CHgCeH OWinclude;CHgECHS 3.0,
Library(C Compiler)
C++ Compiler C#OCOHS 3 D#32bitwbingg«+ exe
System Header(C~~ Compiler) CHgCCH OWincludettc- - cHgocs.
Librany(C++ Compiler)

Description:

< Back Next >

Finish Cancel

B new Project

New Project

Choose source files

] X

Top Directory: ‘PWExamp\e_Prmecth'Nmasz\ib—l.Z.S

| Browse.

Directory File

~ [m] zlib-1.2.8

>

|type filter text

v

[ -settings

[] amiga adler32.c
[ as400 COMprass.c
[ centriz cre32.c

[ dec

[] examples
[0 msdos

[ nintendods
Oold
[Janx

[ test inffast.c
[] watcom o !nﬂate )

VIV Y Y VYY Y Y YV Y

Text file written list of source files

Browse...

% The entered text file is separated by ' or newline character.

15 items selected

Remove

< Back Next = Cancel
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C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)

1.

Create a project by selecting [File]-> [New]-> [Other ...] in the global menu and clicking [C/C++

Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)].
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. New [} X

Select a wizard —
Create a new target test project from CodeWarriori*xml), Green Hills MULTI [
(*.gpj) or NEC PM=+(*.prw, *.prj). |

e )

Wizards:
type filter text

» [ C/C++ Project

» [= C/C++ RTV Project

~ [= C/C++ Target Project
?f C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)
[ C/C++ Target Test Project with Source Files

5 Create 3 C/C++ target test project with Build Information
» [ Cther

= Back Mext > Finish Cancel

Enter a project name and select a toolchain to use. After selecting the toolchain, import the

embedded project file to test. Currently, embedded projects supported by Controller Tester are
CodeWarrior, Green Hills, and NEC.

B new Project u] x
New Project

Create 2 new target test project from CodeWarrior(+xml), Green Hills MULTI(*gpj) or NEC PM-=(*.prw, *.prj)

Project name: ‘ Embedded_Target_Build ‘
Location: ‘ P:#Product_Workspacewct 3102 ‘
Select Toolchain

Select  Stafus  Toolchain Name Description

] CPP_TI_TMS$320_6000_SaC_Unit

] v GCC 4.7 (32bit)

H~| v GCE 53 {32hH

] v Microsoft Visual Studio 2010 (32bit)

] v Microsoft Visual Studio 2010 (32bit_6bit)

O v Microsoft Visual Studio 2015 (32bit)

] v Microsoft Visual Studio 2015 (32bit_64bit)

] =] gees

] ] gec 54

O ] far

Toolchain Setting
Import Setting
Embedded Project File: Browse.
< Back Next > Finish Cancel

After selecting the basic information of the target environment, enter the detailed settings for each
category.
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Create a C/C++ Target Test Project with Build Information
1,

B new project

Target Environment Settings

& Please fill out the target environment information. (% Red: a required field)

» GNU Compilers » gcc b 5.3 » others b please select 2 debugger

Import Target Environment Settings

Settings
—_
Analysis Name Value
Run Toolchain Name GCC 5.3 (32bit)
ey Status This toolchain is supported
C Compiler C:#gecHS.3.0432bitwbinsgcc.exe
System Header(C Compiler) CHgCeH OWinclude;CHgECHS 3.0,
Library(C Compiler)
C++ Compiler C#OCOHS 3 D#32bitwbingg«+ exe
System Header(C~~ Compiler) CHgCCH OWincludettc- - cHgocs.
Librany(C++ Compiler)

Description:

< Back Next > Finish Cancel
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Create a project by selecting [File]-> [New]-> [Other ...] in the global menu and clicking [Create a

C/C++ Target Test Project with Build Information].

B new O *

Select a wizard

Create C/C++ target test project with the build information |

Wizards:
type filter text

» = C/C++ Project

» [ C/C++ RTV Project

~ [= C/C++ Target Project
?f C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)
[£] C/C++ Target Test Project with Source Files

5 Create a C/C++ target test project with Build Information
» [= Other

= Back Mext > Finish Cancel

2. Enter a project name and select a toolchain to use. After selecting the toolchain, Specify the path

of the created Makefile and build script as the build directory and write the build command. You
can choose a script file to set the build-environment from the [Advanced] menu.
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B new project u] X
New Project
Create 3 C/C-~ target test project with 2 build command. (e.g. makefile or build script)
Project name: [Target_Build |
Location. [ P#Product Workspacewct_3_1_02 |
Select Toolchain
Select  Stafus  Toolchain Name Description
| [] PP T ThiS338 000, S0, Unit
] v GCC 47 (32bit)
v GCC 5.3 (32bit)
O v Microsoft Visual Studio 2018 (32bit)
] v Microsoft Visual Studio 2018 (32bit_64bit)
O v Microsoft Visual Studio 2015 (32bit)
O v Microsoft Visual Studio 2015 (32bit_64bit)
m] a gees
m] ] gec 54
O (] iar
Toolchain Setting
Import Setting
8uild Command
mazke clean all
Build Directory: |
Note: The final project name is determined by combining the entered project name
with the module name extracted from the build information. (e.g. [project name] extracted module name)
Advanced
< Back Next » Finish

3. After selecting the basic information of the target environment, enter the detailed settings for each
category.

B new Project

Target Environment Settings

€ Please ill out the target environment information. (¢ Red: 2 required field)

» GNU Compilers b gec b 5.3 b others b plesse select 3 debugger Import Target Environment Seftings

Settings
1
Analysis MName Value
Run Toolchain Name GCC 5.3 (32bit)
e Status This toolchain is supported.
C Compiler CWgCowS 3 Ow32bitwhinwgcc exe
System Header(C Compiler) CHgOCHS OwincludecHgecks 3.0,
Library(C Compiler}
C+ Compiler CHgCCHS.2.0932biItWbIng g« exe
System Header(C++ Compiler) CHgCCw! OWIncludewcs+ CRgecH.

Library(C++ Compiler)

Description:

! Toolchains with invalid compiler paths cannot be selected when creating a target test
project.
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24.3. Target Test Run Settings

You can check the target test execution settings on the target test page in [Project]-> [Properties].

Coverage kind

You can select the type of coverage(Statement, Branch, MC/DC) to be measured for the target test.

Target for coverage measurement

In addition to the functions under test, you can select functions to measure coverage.

All functions called by the target Measures coverages for all functions called by the function
function under test.

The functions called by the previous Includes functions whose coverage was measured from the
test run previous test.

Testcase run

You can choose how to run the test case.

Loads and runs all test cases on target at once.
Each test case is affected by the previous test case run results.

Run at once

Repeats loading and running each test case on target.
Run one by one )
It takes longer than running at once but uses less memory.
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24.4. Target Log Collector

The target log collector is a server that collects target test results and sends them to Controller Tester.
Collecting target test results methods are largely divided into communication and file scanning.
Supported communication protocols and scannable file formats are as follows.

Protocol TCP, UDP, UART

File format Target log(text), memory dump(Hex, Intel HEX)

Installation

The target log collector is automatically installed when Controller Tester is installed.

Run

When [Use the default target log collector] is checked in [Preferences] -> [Target Test] -> [Target Log
Collector], the target log collector starts collecting target test results.
If you use TargetLogCollector.zip after extracting it, run TargetLogCollector.exe in the unzipped directory

at the Windows command prompt.
B preference ) [m] x

type filter text Target Log Collector Frw-
Analysis
Editor
Exclusion Use the default target log collector
Performance
Perspectives
Register external comman:
Report

@ Auto-detect of target log is off.

3 If check 'Use the default target log collector', the target log collector which is installed with Controller Tester run automatically.

Target log collector info:

Source File Types [ Terget Log Collector X :l
v Target Test .
RTV Server ol The default target log collector has been run
by Test E
Theme (S Labs) Auto-detect on
E
ToolChain

[Apply and Close Cancel

Settings

It can be set through the ‘settings.ini’ file in the target log collector installation path, and the options are
as follows.

[LogReceiveServer] Settings for receiving target test results

port TCP, UDP communication port

protocol Communication protocol for receiving target test results
timeout Connection timeout

lastString String representing the end of the data

serialPort Serial communication port
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baudRate
dataBits
stopBits

parity
flowControl
[ScanLog]

dir

fileExtension
[LogSendServer]

port

(Windows: COM#, Linux: /dev/ttyS#)

Serial communication settings
Serial communication settings
Serial communication settings
Serial communication settings
Serial communication settings
Settings for file scanning

Directory to scan

File extensions to scan(Scan all files if blank)

Settings for communication with Controller Tester

Target log file transfer port
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o¥s timeout: If there is no data transmission for the specified number of seconds from the

last reception, the received data is saved.

dir: When a target log file (text, hex) is entered in the specified directory, the target log
collector recognizes it.
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24.5. Preferences
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Target Test

You can set whether to open the target test step notification dialog when the target test is run.

B Freferences

type filter text
Analysis
Editor
Exclusion
Performance
Perspectives

Register external comman:

Report
Source File Types
w Target Test
RTV Server

Target Log Cellector

Test
Theme (CS Labs)
ToelChain

O X

Target Test o v -

Target test run
Prompt for executable target test step

Restore Defaults Apply

Cancel

Apply and Close

Target Log Collector

Set target log collector information to use and whether to automatically detect target test results. If you
turn on automatic target log detection by clicking the [Atuto-detect on] button, a new target test result is
received from the target log collector at a specified automatic detection cycle.

I ereferences

type filter text
Analysis
Editor
Exclusion
Performance
Perspectives

Register external comman:

Report
Source File Types
~ Target Test
RTV Server
Target Log Cellector
Test
Theme (CS Labs)
ToolChzin

o e

Target Log Collector (Cd v

@ Auto-detect of target log is off.

Open configuration directory

3 If check "Use the default target log callector’, the target log collector which is installed with Cantroller Tester run automatically

[ Use the default target log collector

Target log cellector info:

1P address: [127001 |

Port [2020 |

Autc-detect cycle(sec) ‘EE

Auto-detect on

< 5 Restore Defaults Apply
Apply and Close Cancel

Target Log Collector Setting Description

Auto-detect cycle(sec)

IP

Port

Cycle to check for new target test results
IP on the server or PC where the target log collector runs

Target log collector's communication port
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25. CONTROLLER TESTER RTV(Remote
Target Verifier)

Introduction

Controller Tester RTV helps you perform automated testing in your Linux environment.

After installing the Controller Tester RTV server in your Linux environment and completing the default
configuration, you can use the Controller Tester RTV client to perform the RTV test as easily as you
would in a hosted environment.

For information on how to install the Controller Tester RTV server in your Linux environment, please
contact the Technical support contact on bottom of the Troubleshooting page of this document.

Supported Operating Systems

Server: Linux (RHEL, Ubuntu, Debian, Fedora based)
Client: Windows 7/10

Page 264 of 322



Suresofttech User Manual - 3.6_en

25.1. RTV Server Settings

In order to use Controller Tester RTV, you need to add a RTV server with Controller Tester RTV server
installed.

The RTV server can be added in [Window] -> [Preferences] -> [RTV Server].

B Preferences o X

type filter text RTV Server v v
5 Analysis
Editor Server name [ Port Description Add
Exclusion 6060
Language 6060
performance 5060
Perspectives G
Register externzl comman: -

Edit

Remove

Source File Types
v Target Test
RTV Server
Target Log Collector
> Test
Theme (CS Labs)
> ToolChain
key

‘Apply and Close] Cancel

Add a RTV server

1. Click [Add] in [Window] -> [Preferences] -> [RTV Server].

B preferences [u] X

type filer text RTV Server SoSvo
> Analysis
Editor Server name P port Description Add |
Exclusion 5060
Language 6060
Performance 6060
Perspectives . 560
Register external commani
Source File Types
v Target Test
RTV Server
Target Log Cellector
> Test
Theme (CS Labs)
> ToolChain
key

Edit.

Remove

‘Apply and Close] Cancel

2. In the [Add RTV Server] window, enter the RTV server information.

Add RTV server X
|

Add RTV server

Enter the RTV server information

Server name: ‘

Description ‘

Connection Test

oK Cancel

The server name only accepts characters that can be used as Windows file names and
can not be modified after adding the RTV server.

o=
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Edit a RTV server

1.

2. On the [Edit RTV server] window, edit the server information and then click [OK].
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Click the [Connection Test] button to check the connection status with the RTV server you entered.

. The RTV server connection test

@ Connecticn successful

X

If the connection test with the RTV server is successful, click the [OK] button to add the RTV

server.

B Add RTV server

Add RTV server

Enter the RTV server information

Server name: ‘ RTW_Server

1P: ‘211 116.222.223

Port: [e060

Descripticn ‘ RTV server for test

Connection Test

You can see that the RTV server has been added.

[ preferences

type filter text
> Analysis
Editor
Exclusion
Language
performance
Perspectives
Register external comman:
Source File Types
- Target Test
RTV Server
Target Log Collector
5 Test
Theme (C$ Labs)
» ToolChain
key

RTV Server

[m] x

v

Server name

Port

Description

6060
6060
6060
6060

RTV Server

Add
Edit

Remove

Apply and Close]

Cancel

Double-click the server in the RTV server list, or select the server and click the [Edit] button.

B preferences

type fifter text
5 Analysis

RTV Server

v

o X

Editor
Exclusion
Language
Performance
Perspectives
Register external comman:
Source File Types
 Target Test
RTV Server
Target Log Collector
5 Test
Theme (CS Labs)
» ToolChain
key

Server name

Port

6060
6060
6060
6060

Description

Add

Edit |

Remove

Apply and Close]

Cancel
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3. You can see that the RTV server information has been edited.

B edit RTV server

Edit RTV server

Enter the RTV server information

Server name: | 211.116.222.233

IP: [p11.116.222.233

Port: |6060

Description: | RTV Server

Connection Test

Cancel

B preferences

type fifter text RTV Server

> Analysis

Editor Server name P
Exclusion

port Description
6060

Add...

Language

6060 RTV .S.e_rver

Edit

Performance
Perspectives
Register external comman:
Source File Types
v Target Test
RTV Server
Target Log Collector
> Test
Theme (CS Labs)
> ToolChain
key

6060
6060

Remove

Apply and Close]

Cancel

Remove a RTV server

If you no longer use the RTV server, you can remove it.
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When you remove a RTV server, the toolchain or project resources associated with the RTV server are
deleted from the client environment(Can not be deleted if a RTV toolchain added from that RTV server

exists).

1. Select a server from the list of RTV servers and click the [Remove] button.

v Target Test

5 Test

» ToolChain

[ preferences

type filter text RTV Server

5 Analysis

[m] x

v

Editor Server name Ip
Exclusion

Language

performance

Perspectives

Register external comman:
Source File Types

RTV Server
Target Log Collector

Theme (CS Labs)

key

port Description
6060
6060 RTV Server

Add

Edit

6060
6060

| Remove |

Apply and Close]

Cancel

2. Click the [OK] button in the [Remove RTV Server] window(Depending on the size of the RTV
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server resource, it may take a minute or two).
[ Remove RTV Server

X

@ Are you sure you want to remove RTV server( 2

I oK { | Cancel

3. You can see that the RTV server has been removed.

[ preferences.

RTV Srver
> Analysis

Editor Server name P Port
Exclusion T
Language =
performance Remove
Perspectives
Register extemal comman:
Source File Types

~ Target Test

[m] x

Sy w

Deseription Add

RTV Server
Target Log Collector
> Test
Theme (CS Labs)
> ToolChain
key
< >
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25.2. RTV Toolchain Settings

RTV toolchain

To build and run a test in a RTV environment with Controller Tester RTV, you need to set the toolchain
(compiler) information for the source file being tested.

This chapter describes how to add, edit, and delete the RTV toolchain information that has previously
extracted from the RTV environment where the Controller Tester RTV Server is installed.

(For extracting toolchain information from your RTV environment, please contact the Technical support
contact at the bottom of this document Troubleshooting page.)

Add an RTV toolchain

1. Click the [Add RTV Toolchain] button in the [Window] -> [Preferences] -> [Toolchain] window.

B preferences [u] *
type filter text ToolChain [CR IR 4
Analysis
Editor St.. Toolchain Name  Target Co.. Conversion Tool.. Description Add Toolchain.
Exclusion . o
oo v CPPTITMS320.. Notinus.. Microsoft Visual A TV Toolchain
per v’ GCC 47 (32bit) In using
errormance v GCC53 (3200  Inusing Edit
Perspectives
v Microsoft Visual... In using
Register external comman: Duplicate...
v Microsoft Visual.  In using
Source File Types v
Target Test Microsoft Visual... I using Remove
o Test v Microsoft Visual... In using
Coverage 3 gees inusing  GCC 5.3 (32bit)
Export test data s gecsa Inusing  GCC 5.3 (32bit)
External editor v dar Notinus.. GCC 5.3 (32bit)
Perspective Open Confiquration Folder
Type Partition Detail
Unit Test View
Virtual Address
Theme (CS Labs)
ToolChain
key
< >

Apply and Close Cancel

* If you do not have a RTV server, the [Add RTV Server] window will appear first.

2. If you select the RTV server in the [Add RTV Toolchain] window, you can see the list of RTV
toolchain extracted from the RTV server. Select the toolchain you want to add and click the [OK]
button.

.Add RTV Teelchain [} X

RTV Toolchains
Select RTV toolchain

RTV server: (211.116.222.233 ~

RTV Toolchains:

O gigec.2:4; o
O gige
[ gees
gec_5.4 ©

3. The toolchain information is imported from the RTV server (Depending on the size of the system
header, it may take 1 to 2 minutes). When the operation is completed, you can see that the RTV
toolchain has been added.
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B Preferences u] X
type filter text ToolChain [CR =R
> Analysis
Editor S Toolchain Name Target .. Conversio... Description Add Toolchain
E::,I;\j;\;l ; gzpéz;r:;szizojoooisnc’umt Net in. Micresoft ‘Add RTV Toolchain
it) In using
Performance v GCC 5.3 (32bit) In using Edit.
Perspectives ¥ Microsoft Visual Studio 2010 (32bit) In using
Register external commans Duplicate.
Source Flle Types ¥/ Microseft Visual Studie 2010 (3261 8261t)  In using
5 Target Test v Microsoft Visual Studio 2015 (32bit) In using o
o Test ¥ Microsoft Visual Studio 2015 (32bit_64bit)  In using
Coverage LI ] Inusing _GCC 33,
Export test data o gee S s Inusing _GCC5.3
External editor ar Notin.. GCC 5.3
Perspective Open Configuration Folder
Type Partition Detail

Unit Test View
Virtual Address
Theme (CS Labs)
» ToolChain
key

Toolchain Name

C Compiler

C== Compiler

Conversion Toolchain Name
Status.

Description

RTV server

gcc 5.4
Just/bin/gee
Just/bin/g+
GCC 5.3 (32bit)

This toolchain is supperted

211.116.222.233:6060

[Apply and Close Cancel
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4. If you select the RTV toolchain added, you can see that the information of the RTV server is

displayed on

the [Detail].

Edit an RTV toolchain

1. Select the toolchain to be edited and click the [Edit] button.

B cdit Toolchain [m| X
Toolchain(Method Manage)
Manage teclchain information.
Toolchain Information
MName: | gce 5.4 |
Description: | |
Env Script: | Browse...
Configuration: b Unknown(current usage)
C C++
Compiler |fu5rfbinfgcc | Browse...
Linker: |fu5rfbinfgcc | Browse...
Archiver: | | Browse...

System Header:

C#UsersexwappDatawRoamingwCodeScroll#1.1%targetSource®211.116.222.233% | add.
C:WUserswxwAppDataWRoamingWCodeScrol 1.1 WtargetSourcew211.116.222.233%| - —
C#tUsersitxitAppDatatRoaming#tCodeScroll#1.1#targetSourcew211.116.222. 2334 | Edit
C#UserswawAppDataRoamingwCodeScroll 1. 1 WtargetSource®211.116.222.233%|
C#UserswcnAppDatawRoaming#CodeScroll# . 1#targetSourcew211.116.222.233%| | Remove

Automatically extract toolchain information from entered compiler.

Up
Down
< >
Libraries:
Add...
Edit...
Remove

v

Extract Toeolchain Info

< Back

Mext =

G

2. Edit the RTV toolchain information.

3. Click the [Fin

ish] button.
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Duplicate an RTV toolchain

The duplication for an RTV toolchain is not provided.

Remove an RTV toolchain

Select the toolchain to delete and click the [Remove] button.

! If you have a project associated with the toolchain you want to delete, you can not use
the project normally after deleting the toolchain.

Import/Export an RTV toolchain

The RTV toolchain can not be imported/exported because it can be added through the RTV server.
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25.3. Create a RTV Project
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Create an RTV project to test the source files that exist in the RTV environment.

When building source files in the RTV environment, you can extract the information needed to create the

RTV project.

This chapter describes how to create an RTV project by using pre-extracted source file build
information(using the Controller Tester RTV Server Utility) in the RTV environment, or extracting
information at the same time as building the source file.

To create an RTV project, run the [Create Project Wizard].
Click [File] -> [New] or Shortcut.

>

C/C+=+ Project with Source Files

C/C++ Project from Embedded{CedeWarrior, Green Hills, NEC)
C/C++ Project from Visual Studic Project

C/C++ Project from Existing CodeScroll Project

Create a C/C++ project with CPI File

Create a C/C++ project with Build Information

C/C+=+ Project from RTV Build
C/C++ Project from RTV Build Cemmand

|
B
i3]
ol
]
B
o
o

C/C++ Target Test Project with Source Files
C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)
Create a C/C++ target test project with Build Information

Other.

Ctrl+N

File Edit Search Project Target Window Help
New
Clos Ctrl+w
Close All Ctrl+Shift+W
Sav Ctrl+5
Save All Ctrl+Shift+S
Rename. F2
Refresh F5
Switch Workspace.

g Import.

&3 Export
Properties Alt+Enter
Exit

jtrjinj'
_tr_stor

C/C++ Project from RTV Build

It is selected when creating an RTV project using pre-extracted source file build information (using the

Controller Tester RTV Server Utility) in the RTV environment.

1. Enter the project name in [Project name].

B new Project m} *
New Project
Create a new project from the RTW server.
Project name [RTv_project_1| |
Location: | P#Product Workspacettct 3.1 02 |
Select Toolchain
Default Toclchain Name RTV server Description
O gees 211.116.224.99
gec 54 211.116.222.233
Toclchain Setting
< Back Mext = Finish Cancel

2. Alist of RTV toolchains appears in the [Select Toolchain]. Select the RTV toolchain to use.
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3. After selecting the toolchain, then click the [Next] button. You can see the list of source file builds
pre-extracted from the RTV server.

B new Project o x
New Project
Select the build project on the RTV server.
RTV server: 211.116.222 233
Build Project List
Filter: | Show only creatable project ~
Target Project Build Time Build Location (o]
[] [ARRAYZ]All Sources 2020-03-31 11:03:37 /home/test/test/test09
[ [ARRAY2]z.0ut 2020-03-31 11:03:37 /home/test/test/testog
[J [NEWNEWMERGEJAIl Sources ~ 2020-03-27 15:15:08 /homestest/test/test0s
[ [NEWNEWMERGE]a.cut 2020-03-27 15:15:08 /home/test/test/test0s
O [ZUBJAIl Sources 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11
[ [zZuiB]NetLinked 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11
[ [ZLBlexample 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11
[ [ZLiBlexampless 2020-03-27 12:32:07 /homestest/testy/zlib-1.2.11
[ [zugllibz.a 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11
[ [ZuBiminigzip 2020-03-27 12:32:07 /homestest/testy/zlib-1.2.11
[ [ZLB]Iminigzipe4 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11
[ [5PROJAII_Sources 2020-03-27 114335 /home/test/test/test03 v
T : Tt : T >
< Back Next > Einish Cancel

* Among the generated projects, ‘All_Sources_Project Name’ is a project that combines all
the source files of the modules captured by csbuild. Since this project is a combined
project without considering whether it is built or not, it may not be able to perform the
test normally.

4. In the [Build Project List], select the item for which you want to create the RTV project and click
the [Next] button.

B new project m] s

New Project
Select the source file.

RTV server  [211.116.222.233 |

Target Project: [[ZLIB]libz |

Directory File
~ [&] home |t§-‘pe filter text ‘
~ (W] test
~ [m] test zutil.c S
Zib-12.11 gzwrite.c

gzclose.c

deflate.c

gzread.c

COMpress.c

inftrees.c

trees.c

uncempr.c

infback.c

gzlib.c

cre32.c o

15 items selected

< Back Next = Cancel

5. After selecting source files to be tested, click the [Finish] button to create the project.

C/C++ Project from RTV Build Command

It is selected when creating an RTV project by extracting information at the same time as building the
source file. The user builds the source file on the RTV server using the build command and then creates
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the RTV project.

1.

2.
3.

4.

6.

Enter the project name in [Project name].

B new Project m} *
New Project
Create a new project from the RTV server.
Froject name: |RTV_PrDj9(t_1| |
Location: | P#Product Workspacettct 3_1_02 |
Select Toolchain
Default Toelchain Name RTV server Descripticn
O gees 211.116.224.99
gec 54 211.116.222.233
Toclchain Setting
< Back Mext = Finish Cancel

A list of RTV toolchains appears in the toolchain list. Select the RTV toolchain to use.
After selecting the toolchain, click the [Next] button. The build will be performed on the RTV server
from which the selected toolchain was imported.

B new Project [m) x
New Project

Please enter 2 Build command.

RTV server:  [211.116.222.233 |
Build Dlr(émryl V|
Build Comman

Build Log

Use default location

Location P:#Product Workspacewct 3_1_02# metadata Browse.

Open Directory
........ T T B =

Enter the path to build from the RTV server (for example, the directory where the make file is
located), and enter the build command.

In [Build Log], specify the path to the build results file.

The default location is the .metadata directory of the workspace. If you uncheck [Use default
location], you can change the path.

After entering the required information for the build, click the [Next] button. It builds the source file
on the RTV server with the entered build command (depending on the build target, it can take a lot
of time).
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7. When the build is complete, a list of built projects appears.

B rew Project | X

New Project
Select the build project on the RTV server.

RTV server:  [211.116.222.233 ]

Build Project List

Filter: |Show only creatable project v|
Target Project Build Time Build Location @
[ [ARRAYZ]ANl Scurces 2020-03-31 11:03:37 /home/test/test/test09

[ [ARRAYZ]a.0ut 2020-03-31 11:03:37 /home/test/test/test09

[ [INEWNEWMERGEJAISources  2020-03-27 15:15:08 /home/test/test/test0s

O out 7 13:15:08 /homey/test/test/test03

O [zuBlAll_Sources 2020-03-27 12:32:07 /home/test/test/zlib-12.11

[ [ZLB]NotLinked 2020-03-27 12:32:07 /homey/test/test/zlib-1.2.11

O [zuBlexample 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [ZLBlexampless 2020-03-27 12:32:07 /homeytest/test/zlib-1.2.11

O [zLEllibz.a 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

O [ZUBIminigzip 2020-03-27 12:32:07 /homey/test/test/zlib-1.2.11

[ [ZLIBIminigzip64 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [SPROJAIl_Sources 2020-03-27 11:43:35 /home/test/test/test03 .
< >

* Among the generated projects, ‘All_Sources_Project Name’ is a project that combines all
the source files of the modules captured by csbuild. Since this project is a combined
project without considering whether it is built or not, it may not be able to perform the
test normally.

8. In the [Build Project List], select the item for which you want to create the RTV project and click
the [Next] button.

B new project [m] x

New Project

Select the source file.

RTV server:  [211.116.222.233 |

Target Project: | [ZLIB]libz.a ‘

Directory File
v (@] home || type filter text ‘ |
~ [m] test
v [m] test zutil.c o
zlib-1.2.11 gzwrite.c

gzclose.c

deflate.c

gzread.c

COMpress.c

inftrees.c

frees.c

uncompr.c

infback.c

gzlib.c

cre3zc P

15 items selected

9. When creating the RTV project, select the source file to be included and click the [Finish] button to
create the project.

RTV build command

To create a project from build information, you must use the csbuild command on the build command.
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csbuild command

The cs is a utility that automatically extracts the Controller Tester project configuration information of the
source files that are built so that the Controller Tester RTV project can be created.

How to use csbuild
Prefix the existing build command with csbuild.
* Ex) make — csbuild capture make

csbuild option

new: Generate the necessary information before extracting build commands. Specify the toolchain with
the --toolchain option and the project name with the --project option.

* EX) csbuid new --toolchain=gcc5.4 --project=PRJ
! The --toolchain option is required.

capture: Creates an RTV project by performing build command extraction.
* EX) csbuild capture make
convert: Convert a STATIC project to an RTV project.

* EX) csbuild convert
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25.4. Refresh/Add RTV Source Files
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Refresh RTV source file

If the source file is modified and rebuilt on the RTV server, the [Refresh RTV Source File] allows the
revised content to be reflected in the project.

:

2.

If the source file is modified but not rebuilt, the changed contents will not be reflected.
If you modify the source files on the RTV server and then rebuild, you must perform a full

build.

In the [Test Navigator] view, click the [Refresh RTV Source File] context menu.

g Test Navigator

N

W

L E

v

Mew
Delete
Rename...

Import...
Export...

Refresh
Close Project

Quality Management Tools

Run Target Test
Import Target Test Log
Refresh RTV Scurce File..

Add RTV Scurce File...
Collect project log

Create Unit Test...
Run Test

Rebuild and Run Test
Run RTV Test
Reanalyze

Merge Project coverage...

Properties

Delete
F2

F5

F11

Alt+F11

Alt+Enter

When you create an RTV project, you can see the latest build information for the source files you
selected (display a change notification if the build has changed). Click the [Finish] button to
confirm your changes.
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B Update to RTV server scurce m] X

Update to RTV server source
Refresh the source file features of the RTV server.

The build up of the RTV server has been changed.(Changed target build time: 2020-03-27 12:32:07)
Current target build information
Server name:  211.116.222.233
IP: 211.116.222.233
Build Time: 2020-03-27 12:32:00
Build Location: shome/test/test/zlib-1.2.11

==

3. After confirming the changes, click the [OK] button.

B Update to RTV server source [m] x

Update to RTV server source

The Source File has been changed to the source file of the RTV server.

Change
source file content
( 211.116.222.233://home/test/test/zlib-1.2.11/adler32.c Modified

Add RTV source file

You can add source files to your RTV projects via the [Add RTV Source File] if new source files are
added and built on the RTV server, or if only some source files are selected when you create the RTV
project.

' If the source file is added but not rebuilt, the changed contents will not be reflected.
If you build the target server after adding the source file, you must perform a full build.

1. In the [Test Navigator] view, click the [Add RTV Source File] context menu.
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> gt
(=
It

e 2

W W W W

SLESE

R ki ki ke

b

G E

v v v

TR Test Mavigator

Mew

Delete
Rename...
Import...
Export...

Refresh

Close Project
Quality Management Tools

Run Target Test
Impaort Target Test Log

Refresh RTW Source File...
Add RTV Source File...
Collect project log

Create Unit Test...
Run Test

Rebuild and Run Test
Run RTV Test
Reanalyze

Merge Project coverage...

Properties

Delete
F2

F5

F11

Alt+F11

Alt+Enter
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2. When you create the RTV project, you can see the latest build information for the selected source
file (show change notification if the build has changed). Click the [Next] button to confirm the new

3.

file list.

B Adding files from the RTV server build

Adding files from the RTV server build

Add a source file from the RTV server build
(when adding scurce files, perform a refresh.)

Server name:
IP:
Build Time:

Current target build information

211.116.222.233
211.116.222 233

2020-03-27 12:32:00

Build Location: /home/test/test/zlib-1.2.11

The build up of the RTV server has been changed.(Changed target build time: 2020-03-27 12:32:07)

< Back Next >

Cancel

In the [New file], select the file you want to add and click the [Finish] button.
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[ ~dding files from the RTV server build

Adding files from the RTV server build
The project selected in the table is reflected in the project.

New file:

source file content Select All
[0 211.116.222.233;//home/test/test/zlib-1.2.11/inflate.c New Clear Al
O 211.116.222.233;//heme/test/test/zlib-1.2.11/inftrees.c New
O 211.116.222.233//heme/test/test/zlib-1.2.11 /trees.c New
[0  211.116.222.233://heme/test/test/zlib-1.2.11/uncompr.c New
O  211.116.222.233://heme/test/test/zlib-1.2.11/zutil.c New

0/5 Selected

After confirming the changes, click the [OK] button.

B &dding files from the RTV server build [m] x
Adding files from the RTV server build
The source file was updated from the RTV server build, and 2 new file was added
Change
source file content
(27118223 235 home st testziib- T 2 T infiate.c New
211.116.222.233.//home/test/test/zlib-1.2.11/inftrees.c New
211.116.222 233://home/test/test/zlib-1.2.11/trees ¢ New
211.116.222.233://homeytest/test/zlib-1.2.11/uncompr.c New
211.116.222.233.//homeytest/test/zlib-1.2.11/zutil.c New

User Manual - 3.6_en
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25.5. RTV Project Information

Test navigator

1. The icon for the RTV project is displayed as =
2. The RTV server’s information ([server name: IP]) is displayed after the name of the RTV project.

TE Test Navigator
v 18 RTV_project [ 1
+ (5 Default Module

[ adler3z.c
[ compress.c
L4 cre32c
[ deflate.c
[ gzclose.c
L4 gzlib.c
[ gzread.c
L[4 gzwrite.c
[ infbackc
L4 inffastc
L] inflatec
L] inftrees.c
L] trees.c
L} uncompr.c
L zutile
(2 Headers

3. Source files in the RTV project can not be modified(the source file editor of the RTV project is
read-only).

Project property

Info
1. The RTV project displays the RTV server and project information.
B8 Properties for RTV_project ] X
type filter text Info R

Inclusion and Exclusion .
e Project Information
info

Target test Path:  /RTV_project

Test Type:  Project

Location: Pr/Product Workspace/ct_3_1.02/RTV_project
RTV Sever Information

Server name:

IP;

Project: [ZL1B]libza

Build Time: 2020-03-27 12:32:00

Build Location: /hometest/test/zlib-1.2.11

‘Apply and Close Cancel

2. If the general project has set the toolchain as the RTV toolchain, information about the RTV server
from which the RTV toolchain was imported is displayed.
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[ properties for RTV_project o X
type filter text Info GrDrw
::;L“S'E” and Exclusion Project Information
Trget test path:  /RTV_project
Test Type:  Project

Location: P-/Product Workspace/ct_3_1.02/RTV.project
RTV Sever Information

Server name:

IP:

Project: [ZUBJlibza

Build Time: 2020-03-27 12:32:00

Build Location: /home/test/test/zlib-1.2.11

Apply and Close Cancel

Module/File property

Build

1. The RTV project can not change the RTV toolchain that was set when the project was created.

2. However, if the RTV toolchain you set originally is deleted, you can change it to another toolchain.

3. In general projects, you can change the toolchain to the RTV toolchain. Changing to the RTV
toolchain changes all toolchain settings (modules and source files) under the project and allows
you to run the RTV tests.

4. The project with the RTV toolchain can not change the compiler settings of the source file (the
module’s linker configuration can be changed).
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25.6. Run RTV Test

The RTV project allows you to run RTV tests without any additional setup. To test a general project in
the RTV environment, you must set the toolchain of the project to the RTV toolchain created from the
RTV server to be tested.

Run all RTV tests

It runs the selected tests in the [Unit Test] view and the [Integration Test] view.
RTV tests can be run in the following way.

1. Select the project to be tested, right-click it and click [Run RTV Test].

T Test Navigator
- e

VR e ,
]

O stut 3¢ Delete Delete

0 targ

g zlib

& zlib, &

g zlib i1 Export..

g j:; Refresh FS

Rename. F2
Import.

Close Project
Quality Management Tools >
Run Target Test

Import Target Test Log >

F

Refresh RTV Source File.
Add RTV Source File.
Collect project log

Create Unit Test...

Run Test 2k}
Rebuild and Run Test

Run RTV Test Alt+F11
Reanalyze

Y & v

Merge Project coverage..

Properties Alt-Enter

Run RTV unit test

Runs the selected test in the [Unit Test] view.

Run RTV test

[Run] button In the [Unit Test] view.

T R~ S-S = :
¥ _ e Target] Y I[5& | Global Search (Ctrl+3) Q : = @
lest Import Export Properties Preferences . g B = E?l &

=) Coverage - MC/DC 7% Stub (¢ Class Factory <% Control Flow Graph =% Call Graph T Function Call Hierarchy ®7) Emor

Unit Test Integration Test Beg H~ =0

v  Statement Coverage
T
(0/0/0)0 -

type file, function, test, state, issue
Name Result Coverage
adler32(unsigned 1o
adler32_combine un
adler32_combine64
adler32_combine_[.
adler32 z
compress
compress2(uns

STSTTSDS
cocoooo
ccococos o

Run RTV test case

[Run RTV Test Case] context menu (multi-selectable) in the [Unit Test] view.
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Unit Test Integration Test

EH-r v 9
v  Statement Coverage

(0/0/00 -
type file, function, test, state, issue
Name Result Coverage @
~ @ adler32iunzigned 0/0/00 -
v adler32(unsiz , unsig ©/0/00

e

s Copy crl=C

(ca Paste Ctrl+V
> adler32 Duplicate Ctrl+D ©0/0/0)0 -
» & adler32 Dugplicate multiple times 0707000 -
> B adler32 0/0/0)0 -

1 Delete Delete b |

> adler32 x ©/0/00 -
> compres Add Test Case ©/0/000 -
> &4 compres  ogt output Value -> Expected Value ©/0/0)0 -
> [ compres ©/0/0)0 -
N crcdd i Target Output Value -> Expected Value ©/0/00 B
> crc32_b Generate binary for debugging /07000 -
> @ cre32_c PR et o 0/0/0)0 -
> cre32_c ©/0/00 -
N cre32 ¢ [™ Run Test Case ©/0/0)0 B
> cre32 1 Add Stub. 0/0/00 -
B L w0 smn -

Run RTV integration test

Runs the selected test in the [Integration Test] view.

[Run] button In the [Integration Test] view.

N A & od | Targetl ¥ [& [ Global Search (cti-3) Qilm|[=e
Import Export Properties Preferences - e

]
*

Test

") Coverage - MC/DC &% Stub [¢) Class Factory < Control Flow Graph o2 Call Graph g Function Call Hierarchy ¥ Error

Unit Test Integration Test

BoL|EBE- Y =0

v Statement Coverage

(0/0/00 -

type file, test, state, issue

Name Result Coverage
v INTEGRATION_@ /0/0)0 -

> adler32(unsigned long, st unsigned ch /0/0)0

> adler32_combine(unsigned long, unsis o/0/00

> adler32_combine6d un=i m/0/000

> adler32_combine_(u @/0/0)0

> adler32_z(unsigned 0/0/0)0
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25.7. RTV Test Results

Coverage

You can change the coverage information (host, target, host/target merged) displayed in each view and
editor through the coverage view menu in the top toolbar menu.
You can check the detailed information of each view in Test Perspective.

Test results

You can change the test results through the host/target settings menu on the dashboard.

% zlib =] B x» A B fe] Host @ Y [ [ Global Search (Cirl+3) Qlil 2|
Mew Project New Test Import Export Properties Preferences - 4

= Tg || show Coverage | :"| Coverage — MC/DC 7% Stub (¢ Class Factory <& Control Flow Graph =0 Call Graph T Function Call Hierarchy ) Error

Stub

The RTV build stubs that are created when running the RTV test is distinct from the build stubs which
are created when running the host test.

istub % tHEBEs Y= 0
Manage stub items of zlib project. (2 items)

type filter text Stub code  Configuration

© adler32(unsigned long, const unsigned char %\ styb key: ‘5822949563779393816 ‘
v © void _tr_align(struct internal_state * 5)

2 4 align 1 Related Files: ‘P:wExampIe_Projectwcwdipwzlib-W.2..‘
| A% tr_align_2 - RTV Build Stub | Test
Description:
RTV Build Stub
2 > Sav
Type Description

& Target build stub Auto-created stub during RTV tests
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26. CONTROLLER TESTER RTV(Remote
Target Verifier) Target Plug-in

Using Controller Tester RTV (Remot Target Verifier) Target Plug-in, software developed in Linux
environment can be tested in a real embedded target environment. You can run RTV target after
installing Controller Tester RTV server in Linux and setting target environment in Controller Tester. For
information on how to install the Controller Tester RTV server in your Linux environment, please contact
the Technical support contact on bottom of the Troubleshooting page of this document.

The followings are how to create Controller Tester RTV Target Plug-in project and run a test.

+ RTV Server Settings

* RTV Toolchain Settings

+ RTV Target Environment Settings

» Create a RTV Target Project

* Refresh/Add RTV Target Source Files
+ RTV Target Project Information

*+ Run RTV Target Test

Supported Operating Systems

Server: Linux (RHEL, Ubuntu, Debian, Fedora based)
Client: Windows 7/10
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26.1. RTV Server Settings

For RTV server setting to use Controller Tester RTV Target Plug-in, refer to RTV Server Settings.
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26.2. RTV Toolchain Settings

For RTV toolchain setting to use Controller Tester RTV Target Plug-in, refer to RTV Toolchain Settings.
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26.3. RTV Target Environment Settings

To run tests in a target environment using Controller Tester RTV Target Plug-in, you need to enter
information about the target environment as with Controller Tester Target Plug-in. Using information
about the target environment entered by the user, Controller Tester builds a test harness in RTV server
and run in the target environment. Target log collector can get the test results automatically.

The target environment can be set in the project properties page or in the new RTV target test project
wizard.

Target environment settings.

Target environment settings are divided into basic information and detailed settings.
RTV target project don’t need to enter the basic information.

RTV target plugin does not need tocolchain selection.

After entering the basic information, detailed settings that require input are displayed.

Settings

Analysis Name Value

Build language ¢

o Toolchain Name gces.4

Py Status This toclchain is supported
C Compiler Jusr/bin/gee
Systemn Header(C Compiler) CrUsersw “#AppDatawRoaming#CodeScroll#1.1%tar
Library(C Compiler)
C++ Compiler Jusr/bin/g++
Systern Header(C++ Compiler) C:itUserst ¥AppDatawRoamingwCodeScroll#1.1%ar...
Library(C++ Compiler)

Description

Target environment detailed settings

Target environment detailed settings are divided into the analysis, build, run, and etc.

Category Description

The toolchain information is displayed, and in the case of a target test project, the target

Analysis compiler related settings required for analysis are displayed.

Build The settings for building the test software are displayed.

Run Settings for running tests and getting results in the target environment are displayed.
etc. Other settings are displayed. (Program entry point, etc.)

Required settings for each category are indicated in red. Depending on whether the required settings for
each category are entered or not, the behavior when clicking the [Run] button is different as shown
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below.

Required settings

Description
completed category

None Test run impossible
Analvsis If you click [Run], it overwrites the original source code with the test code. To

i

y perform the test, the user must manually build and run the test.

) ) If you click [Run], it builds the test code. To perform the test, the user has to

Analysis, Build
manually run the test on the target.

Analysis, Build, Run Automatically run tests in the target environment.

Target environment detailed settings — Build

Settings

e— Use build script
Build Build script:

Run

etc.

Enter a build script path of RTV server into build script area. After entering the build script path,
Controller Tester checks validity of the path. If the path is invalid, build script area is displayed in red and
if vaild, it is displayed in black.

Settings

W Use build script
Build Build script: |;’h0me£ .anrkspacefRT\.-’_Target_ENmanuaI;’buiId.baﬂ
Run
efc.

Target environment detailed settings — Run

Run setting is divided into batch script area and log interface area. Controller Tester checks validity of
batch script area as with build script area. Informations to get results of RTV target test from target
environment is entered in log interface area.

Batch script area

Enter a batch script path of RTV server into batch script area as with build script area.

Analysis Batch script: |/h0me/ “'workspace/RTV_Target_ENmanual/build.bat |
Build Log interface
Run filewrite ~ | Restore Defaults
etc.

1//The file is included in all test source files. ~

Log interface area

The log interface area is a setting to record test result from target environment. The followings are how
to get target log into Target Log Collector.
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* File
» Socket communication (TCP, UDP)
» Serial communication (UART)

To allow target log collector to get test results during recoding the results in file, you modify a path in log
interface into $SMITH HOMES%/targetLogCollector/scan/log/%file name%.

Log interface

filewrite ~ | | Restore Defaults
24 //This function called at test start. ~
23void cs_io_initialize()

26 {

27 //Open the file to save the target test results.

28 pFile = fopen( "/home/ /Suresofttech_CT_SMITH_HOME/targetlLogCollector/scan/log/test.log”, "w" );
291
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26.4. Create a RTV Target Project

User Manual - 3.6_en

Create an RTV project to test the source files that exist in the RTV environment.

When building source files in the RTV environment, you can extract the information needed to create the
RTV project.

This chapter describes how to create an RTV target project by using pre-extracted source file build
information(using the Controller Tester RTV Server Utility) in the RTV environment, or extracting
information at the same time as building the source file.

To create an RTV project, run the [Create Project Wizard].
Click [File] -> [New] or Shortcut.

New O x
Select a wizard —
=
Wizards:
type filter text

(= C/C++ Project
(= C/C++ RTV Project
w [= C/C++ RTV Target Project
3 C/C++ Target Test Project from RTV Build
&% C/C++ Target Test Project from RTV Build Command
= C/C++ Target Project
= Cther

< Back Mext = Finish Cancel

C/C++ Target Test Project from RTV Build

It is selected when creating an RTV target project using pre-extracted source file build information (using
the Controller Tester RTV Server Utility) in the RTV environment.

1. Enter the project name in [Project name] and select the RTV toolchain to use in the [Select
Toolchain]. After selecting the toolchain, then click the [Next] button.
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8 Mew Project [m} x
New Project
Create a new project from the RTV server.
Project name: |test ‘
Location | D:WCT34_workspacewtest ‘
Select Toolchain
Default Teclchain Mame RTW server Description
O geeT.s tired
gees4 tired
Toolchain Setting
® < Back Next > Finish Cancel

2. You can see the list of source file builds pre-extracted from the RTV server(3¥ Among the
generated projects, ‘All_Sources_Project Name’ is a project that combines all the source files of
the modules captured by csbuild. Since this project is a combined project without considering
whether it is built or not, it may not be able to perform the test normally). In the [Build Project List],
select the item for which you want to create the RTV project and click the [Next] button.

E New Project

O .
New Project
Select the build project on the RTV server.

RTV server tired

Build Project List

Filter: | Show only creatable project

Target Project Build Time Build Location

[RTV _Target_ENmanual]All_Sources  2020-11-12 17:16:53 /home/

fworkspace/RTV _T.
[ [RTV Target ENmanualiNotLinked 2020-11-12 17:16:53 /home/

/workspace/RTV_T.

@ < Back Next > Finish Cancel

3. After selecting source files to be tested, click the [Next] button.
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Mew Project O x
)

New Project
Select the source file

RTV server: |t\red ‘

Target Project: | [RTV_Target_ENmanual]All_Sources ‘

Directory File
+ [m] home ‘type filter text |
v [m] -
~ [m] workspace cale.e

RTV_Target_ENmanual

1 items selected

® < Back Next > Finish Cancel

4. After entering the detailed settings for each category and click the [Next] button

m Mew Project [} *
Target Environment Settings
(1) When running the target test, it will ovenwrite the source code with the test code. You can run
the target test manually, or automatically by filling out the required fields on the Build/Run tab.
RTV target plugin does not need toolchain selection. Import Target Envirenment Settings
Seftings
Analysis Mame Value
Build language ¢
o Toclchain Name gces54
etc Status This toelchain is supported
: C Compiler Jusr/bin/gee
Systern Header(C Compiler) Célsersit . #AppDatafRoamingWCodeScroll# 1. 14¥ar...
Library(C Compiler)
C++ Compiler Jusr/bin/g++
Systern Header(C++ Compiler) Ciélsersi _~ ~#AppDataRoamingWCodeScroll#1. 1##ar...
Library(C++ Compiler)
Description:
@ < Back Next = Cancel

C/C++ Target Test Project from RTV Build Command

It is selected when creating an RTV target project by extracting information at the same time as building
the source file. The user builds the source file on the RTV server using the build command and then
creates the RTV target project.

1. Enter the project name in [Project name] and select the RTV toolchain to use in the [Select
Toolchain]. After selecting the toolchain, then click the [Next] button.
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8 Mew Project [m} x
New Project
Create a new project from the RTV server.
Project name: |test ‘
Location | D:WCT34_workspacewtest ‘
Select Toolchain
Default Teclchain Mame RTW server Description
O geeT.s tired
gees4 tired
Toolchain Setting
® < Back Next > Finish Cancel

2. Enter the path to build from the target server (for example, the directory where the make file is
located), and enter the build command. In [Build Log], specify the path to the build results file.
After entering the required information for the build, click the [Next] button. It builds the source file
on the target server with the entered build command (depending on the build target, it can take a

lot of time).
m New Project [m] Y
New Project
Please enter 2 Build command
RTV server. |t\red ‘
Build Dircetory |fhomef /workspace/RTV_Target_ENmanual v‘

Build Comman

gec cale.q

Build Log
Use default location

Location: D#CT34_workspacettesty. metadata Browse.

Open Directory

® < Back Next > Finish Cancel

3. When the build is complete, a list of built projects appears(3¢ Among the generated projects,
‘All_Sources_Project Name’ is a project that combines all the source files of the modules captured
by csbuild. Since this project is a combined project without considering whether it is built or not, it
may not be able to perform the test normally). In the [Build Project List], select the item for which
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! New Project

you want to create the RTV target project and click the [Next] button.

New Project

RTV server. tired

Select the build project on the RTV server.

O

X

Build Project List

Filter:

Target Project

[RTV_Target_ENmanual]All_Scurces

~
Build Time
2020-11-12 17:16:53

Build Location

shome/ Jworkspace/RTV T.
[ [RTV_Target_ENmanual]NotLinked 2020-11-12 17:16:53 /home/ Jworkspace/RTV T.
® T

. MNew Project

New Project

RTV server:

Select the source file

O

X

|hred

Target Project: | [RTV_Target_ENmanual]All_Sources

Directory File
+ [m] home ”type filter text | |
v [m] .
~ [m] workspace calec
RTV_Target_ENmanual
1 items selected
® Ve[

5. After entering the detailed settings for each category and click the [Next] button

After selecting source files to be tested, click the [Next] button.
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CtRE O X
Target Environment Settings
() When running the target test, it will overwrite the source code with the test code. You can run
the target test manually, or automatically by filling out the required fields on the Build/Run tab.
RTV target plugin does not need toolchain selection Import Target Envirenment Settings
Seftings
Analysis MName Walue
Build language c
Run Toclchain Name gecsd
B Status This toelchain is supperted
: C Compiler fusr/bin/gee
System Header(C Compiler) Cr#lsersi . #AppData¥¥Roaming#CodeScroll#1.1#tar.
Library(C Compiler)
C++ Compiler fusr/bin/g++
Systemn Header(C+~+ Compiler) Crlsersi .~ #AppDataWRoamingWCodeScroll# 1. 14tar.
Library(C++ Compiler)

Description:

® < Back Next > Cancel

RTV build command

To create a project from build information, you must use the csbuild command on the build command.
For RTV build command, refer to [RTV build command] in Create a RTV Project
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26.5. Refresh/Add RTV Target Source Files

If the source file is modified or added on the RTV server, the [Refresh RTV Source File] and [Add RTV
Source File] allow the revised content to be reflected in the project. For Refresh/Add RTV Target Source
Files, refer to Refresh/Add RTV Source Files.
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26.6. RTV Target Project Information

Test navigator

* The icon for the RTV project is displayed as =,
* The RTV server’s information ([server name: IP]) is displayed after the name of the RTV target

project.
TgTest Navigator | B 5 ¥ = 8
w % test [tired: 1
v () Default Module

L calce

» Source files in the RTV project can not be modified(the source file editor of the RTV project is
read-only).

Project properties

Info

The RTV target project displays the RTV server and project information.

[8 Properties for test O X
type filter text Info = v -
Inclusi d Exclusi
l::oumn an cluston Project Information
Target test Path: ;*te,r..t
Test Type: Project
Location: D:/CT34_workspace/test/test
RTW Sever Information
Server name: tired
IE:
Apply and Close Cancel
Target test

The RTV target project can set about target test run and RTV environment. For target test run settings,
refer to Target Test Run Settings and for RTV environment settings, refer to Target Environment

Settings.
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Module/file properties

For properties about module or file, refer to RTV Project Information.
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26.7. Run RTV Target Test

Test run

The binary file built in Linux environment can be tested in target environment using RTV Target Plug-in.
For running the RTV target test, refer to Run RTV Test.
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27. DISCOVERY Plug-in

DISCOVERY automatically generates test cases to increase coverage.

The process of executing DISCOVERY is as follows.

» DISCOVERY Install
+ DISCOVERY Execution
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27.1. DISCOVERY Install

DISCOVERY Install

By using the install package, you can install DISCOVERY as follows:

1. Execute DISCOVERY _Installer.exe file.
DISCOVERY _Installer.exe

2. Set the path where Controller Tester is installed and click [Install].

B Install CedeScroll DISCOVERY x

Specify the folder where the CodeScroll is installed,

To install in this folder, clic I*, Click "Browse” to specify a different folder, or enter the
path to the des ally,

Folder:

_Erogram File softwCodescroll Controller Testar 35w Browse. ..

Install Cancel

! If the installation path of Controller Tester is wrong, it will not be installed. If the version
of Controller Tester installed is lower than the version of Controller Tester required to

install DISCOVERY, it will not be installed.

3. After installation is complete, click [OK] to automatically run Controller Tester.
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B Install CodeScroll DISCOVERY x

“to specify a different folder, or enter the

Install

alder:
C:#Program FilesWSuresofts o DISCOVERY installation complete.

Install Cancel
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27.2. DISCOVERY Execution

If you use the [Test Case Generation using Symbolic Execution] feature, test cases that can increase
coverage are automatically generated.

Test Case Generation using Symbolic Execution

1. Generate test cases based on symbolic execution for the selected tests.

e Toolbar in Unit Test View

If you click [Test Case Generation using Symbolic Execution] on the toolbar of Unit Test
View, test cases are generated and executed based on symbol execution for the function/

test checked in Unit Test View.

Unit Test

Integration Test

* Context menu in Unit Test View

Bleeg - ~-=1n

|Test Case Generation using Symbelic Execution

(0/0/0)0

Right-clicking a function/test and selecting the [Test Case Generation using Symbolic
Execution] menu generates and executes a test case based on the symbolic execution.

Unit Test

type file, function, test, state, issue

Integration Test

Name
> > zlibVersj

(933 / 0/ 265) 1198

Result

4 nsm o

@EBE&EEH~- ¥=0

v Statement Coverage

42.8%

(1994/4652)

Coverage

> zlibtompil-l {©} Test Case Generation using Symbolic Execution

100.0% 111
40.4% o0

» O zefree(void
> zcalloc(v
> @@ zErrorisign

> updatewinde ¥
> uncompress:

> uncompress

> tr_static_i

» syncsearch

> slide_hash

> send_tree(=

> O send_all_tr

> scan_tree(=

> read_buf (st
» putShortMSE ;74
> B8 pqdownheap

> longest_mai *
> Im_init(str ¢
> B4 init_block
> inflate_tal
» inflate_fa:
> Gd inflateVali
> inflateUnde

Create Test
Copy Test
Delete

Host Output Value -> Expected Value
Target Output Value -> Expected Value

Test reconfiguration
Set related file
Relevant issues settings...

Import Test Data
Export Test Data

% Add Stub...

Apply Class Code
Select Function

Deselect Function

Generate coverage report

Ctrl+C
Delete

100.0% 22
100.0% (2/2
100.0% (1/1
13.3% 420
94.4% -1 o6
3 100.0% (1/1
9 N/A
10 100.0% (13/12
3 100.0% (13/13
44.0% o000
73.9%
87.8% o=

100.0% 122
100.0% (11/11
94.1% =222

12 100.0% 116
14 40.9% :
22.4% 27765
37.5% =2
42.8% 27

» inflateSyncPoint(struct z_stream_s

0/ 001 60.0% ==

100.0% (14114

100.0% (14714

~

2. You can check the progress information after clicking [Test Case Generation using Symbolic

Execution].

Progress Information

—
i e
- 4

Test Case Generation using Symbolic Execution

Preparing to generate Test Cases using symbolic execution...

Cancel
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! When generating a test case based on symbolic execution, it may take a long time to
generate test cases.

3. When the test case generation is completed, you can check the coverage through the [Test Case
Generation using Symbolic Execution] dialog.

B Results of Test Case Generation using Symbolic Execution O ot

Results of Test Case Generation using Symbolic Execution

Test case generation using symbelic execution is complete.
35t The coverage results for the selected functions are displayed.

Statement Branch MC/DC
79.3% 66.6% 39.5%
{+13.5%) (+23.3%) (+26.8%)
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28. CONTROLLER TESTER CLI(Command
Line Interface)

You can run Controller Tester in CLI environment.
The process of executing Controller Tester in CLI environment is as follows.

e |nstall CLI
* Project Import/Export

+ CLI Settings
« CLI Execution
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Install CLI

By using the install package, you can install CLI as follows:

1. Runthe CodeScroll CLI.exe file.

CodeScroll CLLexe

2. Enter the path where Controller Tester is installed and click [Install].
B Install CodeScrall CLI *

W the folder where the C

a different folder, or enter the

Browse,,,

! If the installation path of Controller Tester is incorrect, it will not be installed.

3. CLIl is installed.
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B Install CodeScroll CLI X

the fold

nt folder, or enter the

Ci¥Program Files®Sureso

Install Cancel
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28.2. Project Import/Export

You can import and export projects in the CLI environment.

Export command

You can export a project using the -e, --export <project top dir> <global top dir> <exp

ort dir>command.

projectlE.exe path: Controller Tester installation path\plugins\com.codescroll.ut_ut_3.x.x\bin.
project top dir: export target project directory.

global top dir: tool global directory.

export dir: Export output directory.

Export output

io: Folder containing the interface implementation file used for target export. Appears on the
global path and does not create it if it does not exist.

target_server: Folder containing RTV target server information. Appears on the global path and
does not create if it does not exist.

factory: Folder used for class factory function. Appears in the project path and does not create if it
does not exist.

pa.ini, ut.ini: Project analysis and test configuration files.

build.mk: RTV project compilation flag file.

link.mk: RTV project link flag file.

ctproject.json: Project setting information and exclusion information.

o

o

o

o

o

infromation: Project information.

exclusions: [Project] — [Properties] — [Inclusion and Exclusion] — [Excluded].
Inclusions: [Project] — [Properties] — [Inclusion and Exclusion] — [Included].
globalExclusions: [Window] — [Preferences] — [Exclusion].
utCoverageExclusions: [Project] — [Properties] — [Test] — [Exclusion of coveragel].
utUserCodelnsertNodes: Fault Injection view.

utClassFactories: Class Factory view.

properties: Project setting information.

globalProperties: Controller Tester global setting information.

» ctsrc.json: Test target source file information.

o

name: Module name.
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o language: Target source language.

o linkFlag: Link flag.

o cmpileFlag: Compilation flag.

> toolchainName: Toolchain name.

o sourceTopDir: Source common parent path.

o src.path: Source file path.

o src.compileFlag: Compilation flag.

« ctaction.json: A file that defines actions to be executed for each step.

o copy: Fields left by the existing copy action migration.

o beforeCreateProject: Actions executed before project creation.

o afterCreateProject: Action to be executed after project creation.

o afterlmport: Action to be executed after import is complete.

o copy action: Description.
= actionName: Action name.
= from: Copy destination.
= to: Path to be copied.
= isDir: Whether a directory.

+ ctmacro.json: The macro information inserted in each json file is replaced with the characters in
the ctmacro.json file.
o If you put it in the json file in the form of ${macro name}, it is replaced with the
corresponding string when imported.
> When exporting, the WORKSPACE and GLOBAL paths are created as blanks in the
ctmacro.json file.

= WORKSPACE: The workspace path of the project to be created when exporting.
= GLOBAL: Global path of PC to be imported.

* The WORKSPACE path and GLOBAL path are required.

Import command

1. You can import the project usingthe # -1, --i <import resource dir> command.
* import resource dir: Import destination directory.
2. Import will create a .import_product folder in the destination directory. In that folder, setup files
(-cpi, .ini) and .bat files used for project creation and test export import are created.

* Create an exportTest folder in the import destination directory and copy the result of
[Project] — [Export] — [Test] — [Export Test] to import the test when importing.
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28.3. CLI Settings

Creates a configuration file to run Controller Tester in CLI environment.

Creating CLI configuration file

» If you select [Project] — [Generate command line interface INI file], the projectName_CLl.ini file
and path.bat file are created in the path selected by the user.
Project | Window Help
Open Project 3

Close Project 4

Sl
.-“F

Initialize Project..

Generate command line interface M| file
Collect project log

Properties

* If there is no selected project, CLLI.ini file and path.bat file that does not contain project
information are created.
[Information]

Item Description
workspace Workspace path.

ct_version Controller Tester version.

* [Information] automatically fills in the values when creating the CLI configuration file.

[Project]
Item Description
create Whether to create a project.
cpi_file If create=true, the path to the . cpi file for project creation.
name Project name.
toolchain Toolchain name (create in case of RTV project).

target_project Target project name (create in case of RTV project).
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! The target_project option must be entered in the same way as the target project name in
[Project]-[Properties]-[Information]-[RTV Server Information].
[Analysis]

Item Description

run  Whether to perform analysis.

[InitializeTest]

Item Description

run  If true, delete all existing tests.

[CreateTest]
Item Description
run Whether to generate unit tests.

It is a function name for generating unit tests. Unit tests can be created for one or more
functions.

When entering multiple functions, they can be separated with a semicolon (;) or Enter.
If there is no target_function list, create unit tests for all functions.

target_function

[ImportTestinfo]

Item Description
run Whether to fetch test information.

testinfo_file Path to the testinfo.export file.

[CreateTestCase]

Item Description

run Whether to create a test case.

mode Test case generation mode. (flat, pairwise, random)

random_testcase_count In case of random, input the number of test cases generated.

[ExecuteTest]
Item Description
run Whether to run unit test.
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remote_target RTV run or not.

run_robust If an error occurs while running a test, whether to exclude non-executable tests.
[Report]
Item Description
run Whether to generate a report.
, Report output path.
output_dir

The default output path is project path.
each_test Whether to generate a report by test.

HTML, XLSX, PDF, DOCX, .
Specify Report Format
PPTX, XLS, DOC, PPT

URL URL of the results report accessible from ITS

Individual import of test information

* By setting run=false in [ImportTestinfo], [[mportStub], [ImportTest], and
[ImportintegrationTest] can be executed individually.

[ImportStub]

Item Description
run Whether to perform stub import.
stub_file Path to the stub file.

stub_dir Path to the stub directory.

[ImportTest]

Item Description
run Whether to perform test import.

.utest file path.
test_source_file When entering multiple source file paths, they can be separated with a semicolon (;) or
Enter.

Path to the test source directory.
test_source_dir If you enter the test source directory path, perform a full test import included in the
directory path.
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[ImportTestCase]

Item Description
run Whether to perform test import.

testcase dir Test case directory path.
_ If you enter the test case directory path, import all test cases included in the directory path.

[ImportintegrationTest]

Item Description
run Whether to perform integration tests and import of test cases.
test_file .itest file path.

st gy COMmon parent path for .itest file.
_ If the test and test case are in the same directory, perform an import.

Create CPI file

CPI file is a configuration file for creating a project in CLI environment. The project is created only when
the [Project] — create option in the CLL.ini file is set to true.

You can set the option to create a project from the CPI template file in the path of Controller Teste

r installation path\plugins\com.codescroll.gp.cli version\cpi.

! You cannot create a project in the CLI environment while using the workspace.

Item Description

Project creation type setting.
General project =1

KIND Get Build Script =2
Visual Studio Import =3
Import Embedded Project = 4

NAME Project name.
LOCATION Location of project creation.
DESCRIPTION Project description.

Project type.

LANGUAGE
Java =0, C/C++ =1

SourceFileProject

Item Description
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T tl t )
IUT_LANGUAGE arget language type

C=0, C++=1, Java=2
DBSCHEMA Global database schema version.
LINKFLAG Link flag.

COMMON_COMPILEFLAG Compilation flag to apply to all TUs.

TOOLCHAIN _NAME Toolchain name.

BINARY_KIND Binary type.

SOURCE_TOP_DIR Source file top level directory.

SOURCE Absolute path to source file.

COMPILEFLAG Compilation flag to apply only to source files.
COMPILER _PATH Path to the compiler to apply only to source files.

VisualStudioPorject

Item Description
PROJECT_PATH Visual Studio project file to import.

ENVFILE Environment variable required for import.

BuildScriptProject

Item Description
BUILD_COMMAND Build script to perform the import.

WORKING_DIRECTORY Working directory to perform import.

ENVFILE Environment variable required for import.
EmbeddedProject
Item Description

COMMON_COMPILEFLAG Compilation flag to apply to all Source Files.
TOOLCHAIN_NAME Toolchain name.

PROJECT_PATH Visual Studio project file to import.
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28.4. CLI Execution

Controller Tester can be done in CLI environment.

Performing Controller Tester with CLI

1. Execute the path.bat file created with [Generate command line interface INI file] to get the path
information necessary for CLI execution.
2. Execute UtCLl.exe by passing the CLL.ini file edited by the user as an argument.
+ UtCLl.exe path: Controller Tester installation path\plugins\com.codescro
1l.ut ut 3.x.x\bin

ntroller Teste
troller Te

3. The Controller Tester function set by the user is performed.
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29. EULA(End-User License Agreement)

Software End User License Agreement

Important: This End User License Agreement (‘EULA”) is a legal agreement between the user
(individual or organization) and Suresoft Technologies, Inc. (“SureSoft Tech”) which is the manufacturer
the software products (“Software product” or “Software”) identified by the product identification card or
recognition label attached to this EULA. The software product includes computer software, related
media, related documents, and “online” or electronic manual. When installing, copying, downloading,
backing up, accessing or using the software product, the user must accept the terms of use in the EULA,;
if the user does not accept the terms of use in EULA, the user may not be licensed for the software
product. Unless the user is licensed to use the software product, the user cannot install, copy, download,
backup, access or use this software product.

Software Product License

The Software product is protected by intellectual property rights as well as copyrights, program
copyrights, and international copyright regulations. The term “computer” used in this agreement means a
single computer system, the range of which is described below.

1. License Grant

The EULA grants the user the following rights.

Software Installation and Use. Except for those clearly explained in the EULA, only one copy of
software product can be installed, used, accessed, executed or interacted (“execution”) on the computer.
To install, use or execute the software product on two or more computers, the user must obtain the legal
license(s) that corresponds to the number of computers regardless of the interaction of software used or
executed on each computer.

Backup Copy. When there is no software product backup copy on the computer, the user can create a
single backup copy that corresponds to the computer software part of the software product. The backup
copy can be used for the purpose of recording. To create a single backup copy, a backup utility can be
used. Except for those clearly stated in this EULA, the user may not make copies of the software product
including documents provided with the software product.

2. Other Rights and Limits

Computer or Single Computer System. The Software product’s license is applied only to a single
computer system. If the single computer system has multiple CPUs, it is considered as a single
computer system only when these CPUs are installed to one circuit board and the structure is the
symmetric central processing structure that shares one system bus.

Choose language versions. When the software product is included in one or more language versions, it
is allowed to use only one language version.

Reverse engineering limitations. De-compilation and decomposition. The user cannot decompile or
decompose software the product using reverse-engineering.
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Component separation. The software product is allowed as a single product. Users cannot separate
the components to use in one or more computers.

Lease. The Software product cannot be leased or lent.

Right Transfer of software product. The user may permanently transfer all rights as part of the sale of
hardware or right transfer according to this EULA, it is regarded that the recipient has accepted the
terms of use in this EULA.

Expiration. When the user violates the terms and conditions in the EULA, without infringing other rights,
Suresoft Technologies can make user’s rights expire according to the terms and conditions in this EULA.
In such a case, the user must discard all the duplicates and composing parts, including software product
that has been already installed.

Registered Trademark. The EULA doesn’t grant any rights related to the registered trademark and
service trademark of the software manufacturer, the computer manufacturer, and other related suppliers.
Upgrade. If the software product is upgraded via Suresoft Technologies, the terms of use in the EULA
are still valid for the upgraded software and it cannot be separated to use in one or more computers.

3. Copyright

Every right and intellectual propriety right (including all the image, figure, animation, video, audio, music,
text, and applet of the software product) of the software product, the enclosed manual, and every copy of
the software product are the property of software manufacturer or supplier. All rights and intellectual
property rights for the contents that are not built-in the software product but are accessible through the
use of the software product are the property of the Company, and this EULA does not grant any rights
for such use. When software product includes the manual in a file, only one copy of that file can be
printed. The documents accompanied by the software product cannot be copied. All the rights that are
not clearly stated are the property of the corresponding software manufacturer and supplier.

4. Double Media Software Product

The Software product can be delivered in one or more media. Regardless of the received media’s type
or size, only one media can be used in the computer. Other media cannot be executed on another
computer. Except for the case of transferring rights permanently (as described above), the user cannot
lease or lend the other media or transfer the right to other users.

5. Guarantee

The Software product’s guarantee on quality follows the attached warranty. If there is no separate
warranty enclosed, Suresoft Technologies guarantees that there was no defect during the production
process if it has been normally used for one year from the day of purchase. This does not mean that the
software product has no error, and does not exclude the possibility that unexpected result may appear
when using the product. Except for the cases where it is clearly stated in the separate warranty
agreement, Suresoft Technologies is not liable not only for the inaccuracy, error or defect of the software
product but also for the loss and damage produced from these. Suresoft Technologies doesn’t take any
responsibility for the third party’s claims for damage or the user’s claims for damage to the third party.
The Limited warranty statement, mentioned in the EULA, is still valid even though the user notified
Suresoft Technologies or its official representative in advance of the possibility mentioned above.
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6. Export limitation

The right transfer of the software product can be carried out only within Korea, and it cannot be exported
to other countries.

7. JAVA Support

The Software product includes the support of programs written in JAVA. JAVA technology is not
designed as an online control device, or not made, used or sold in dangerous environments that need to
error preventive function, such as nuclear facility, aircraft navigation, aircraft control, medicine, medical
system, and weapon system that can cause death, injury, or critical physical/environmental damage.

Caution

© Suresoft Technologies, Inc. All copyrights reserved. Printed in Korea
Suresoft Technologies and CODESCROLL are trademarks of Suresoft Technologies, Inc.

The product name or trade name mentioned in this document and related document are the trademarks
or registered trademarks of the Company having the copyright for the product. The software described in

this document is provided according to the usage agreement and non-disclosure agreement.

The software may only be used or copied according to the terms of use in this Agreement.
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